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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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3D-LUT RGB Cube Files from BBC
These 3D-LUT files are designed and copyrighted by the BBC and are available under license.

3D-LUT RGB Cube Files from NBCU
These 3D-LUT files are designed and copyrighted by the NBC Universal and are publicly available 
free of use.

Audinate/Dante Trademarks and Patents
The incorporation of and use of Dante functionality in the Ross Video Ultrimix-Dante feature is 
covered by specific Trademarks and Patents as referenced below:

Trademarks

Audinate®, the Audinate logo and Dante® are registered trademarks of Audinate Pty Ltd. All other 
trademarks are the property of their respective owners.

Patents

Audinate products are protected by one or more of US Patents 7747725, 8005939, 8478856, 
9003009, 9398091, 10097296, 10461872, 9178927, 9979767, 7978696, 8411679, 8913612, 9860291, 
10536499, 8171152, 8966109, 9479573, 10291944, 9497103, 10439848, 10419506, 11075967, 
11539773;European Patents 1872533, 2033360, 2033361, 2165541, 2255541, 2764631, 3155735, 
3571598; Chinese Patents ZL200780026677.0, 101491002B, 101563886B, 101731011B, 
102017652B, 103959664B, 106576007A, 110462600A; World Intellectual Property Organization 
Patent 2018/132872 and other patents pending or issued.

Patents
Patent numbers US 7,034,886; US 7,508,455; US 7,602,446; US 7,802,802 B2; US 7,834,886; US 
7,914,332; US 8,307,284; US 8,407,374 B2; US 8,499,019 B2; US 8,519,949 B2; US 8,743,292 B2; GB 
2,419,119 B; GB 2,447,380 B; and other patents pending.



Notice
The material in this manual is furnished for informational use only. It is subject to change without 
notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited 
assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Trademarks
• Dolby® is a registered trademark of Dolby Laboratories.
• Google® is a registered trademark of Google Inc.
• Microsoft® Excel® and Edge® are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
• Mozilla® and Firefox® are registered trademarks of the Mozilla Foundation.
• Oracle® and Java® are registered trademarks of Oracle and/or its affiliates. Other names may be 

trademarks of their respective owners.
• Safari® is a trademark of Apple Inc., registered in the U.S. and other countries.

Safety Notices
Refer to the “Important Regulatory and Safety Notices” document that accompanied your 
product.

Statement of Compliance
This product has been determined to be compliant with the applicable standards, regulations, and 
directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is 
available upon request by contacting techsupport@rossvideo.com. Please include the product; 
model number identifiers and serial number and country that compliance information is needed in 
request.

EMC Notices
United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appariel numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.



European Union

This equipment is in compliance with the essential requirements and other relevant provisions 
established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the 
“New Legislative Framework”.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications 
Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea

This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be 
aware of this fact. This device is intended for use in areas outside home.

International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and 
found to comply with the limits for a Class A Digital device.

Warranty and Repair Policy
The Ultrix systems are backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this 
equipment may cause radio interference.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.
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electromagnetic wave suitability equipment and 
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equipment is to be used in the places except for home. 



In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to Ultrix, what you should know about maintaining security of this product, and how we can 
partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data



• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
This guide covers the configuration and operation of the Ross Video ULTRIX-(NS)-FR1, 
ULTRIX-(NS)-FR2, and ULTRIX-(NS)-FR5 routers. If you are configuring an ULTRIX-FR12, refer to the 
ULTRIX-FR12 User Guide.

 For information on creating and managing databases for your routing system, refer to the Ultrix 
and Ultricore Database Guide.

The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides general information to keep in mind before configuring your Ultrix, 

instructions for configuring the Ultrix network settings, and assigning a name to identify the 
router.

• “Role-Based Access Control” outlines the use of the RBAC feature within the DashBoard 
software application for the Ultrix routers.

• “Using DashBoard” outlines the Ultrix tree view in DashBoard, and how to navigate the nodes.
• “Navigating the Product Info Interfaces” summarizes the Product Info interfaces (formerly the 

System Status interfaces in software versions prior to v6.1).
• “Navigating the System Configuration Interfaces” summarizes the configures the interfaces 

used to configure the connection points in your routing system.
• “Navigating the Device Configuration Interfaces” summarizes the interfaces that define the 

physical outputs, inputs, and communication ports of the Ultrix router.
• “Software License Keys” provides instructions for enabling the licensed features of your Ultrix 

router.
• “Enabling a Service” outlines how to enable a communication protocol, and configure the 

additional settings on the router for each protocol (if required). A summary of the supported 
commands is also provided.

• “Timing and Reference Setup” outlines how to configure the reference and time settings for 
your Ultrix router.

• “Configuring the SDI I/O Ports” provides instructions on how to manage your hardware 
matrices, configure an AUX port, and assign an UltriScape (Multiviewer) head to a physical output.

• “UltriSync Configuration” provides an overview of the UltriSync licenses, and how to configure 
the UltriSync settings for an input port.

• “UltriClean Configuration” provides an overview of the UltriClean licensed feature, and how to 
configure the Clean Switch mode for an output port.

• “UltriSRC Configuration” outlines how to assign an UltriSRC license to an input port.
• “Configuring an Audio Matrix” summarizes how to enable the audio matrix, the audio mapping 

options when using SDI embedded audio or MADI signals, how to set the audio transition mode 
for an audio channel.

• “UHD Gearbox Configuration” provides instructions on how to set up your Gearbox groups. 
• “ULTRIX-IP-IO Setup” outlines how to configure receivers and senders for the Ultrix router to be 

used in video and audio streaming when at least one ULTRIX-IP-IO blade is installed in a slot of an 
Ultrix router.

• “ULTRIX-IPX-IO Setup” outlines how to configure receivers and senders for the Ultrix router to 
be used in video and audio streaming when an ULTRIX-IPX-IO blade is installed in a slot of an 
Ultrix router.
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• “ULTRIX-SFP-IO Setup” outlines how to utilize the ports for the Ultrix router when an 
ULTRIX-SFP-IO blade is installed in a slot of an Ultrix router.

• “UltriStream Setup” provides information on the UltriStream licensed feature for the Ultrix 
routers.

• “UltriProc Setup” provides information on the SDR/HDR conversion and Color Correction 
options available when one of the UltriProc licenses is enabled on an Ultrix router.

• “Ultrimix-Dante Setup” provides information on installing the Ultrimix-Dante license, and 
configuring it for the Ultrix routing system.

• “Using Remote Control Panels” provides information on operating the Ultrix router with Ross 
remote control panels (RCP).

• “Operation with Ross Devices” provides general information for operating the Ultrix router in a 
routing system that also includes Ross NK Series devices.

• “ULTRIX-UCCI Redundancy” outlines the ULTRIX-UCCI Control redundancy feature for the 
ULTRIX-FR5.

• “Managing your Ultrix Settings” outlines how to import and export archived files (*.ufs) of your 
Ultrix router settings to another Ultrix router.

• “Monitoring the Hardware” outlines how to monitor the router hardware via the DashBoard 
status fields.

• “Monitoring the Communications” summarizes how to verify communications on an Ethernet 
port, an Ultricore connection, and the overall communication status of the Ultrix router.

• “Monitoring the Signals” outlines how to monitor the reference signal, the inputs and outputs 
signals via the options in the Frame Configuration interface of DashBoard.

• “DashBoard Interface Overview” summarizes the functions, menus, and parameters of the 
Ultrix tabs and windows in DashBoard.

• “Glossary” provides a definitions of commonly used terms and conventions for this guide.

If you have questions pertaining to the operation of Ultrix, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Ultrix:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Ultricore BCS User Guide, Ross Part Number: 2201DR-106
• Ultriscape User Guide, Ross Part Number: 2101DR-018
• ULTRIX-NS-FR1, ULTRIX-NS-FR2 Quick Start Guide, Ross Part Number: 2101DR-002
• ULTRIX-FR5 Quick Start Guide, Ross Part Number: 2101DR-502
• ULTRIX-NS-FR5 Quick Start Guide, Ross Part Number: 2101DR-503
• Ultrix and Ultricore Database Guide, Ross Part Number: 2201DR-109
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 Installation Guide, Ross Part Number: 2101DR-003
• ULTRIX-FR12 Installation Guide, Ross Part Number: 2101DR-603
• ULTRIX-FR12 Quick Start Guide, Ross Part Number: 2101DR-602
• ULTRIX-FR12 User Guide, Ross Part Number: 2101DR-604
• ULTRIX-MODX-IO User Guide, Ross Part Number: 2101DR-020
• Ultrix SFP Modules Guide, Ross Part Number: 2101DR-008
• Walkabout Application Note, Ross Part Number: 2201DR-003
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Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Save As dialog, click OK.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the Ultrix Installation Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 An error message displays when an object overlaps a tile or when one tile overlaps another in the 
workspace.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
An effective routing system takes careful planning. Routing systems may consist of many devices 
either located within the same facility, or across multiple locations. Routing devices (routers) must 
connect and communicate with each other and any control system devices all on a high speed 
network.

 DashBoard is required to configure the Ultrix router.

Configuration Overview
The generalized work-flow of configuring your Ultrix router is:

1. Configure the network interface settings for the Ultrix router.

2. Establish DashBoard connectivity.

3. Configure Ultrix device system settings

4. Define a database for the router.

5. Set up control panels.

 Ultrix supports a maximum of 25 DashBoard clients with 50 other TCP/IP connections (remote 
control panels, third-party control systems, etc.).

Figure 1  Process for Configuring an Ultrix Router

Establish Communications
Walkabout is a DashBoard system for network device discovery. Ultrix supports the Walkabout 
system for configuration of its IP settings. Once you establish communications over Ethernet 
between the Ultrix router and DashBoard, you can proceed to use the interfaces in DashBoard that 
enable Ultrix to communicate with the other devices in your routing system.

 Ross Video recommends a Memory Allocation of at least 4GB in DashBoard to ensure reliable 
operation. Refer to the DashBoard User Guide for details on setting the Memory Allocation value.

Network Settings
The Ultrix network settings may be changed by either the DashBoard Walkabout interface, or the 
Ultrix front panel interface. A complete network setting requires a static IP address, a network mask 
address, and a gateway address. These should be supplied by your IT Department for this device.

Using Walkabout in DashBoard
Walkabout is a Ross router utility operating within DashBoard that enables you to configure the 
network settings for Ross routers, remote control panels, and other devices. Once a valid 
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connection is established with Walkabout, the router is listed in the Tree View of DashBoard and 
available for monitoring and configuration using the options in DashBoard. 

Ultrix supports a basic configuration mode via the Walkabout system for initial configuration of IP 
settings. Use Walkabout to:

• specify device IP settings and names
• specify a name for your routing system
• specify the system role (e.g. primary, backup, device)
• select a system to join from a list of valid system names assigned to controllers
• set communications server from a list of valid communication server devices (or IP)

For More Information on...
• the features of Walkabout, refer to the document Configuring Devices Using Walkabout.

Using Walkabout to Assign the Initial IP Address to the Router
Once the Ultrix router is physically installed and cabled to your facility network, you will need to 
assign it an initial static IP Address to enable DashBoard to locate it on your network. Establishing 
an initial IP Address enables DashBoard to communicate with the router and update the Basic Tree 
View with the Ultrix nodes.

 After you edit a cell in the Walkabout table, it is recommended to wait approximately 1 minute, 
then click Refresh to apply the new settings.

To assign the initial static IP address for the Ultrix router

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
interface is current.

4. In the Walkabout table, find the entry for the Ultrix you want to configure.

 A factory default Ultrix will display Ultrix in the Name field and an IP address of 192.168.20.140. 

5. Use the Name field to assign a unique identifier to the Ultrix router. 

This will also be the name displayed in the Tree View of DashBoard.

6. To assign a new IP address:

a. Double-click the Address field.

b. Enter the IP Address supplied by your IT Department for this device.

c. Press Enter to save the new address.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultrix router.

The router reboots and the new settings are applied.
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Adding the Ultrix Router to the Tree View in DashBoard
Once you have assigned the Ultrix router a static IP Address, you can then manually add it to the 
Tree View in DashBoard. Manually adding the Ultrix router displays its node in the Tree View, 
granting you access to the interfaces described in the chapter “DashBoard Interface Overview”.

To manually add the Ultrix router to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Select Equipment or Service Type to Add dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the router in the IP Address field that you assigned in “To assign the 
initial static IP address for the Ultrix router”.

7. Perform one of the following steps:

• In the text fields provided, enter the display name for the Ultrix router, and port of the panel 
you wish to add; or

• Click Detect Frame Information to automatically retrieve the connection details.

8. Click Finish. 
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Updating the Network Settings for the Ultrix Router
 This section is not applicable if your router is already set to the correct IP address.

Once you establish initial communications with the Ultrix router, and it displays in the DashBoard 
Tree View, you may wish to review or change the IP Address and other settings according to your 
facility network requirements.

 This procedure requires a reboot of the router.

To update the network settings for the Ultrix router

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Double-click the Product Info node.

4. Select the Network tab.

5. Locate the Settings area.

6. Edit the fields as required.

 Do not assign the Ultrix to an IP address in the range of 192.168.12.0-192.168.12.255. These are 
reserved addresses.

7. Click Apply.

8. Click Reboot. This button is located at the bottom of the window. 

Re-naming the Ultrix Router
If you installed multiple Ultrix routers in your system, each router must have a unique name 
assigned to it via its front panel menu system. This ensures that the router is easily identifiable in 
the Walkabout interface and uniquely identifies its inputs and outputs in the DashBoard database 
interfaces.

Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where Frame identifies 
the physical router chassis housing the matrix/matrices. By default, each Ultrix router ships with the 
name “Ultrix” automatically set. By re-naming each Ultrix router, you are providing a unique 
identifier for the sockets within the router system.

You can rename a router via the options in DashBoard or via the front panel. This section outlines 
both methods.

Re-naming the Ultrix Router via DashBoard
Each Ultrix router can be given a unique name that is used on internal menus and as the identifier 
in the tree views of DashBoard. 

 Changing the router name after database configuration takes time to propagate through the 
system, and for DashBoard to reconnect, resuming stable system operation. Sufficient time must 
be allowed when making this change before attempting to use the system. This time will vary 
depending on features, matrix size, and configuration. In the case of the ULTRIX(-NS)-FR1 and 
ULTRIX(-NS)-FR2, the worst case will be 3-4 minutes. In the case of the ULTRIX(-NS)-FR5, the worst 
case is 10 minutes. The router name is typically assigned during initial commission and very 
rarely ever changed again.

 This procedure requires a reboot of the router.
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To re-name the Ultrix router via DashBoard

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the Ultrix router.

 Ultrix does not support Unicode characters.

4. Press Enter to apply the new name.

5. Click Reboot.

 It may take several seconds or more for the Ultrix node name to update in the Tree View of 
DashBoard.

Re-naming the Ultrix Router via the Front Panel
The LCD Display on the Ultrix front panel reports the chassis IP Address, the unique name of the 
router, and reports when an error or warning condition is occurring on the router. Next to the LCD 
Display is a five-direction round finger joystick that is used to access and navigate the Ultrix 
messages and menus on the LCD Display.

For More Information on...
• using the joystick to navigate the front panel menu system, refer to the Ultrix Installation Guide.

To re-name an Ultrix router via the front panel

1. Navigate to the Frame Name menu via the front panel as follows:

The current name for the router is displayed in the bottom line of the Frame Name: field. The 
first character position in the field will alternate flash with an underscore character. This 
provides visual feedback to the current cursor position.

2. Use the joystick to assign a new name to the router.

• Pressing the joystick LEFT/RIGHT positions the cursor.
• Pressing UP/DOWN selects a character.

3. Press the joystick IN to apply the new name.

4. Ensure the cursor is positioned at the front of the name.

1 2 3 4Network
>System

1 2 3 4Frame Name
 System  Name

1 2 3 4Frame Name:
 Ultrix

1 2 3 4>Config
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5. Press the joystick LEFT to navigate back up the menu tree.
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Role-Based Access Control
This chapter outlines the use of Role-Based Access Control (RBAC) within the DashBoard software 
application for the Ultrix.

 This feature requires software version 6.1.0 or higher.

Before You Begin
Ensure the following:

• The Ross Platform Manager and appropriate licenses are purchased to use RBAC features.
• The RPM Server is configured and added to DashBoard.
• The permissions for the devices in your routing system are defined via the Ross Platform 

Manager.

For More Information on...
• configuring the Ross Platform Manager and Server, refer to the DashBoard RPM User Guide.
• the Ultricore Profiles feature, refer to the Ultrix and Ultricore Database Guide.

Enabling RBAC for an Ultrix
The RBAC feature determines access to an individual devices (Ultrix or Ultricore) via a DashBoard 
instance (client). Once RBAC is enabled, any DashBoard without RPM will not be allowed to connect 
to the device unless the user enters a 'master password'. 

• If a DashBoard instance has RPM and the account for the current user is configured to allow 
access to the device, the user will be able to continue using the device. 

• If the user does not have access, the device will be disconnected from DashBoard until a user 
with access rights is signed-in.

To enable RBAC on an Ultrix

1. Launch DashBoard.

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes.

4. Expand the Ultrix sub-node.

5. Double-click the Product Info sub-node.

The Product Info interface displays.

6. Select the Setup tab.

7. Locate the RPM Role Based Access Control Required area.

8. Click Role Based Access Settings.

The Change RBAC Settings dialog opens.

9. From the RPM Role Based options, select On.

  The RPM Role Based is set to Off by default.

10. Use the Client Master Password field to specify the text string a user can enter to gain access 
to this device when RPM is not present in DashBoard or if DashBoard is unable to connect to 
the RPM Server.
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11. Click Done.

• The Change RBAC Settings dialog closes.
• On the Setup tab, the RPM Role Based Access Control Required field now reports On.

To verify that RBAC is enabled

1. Close the Product Info interface in DashBoard.

2. Locate the device node in the DashBoard Tree View.

3. Right-click the device node.

4. Select Disconnect.

The device node displays a grayed out icon.

5. Right-click the device node.

6. Select Connect.

The device node displays with a lock icon. Any user attempting to access this device will be 
prompted to enter the password specified in step 10 in the previous procedure. 

Accessing a Device with RBAC Enabled
Once the Ultrix is accessed through DashBoard are configured to require connection to an 
authenticated DashBoard instance (client), connection requests from unauthenticated sources are 
declined. A Lock icon displays next to the Ultrix node in the Basic Tree View to indicate that RBAC is 
enabled for that device. If RBAC is enabled but your system is not using an RPM Manager or Server 
or the RPM Server is unavailable, you will need to enter a Client Master Password to gain access to 
the device. This section outlines how to use a Client Master Password to access a device when RBAC 
is enabled.

 If RPM is used, access to the device is based on the privileges of the current user signed into 
DashBoard.

For More Information on...
• managing access control in DashBoard, refer to the DashBoard RBAC User Guide.

To access an Ultrix when RBAC is enabled

1. Locate the Ultrix node in the Tree View of DashBoard.

Notice that the node displays an icon with a lock symbol.

2. Double-click the Ultrix node.

The Password dialog opens.

3. Enter the password as defined in step 10 of “To enable RBAC on an Ultrix”.

4. Click Login.

The Password dialog closes and the Ultrix node displays a green icon and its tree nodes are 
accessible.

 Entering an incorrect password denies access and the device icon is lit red.
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Using DashBoard
This chapter outlines the Ultrix tree view in DashBoard, and how to navigate the nodes.

If you have questions pertaining to the operation of Ultrix, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

For More Information on...
• the DashBoard client software, refer to the DashBoard User Manual.
• the database interfaces in DashBoard, refer to the Ultricore and Ultrix Database Guide.

Ultrix in DashBoard
Ultrix groups the configuration, monitoring, and operating features in a Tree View in the DashBoard 
client window. Each node of the tree opens to reveal one or more sub-nodes, giving access to the 
features for your router.

Figure 2  Example of the Ultrix Nodes in a DashBoard Window

Ultrix includes the following interfaces, as separate nodes, in the DashBoard Tree View.

UltriScape
The first node provides access to the UltriScape Layout Editor, and UltriScape Head interfaces. 
UltriScape is the integrated Multiviewer for Ultrix routers. Use the UltriScape Layout Editor to 
manage the layouts and the UltriScape Head to assign sources to the UltriScape Head outputs. You 
must have at least one UltriScape license key installed to access the UltriScape interfaces. Refer to 
the UltriScape User Guide for details.

Product Info
Double-clicking the Product Info node displays two types of tabs within the same DashBoard 
window: Status (read-only) tabs located on the left, and a series of configuration options (tabs) 
located on the right. Refer to “Navigating the Product Info Interfaces” for details on this node.

System
The System tree includes three sub-nodes: Configuration, Control, and Monitoring. 

• The Configuration sub-node enables you to set up communications with devices in the routing 
system. Refer to “Navigating the System Configuration Interfaces” for details.

• The Control sub-node is not implemented on the Ultrix routers.
• The Monitoring sub-node enables you to manage what types of alarm conditions to monitor for 

each slot and port that is populated in your Ultrix router. Refer to “Navigating the Monitoring 
Interfaces” for details.
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Database
Expanding the Database node enables you to configure the databases, matrices, destinations, 
sources, group, levels, soft panels, and salvos for the routing system. Refer to the Ultrix and 
Ultricore Database Guide for details.

Navigating the Ultrix Interfaces in DashBoard
The interfaces are accessed by expanding the Ultrix node in the DashBoard Tree View and selecting 
the appropriate sub-node. Several of the interfaces are organized in a table layout with a toolbar on 
the bottom, and a toolbar on the left side of the tab.

For More Information on...
• the Database interfaces for your router, refer to the Ultricore and Ultrix Database Guide.

To access the Ultrix interfaces in DashBoard

1. Locate the Ultrix node in the Tree View of DashBoard

2. Expand the Ultrix node to display a list of sub-nodes.

When accessing an Ultrix, the first sub-node provides access to the Ultriscape settings for the 
Multiviewer licensed featured. If the Ultriscape sub-node is not displayed, an Ultriscape license is 
not enabled on the router. Refer to the Ultriscape User Guide for details.

3. Expand the second sub-node.

4. Double-click the Product Info sub-node to display that interface in the right pane of the 
DashBoard window.

The Product Info interface displays two panes within the same DashBoard window: status 
(read-only) fields in the left pane, and a series of tabs with configurable menus and settings in 
the right pane. Refer to “Navigating the Product Info Interfaces” for an overview of the 
available tabs, menus, and settings. 
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5. Expand the System sub-node.

The System tree includes three sub-nodes: Configuration, Control, and Monitoring. 

 The Control sub-node is not implemented on the Ultrix routers.

6. Expand the Configuration sub-node.

The Configuration tree includes two sub-nodes: Ultrix and Connections. Refer to “Navigating 
the System Configuration Interfaces” for an overview of the Configuration sub-nodes.

• The Configuration > Ultrix node provides access to the Device Configuration interfaces. Refer 
to “Navigating the Device Configuration Interfaces” for details.

• The Configuration > Connections node enable you to manage the available devices in your 
routing system that are auto-detected by your Ultrix router. Refer to “Connections 
Interface” for details.

7. Expand the Monitoring sub-node.

The Alarm Configuration sub-node displays. This node provides interfaces for enabling the 
video and audio alarms, and a central interface to monitor those alarms. Refer to “Navigating 
the Monitoring Interfaces” for an overview of the available tabs, menus, and settings.
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Navigating the Product Info Interfaces
The Product Info interface provides hardware information, network settings, access controls, 
options for creating backups of your settings, and general management for your router. This 
chapter summarizes the Product Info interfaces (formerly the System Status interfaces in software 
versions prior to v6.1).

Overview
The Product Info interface displays two panes within the same DashBoard window: status 
(read-only) fields in the left pane, and a series of tabs with configurable menus and settings in the 
right pane.

Figure 3  Example of the Product Info Interface for an Ultrix

The following sections briefly outline each tab displayed on the Product Info interface starting with 
the leftmost tab.

Product Tab
The Product tab provides read-only information about the general hardware and software status. 

Table 1 summarizes the read-only information displayed in the Product tab.

Table 1  Product Info — Product Tab

Item Parameters Description
Product <text> Indicates the product name

Vendor <text> Indicates the supplier/manufacturer

System Version # Indicates the build version

Serial Number # Indicates the serial number 
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Other Tab
Table 2 summarizes the read-only information displayed in the Other tab.

Network Tab
The Network tab provides network setup options and options to specify DashBoard client access.

Figure 4  Example of the Ultrix Product Info > Network Tab

Uptime #h #m #s Indicates the number of hours since the last reboot

System Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the internal 
clock (if no connection to an NTP Server is available) 
where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time

Table 2  Product Info — Other Tab

Item Parameters Description
Frontend Software Date # Read-only information used by Ross Technical Support.

Backend Software Date #

Device FW Rev #

Table 1  Product Info — Product Tab

Item Parameters Description



Ultrix User Guide (v28-rev5) Navigating the Product Info Interfaces • 35

Table 3 summarizes the fields and menus displayed in the Network tab.

Table 3  Product Info — Network Tab

Item Parameters Description
Information (Read-only)

Active ENET ENET # Indicates which Ethernet port on the router is 
the primary network connection

ENET # Link Connected (x, y) Indicates that a valid network link is configured 
on the specified Ethernet port of the device 
where:
• x represents the connection speed (Mbps)
• y represents the link type (e.g. full duplex)

Not Connected Ethernet communications for the device are 
invalid. The Ethernet cable may be disconnected 
on the rear panel or the Ethernet network may 
be down or experiencing problems.

ENET MAC <number> Indicates the MAC Address for the device 

Settings

IP Mode Static The user manually specifies the network 
settings for the device

Static DHCP The DHCP service for your network assigns the 
network settings to the router. Once the 
settings are validated, they are static.

Address ###.###.###.#
##

Specifies the IP address for the device

Subnet Mask ###.###.###.#
##

Specifies the subnet mask for the device

Gateway ###.###.###.#
##

Specifies the gateway for communication 
outside of the local area network (LAN)

Cancel Ignores any unsaved changes made to the 
Address, Subnet Mask, and Gateway settings 
and reverts back to the current running values.

Apply Updates the Address, Subnet Mask, and 
Gateway settings

SNMPa

Enable SNMP Selected Enables the SNMP Agent on the device

Cleared Disables the SNMP Agent on the device

SNMP Community 
Name

# Specifies the SNMP Agent identifier for 
communications. The default is ultricore. For 
stronger security, it is strongly recommended 
that users set their own community string.

SNMP Trap 
Destination IP 
Address

###.###.###.#
##

Specifies the target address the device sends 
SNMP traps to

Permitted Clients
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Transfer Tab
The Transfer tab provides three sub-tabs to manage the settings, profiles, and user credentials for 
your system.

Figure 5  Example of the Product Info > Transfer > Ultriscape Layouts Tab

UltriScape Layouts Sub-tab
Table 4 summarizes the sub-tabs displayed on the UltriScape Layouts sub-tab. 

DashBoards: # Lists the IP Address of each DashBoard client 
that is allowed to communicate with this device

Add Enables you to add a new DashBoard client to 
the Permitted Clients list

Delete Deletes the selected DashBoard client from the 
Permitted Clients list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the 
Permitted Clients list

Cancel Ignores any unsaved changes made to the 
Permitted Clients list and reverts back to the 
current running values

Apply Updates the Permitted Clients list settings

a. Requires the Ultricore-SNMP license key.

Table 3  Product Info — Network Tab

Item Parameters Description
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Ultrix Frame Settings Sub-tab
Table 5 summarizes the sub-tabs displayed on the Ultrix Frame Settings sub-tab. 

IP Media Config Sub-tab
Table 6 summarizes the sub-tabs displayed on the IP Media Config sub-tab. 

Table 4  Transfer — Ultriscape Layouts

Section Item Parameters Description
Export Layout <layout name> Selects the layout to be exported

Save As... 
(read-only)

*.lay Automatically updates with the name of the 
layout archive

Browse... Enables you to save or re-name the layout to a specific location

Apply Click to begin exporting the file to the specified location

Import Layout File 
(read-only)

*.lay Indicates the last layout file that was imported

Browse... Enables you to specify the layout to import

Retrieve 
Layout As:

<layout name> Indicates the file currently selected for 
importing

Apply Click to send the file to the device

Table 5  Transfer — Ultrix Frame Settings

Item Parameters Description
Export

Save As: (read-only) *.ufs Automatically updates with the name of the 
frame settings archive

Browse... Enables you to save or re-name the frame file to 
a specific location

Apply Click to begin exporting the file to the specified 
location

Import

Settings File: *.ufs Indicates the last frame file that was imported

Browse... Enables you to specify the frame file to import

Apply Click to send the file to the device

Table 6  Transfer — IP Media Config Settings

Item Parameters Description
Export

IP Media Config slot#x Indicates the blade that the IP settings will be 
downloaded from where:
• slot# represents the physical router slot
• x indicates the blade type (e.g. IP, IPX)
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Setup Tab
The Setup tab provides global settings such as assigning a device name, enabling remote control 
mode on a router, and determining access to the device.

Figure 6  Example of the Ultrix Product Info > Setup Tab

Save As: *.imc Indicates the file that the selected blade will be 
archived to

Browse... Enables you to save or re-name the IP media file 
to a specific location

Download All: Selected Archives the configuration of all available IP 
blades in this router

Cleared Archives only the selected blade

Download Captures the settings of the selected IP blade(s) 
to the file indicates in the Save As field

Import

Slot to Target: slot#x Indicates the blade that the IP settings will be 
uploaded to where:
• slot# represents the physical router slot
• x indicates the blade type (e.g. IP, IPX)

IP Media Config File *.imc Indicates the last file that was imported to the 
router

Browse... Enables you to specify the file to upload

Upload All: Selected Uploads the selected file to all available blades

Cleared Uploads the selected file to the specified blade

Upload Imports the selected *.imc file to the specified IP 
blade(s)

Table 6  Transfer — IP Media Config Settings

Item Parameters Description
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Table 7 summarizes the options displayed in the Setup tab. 

Table 7  Product Info — Setup Tab

Item Parameters Description
Device Identification

Device Name <name> Provides a unique identifier for the router in the 
Tree View of DashBoard 

System Name <name> Provides a unique identifier for the routing system

Control Mode

Remote Controller 
Mode

Selected Enables the primary device (Ultricore BCS) in your 
routing system to control this router. This hides the 
Database nodes in the Tree View.

Cleared This router cannot be controlled and monitored by 
a primary device

Log Settings

Logging Selected Enables the router to update the entries in the Logs 
tab

Cleared Disables this feature

Output Debug 
Messages

Selected Only use this feature under the guidance of Ross 
Technical Support.Cleared

DashBoard Interface

DashBoard Timeout 10-300s Sets the maximum number of seconds that 
DashBoard waits until it queries Ultrix. The default 
is 70 seconds. 

Update Applies the new value in the DashBoard Timeout 
menu

RPM Role Based 
Access Control 
Required (read-only)

On Any DashBoard without RPM will not be allowed to 
connect to the device unless the user enters a 
'master password'

Off Disables RBAC support

Role Based Access 
Settings

Displays the Change RBAC Settings dialog. Refer to 
“Role-Based Access Control” for details.

Password Protected Settings

Protect all licensed 
features with a 
password

Selected Enables the password-protected feature that 
prevents unauthorized changes to license keys. 
When the Port License tab is locked, users require a 
password to access/edit the license key 
information. 

Cleared Disables this feature (the Port License tab is 
editable). This is the default.

Change Password... Enables you to specify a password at least 8 
characters long.
It is recommended to change the password from 
the default value that is assigned at the factory.
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Storage Tab
Table 8 summarizes the read-only displayed in the Storage tab.

Logs Tab
There are three logs that can be viewed from the Logs tab: System Log, Controller Communications 
Log, and DashBoard Communications Log. The read-only information displayed in the logs is used 
by Ross Technical Support for diagnostic and troubleshooting purposes.

Status

Status (read-only) mm/dd/yy 
ERROR: 
Duplicate device 
name [abc] for 
ID [#]

Reports when multiple devices, with the same 
name, are communicating with the Ultrix router 
where:
• mm/dd/yy represents the date of the error
• [abc] represents the device name
• [#] represents the ID number assigned to the 

device

Clear Clears the Status field entry

Ultricore Profile Settings

Credential Mode Disable All users have full access to all settings and 
interfaces of the router. This is the default.

OS Users

Ultricore Users Users must enter their credentials as defined by the 
Ultricore Profiles feature

Routing Behavior

Salvo/Multi- 
Crosspoint Take 
Completion

Require All 
Crosspoints

The Take operation will fail entirely if any 
destinations are locked or protected

Best Effort The Take operation will be performed for any valid 
routes and fail for locked or protected routes

Table 8  Product Info — Storage Tab

Item Parameters Description
Internal OK There are no storage space issues detected

WARNING Less than 20% of the storage space is available

CRITICAL Less than 10% of the storage space is available

SD Card OK There are no storage space issues detected

Table 7  Product Info — Setup Tab

Item Parameters Description
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Navigating the System Configuration 
Interfaces
This chapter summarizes the System > Configuration interfaces.

Configuration Tree Overview
Expanding the top Configuration node enables you to access the sub-nodes that manage the 
available devices in your routing system that are auto-detected by your Ultrix router. 

Figure 7  Expanded Ultrix Configuration Nodes in the Tree View

Double-click the first sub-node to display the Device Configuration interface in the right pane of 
the DashBoard window. Refer to “Navigating the Device Configuration Interfaces” to learn more 
about the features of the Device Configuration interface.

Figure 8  Example of a Device Configuration Interface with Multiple Blades
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Double-click the Connections sub-node to display a series of tabs in the right pane of the 
DashBoard window. The following sections outline the tabs, fields, and settings available in the 
Connections interface.

Figure 9  Example of the Ultrix > Connections > Incoming Connections Interface

Connections Interface
The Connections interface lists and configures the connection points in your routing system. The 
interface is organized into three tabs: Incoming Connections, Services, and Protocol Servers. The 
following sections outline each tab.

 Prior to software version 6.1, the Connections interface tabs and fields were included in the 
Database > Connections and Database > Third-Party Matrices interfaces.

Incoming Connections Tab
The Incoming Connections table lists the connection details of remote client devices under the 
supervision of the active database currently communicating with the router.

Figure 10  Example of Entries in a Connections > Incoming Connections Interface
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Table 9 summarizes the fields displayed in the Incoming Connections tab. 

Table 9  Connections — Incoming Connections

Item Parameters Description
Communication tcp   The device is communicating over a network 

connection. Note that the DashBoard client 
computer, the router, and the external device must 
be on the same network.   

ip: # Specifies the IP Address of the device on the 
network

ip: localhost Specifies that the device is the router you are 
currently configuring

port:##### Specifies the ethernet port the devices is associated 
with on the network

TBUS | port: The device is communicating via the specified T-Bus 
port

Description <text> Provides a short textual description of the device

Device ID <name> Specifies the external device for the connection 
point

Name <name> Assigns a unique identifier for the device in the 
routing system. This name is also used when 
matrices are defined in the system.

Protocol GVG Native The device uses the third-party GVG protocol to 
communicate

NVISION This device communicates via the third-party 
NVISION protocol

OGP This device uses the openGear Protocol to 
communicate

Probel SW-P-08 The device communicates via the Probel SW-P-08 
protocol

Ross NK The device uses the Ross NK protocol to 
communicate (T-Bus or TCP only)

TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only)
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Services Tab
The Services tab lists the available communications protocols and provides options for 
enabling/disabling each protocol for the router.

Figure 11  Example of the Connections > Services Tab

Table 10 summarizes the options displayed on the Services tab.

 
Table 10  Connections — Services

Item Description
SSH service Enables the ability to log onto the primary device via an SSH server. 

Secure Shell (SSH) Login is a client-server protocol used by system 
administrators to securely log onto remote systems and execute 
commands over an unsecured network. SSH may also be used by 
Technical Support for advanced troubleshooting.

FTP service Enables the ability to communicate with the Ultrix over an FTP 
connection

Walkabout Enables the primary device to communicate with devices in the 
Walkabout system

Ember Plus Enables the primary device to communicate with a third-party control 
system via the Ember+ media distribution protocol

GVG Native Enables the primary device to communicate via the GVG Series 7000 
Native protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection.

Nvision Enables the primary device to communicate via a limited sub-set of the 
NVISION serial NP0010 protocol, and the NVISION NP16 Ethernet 
protocol.
Requires the Ultricore-NVISION license.

Probel SW-P-08 Enables the primary device to communicate via the Probel SW-P-08 
protocol. This protocol is available over an RS-422 or RS-232 serial 
connection, as well as an ethernet connection.

RossTalk Communications via the RossTalk protocol (a plain text based protocol 
that allows control of Ross Video equipment)
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Protocol Servers Tab
The Protocol Servers tab lists the currently active servers running in the routing system. This tab is 
auto-populated based on the external devices on the same network as your primary device.

Figure 12  Example of the Connections > Protocol Servers Interface

Table 11 summarizes the fields displayed in the Protocol Servers tab.

 

TSL Enables the primary device to communicate via the TSL UMD v3.1, TSL 
UMD v4.0, and TSL UMD v5.0 protocols.

NK Enable this option if there are Ross NK series devices or signal types 
the primary device itself does not handle. 
The Ross NK series devices must be connected to the Ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable 
communication with the primary device.

Enable Web Access Remote access and upgrades are disabled by default (the Upload 
button is disabled in the DashBoard interfaces). Remote upgrades 
may optionally be enabled through DashBoard via this option. 

On bootup or power cycle, this option will default back to disable 
(box is unselected). You must select the box again if you wish to 
enable web access and firmware upgrades after a bootup or power 
cycle.

Table 11  Connections — Protocol Servers

Item Description
Name Indicates the unique identifier for the device in the routing system. 

This name is also used when matrices are defined in the system

Communication Indicates the communication protocol, IP Address, Port Number, and 
configuration details of the device.

Table 10  Connections — Services

Item Description
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Server Options Dialog
Click Options (located in the bottom left corner) to display the Server Options dialog. This dialog 
provides additional settings for the supported protocol servers. 

Figure 13  Example of the Services > Server Options Dialog

Table 12 summarizes the fields displayed in the Server Options dialog.

 
Table 12  Connections — Protocol Servers > Server Options

Item Parameters Description
GVG Native

L4 Echo No The Ethernet Layer 4 acknowledge is disabled. This 
is the default.

Yes The Ethernet Layer 4 acknowledge is enabled

Probel SW-P-08

Protocol Variant Use Last Req The Ultrix will respond using protocol variant 
(extended/non-extended) as per the received 
request format. This is the default.

Non-Extended Ultrix will always replay using non-extended 
formatting

Extended Ultrix will respond with extended formatting

Matrix Mode No Ultrix will use information from the LEVEL section of 
the protocol to control Ultrix levels

Yes Ultrix will use information from the MATRIX_ID 
section of the protocol to control Ultrix levels

Do not wait for ACK No Ultrix will wait for message acknowledgments 
between connect responses. This is the default

Yes Ultrix will not wait for message acknowledgments 
between connect responses

Batch Collate Time 
(ms)a

# Wait up to 100 milliseconds for multiple commands 
received before processing. The default is 0 (which 
disables this feature).
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Batch Collate Split 
Size (# of 
commands)

# Wait up to 100 received commands before 
processing. The default is 0 (which disables this 
feature).

Unused Field # Send number (0-15) in either Level or Matrix field - 
which ever is not used as per Matrix Mode setting. 
The default is 0.

Probel Filter Yes Probel SW-P-08 crosspoint tally responses are 
provided when there are no status changes 
resulting from the crosspoint connect message.

No Removes the Probel Crosspoint Switch filter

TSL UMD v5.0

Wrapping No The DLE/STX wrapping is not enabled. This is the 
default.

Yes Enables the DLE/STX wrapping for TCP/IP transport

PBC in Count No Packet Byte Count is not included in total byte 
count. This is the default.

Yes Packet Byte Count is included in total byte count

Nvision

Offset 0 The Ultrix level matches the NVISION level

1 The Ultrix level is the NVISION level plus 1

Ember+

Mode Virtual Each level is represented by a Matrix and the Labels 
will be the one defined in the Destinations and 
Sources interfaces

Physical The whole router is represented as a single Matrix 
and the physical socket labels are used. The 
external control system using Ember+ commands 
bypasses the virtual IO mapping and directly 
controls the Ultrix physical socket connections. 
Therefore the Ultrix should not be switched by any 
other devices

a. When the Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will 
release the batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 12  Connections — Protocol Servers > Server Options

Item Parameters Description
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Navigating the Device Configuration 
Interfaces
The Device Configuration interfaces enable you to define the physical outputs, inputs, and 
communication ports of the Ultrix router. You can also monitor the overall status of the Ultrix 
router, or just the status of a specific signal path or port on the rear panel. This chapter briefly 
summarizes each interface.

Overview
The Device Configuration interfaces are accessed via the System > Configuration tree in DashBoard.

Figure 14  Expanded Ultrix Configuration Nodes in the Tree View

Double-click the Ultrix sub-node to display the Device Configuration interfaces in the DashBoard 
window.

Figure 15  Example of a Device Configuration Interface with Multiple Blades

Navigation Toolbar
A toolbar always displays at the top of each Device Configuration interface. (Figure 16) From this 
toolbar you can quickly monitor the overall status, verify the IP address, and navigate between the 
Device Configuration interface. This section outlines the read-only fields and buttons on the toolbar 
(from left to right).

Figure 16  Example of the Navigation Toolbar
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Table 13 outlines the read-only fields and buttons on this toolbar starting with the leftmost field.

Frame View Interface
When the Device Configuration interface is first displayed in the DashBoard window, the Frame 
View is automatically selected. This interface provides a map of the rear panel. The number of slots 
and the available connections depends on the router model and the type of blade(s) installed in 
each slot. Colors and icons indicate port status.

Table 13  Device Configuration — Toolbar

Item Description
Frame 
(read-only)

This field reports the unique identifier assigned to the router

Type (read-only) This field reports the model of the router. Figure 16 shows an ULTRIX-FR5.

IP (read-only) This field reports the current TCP/IP network address assigned to the router

Displays the home page (frame view) that includes a map of the router rear 
panel. Selecting a blade displays the options for that blade. Selecting one or 
more ports display the options for the port(s). Refer to “Frame View Interface” 
for details.

Displays the configuration options for the ports on the rear panel. Refer to “Port 
Configuration Interface” for details.

Displays the global configuration options for the router, such as network 
settings, specifying a reference source, and enabling alarms. Refer to “Frame 
Configuration Interface” for details.

Displays the options to configure an ULTRIX-SFP-IO blade or a port that is 
populated with an SFP module. Refer to “SFP Configuration Interface” for 
details.

Displays options for managing the license keys for your router. Refer to 
“Licenses Interface” for details.

Status

Select this button to display a list of changes for the active slots

Alarms

Indicates the total number of warnings (red icon) and errors (yellow icon) the 
router is currently reporting. Select the Alarms button to view a list of the 
current alarm messages.
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Figure 17  Example of the Frame View Page — ULTRIX-FR5 with ULTRIX-HDX-IO Blades

The top row of the router map represents the power connections (left side), and any UCCI blades 
installed (right side). Selecting a power connector displays the Frame Configuration > Fans & Power 
tab. Selecting a port from an Ultrix-UCCI blade displays its options in the Port Configuration 
interface.

Each subsequent row represents a populated slot in the chassis. Selecting a slot displays its options 
in the Port Configuration interface. 

Selecting a port displays its options and status on the Port Configuration interface. When a port is 
selected, its label (located under the port image) is lit blue. Refer to “Port Configuration Interface” 
for information on the types of menus and fields on this interface.

Each port is lit green, yellow, or red to indicate its status:

• Red — no signal is present or is a type/format that is not supported.
• Yellow — an SDI signal is present without embedded audio.
• Green — an SDI signal is present with embedded audio.

Selecting any other ports navigates directly to the relevant configuration and status page.

Port Configuration Interface
The Port Configuration interface reports individual I/O port status and settings. Selecting a slot 
updates the table for all installed ports. Selecting a port displays only the options for that port (the 
label under the port icon is lit blue). You can also choose to filter the information displayed in the 
table (e.g. only inputs, or only outputs). 
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Figure 18  Example of the Port Configuration Interface for a Specific Slot

1. Populated Slots

A row of buttons representing the slots available on the rear panel. Selecting a button displays 
the options specific to that slot. This provides quick I/O module selection to view status and port 
configuration. Figure 18 shows that Slot 1 was selected.

2. View Options

The Views options in this area enable you to filter the information displayed on the Port 
Configuration interface. Choose from the following:

› Baseband/IP — Toggle this button to select between baseband (SDI) signals or IP signals (blade 
dependent).

 The IO Module option is also available when there is at least one ULTRIX-MODX-IO blade 
installed. Refer to the ULTRIX-MODX-IO User Guide for details.

› Ports/Channels — Toggle this button to select between primary signal view (SDI) or embedded 
audio channel view.

› Inputs/Outputs — Toggle this button to specify the type of port to display in the table. 
› Select All — Select this button to change the port view to see all ports of a specific type (input or 

output).
› Clear All — Select this button to clear the port view to allow individual port selection.

3. Slot Map

This area provides a graphic representing the physical ports of the selected slot. Select a port 
image to display its details in the Port Configuration Table. A port label is highlighted in blue 
when the table displays information specific to that port. The color of the port denotes its signal 
status as follows:

› Red — no signal present or is of type not supported.
› Yellow — an SDI signal is present but does not include embedded audio.
› Green — an SDI signal is present and includes embedded audio.
› Gray — the port is not in use or it is not populated with an SFP module. 

A port may also display a character above it:

1) Populated Slots 3) Slot Map

2) View Options 4) Port Configuration Table

4
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› D — the port is currently assigned to Ultrimix-Dante.
› i — the port is currently assigned as part of a Gearbox quad-link group.
› M — the port is currently assigned as an UltriScape (Multiviewer) output.
› / — the port is currently configured with UltriSync (frame sync) license.

Select individual ports to toggle port details list. The port identifying number/letter is highlighted 
when included in the port details list.

 Selecting a non-signal port (such as a power connector, or reference port) opens the status and 
configuration interface for the port type.

4. Port Configuration Table

A table that displays details on each port for the selected slot. The columns and rows depend on 
the blade type that populates the slot. Refer to the following sub-sections for blade-specific 
details. The table is filtered by the selections made via the View Options. For example, to 
monitor/configure a single audio input:

a. From the Selection Options, click Clear All.

b. From the Views Options, click Channels.

c. Select the required I/O port. 

The table updates to display only the selected port. You may add more ports to view by 
selecting them on the rear panel graphic display.

SDI I/O Blades
Selecting any blade (HD-BNC, SFP, HDX, etc.) using the buttons located in the Populated Slots 
selection bar, displays the Port Configuration table for the selected blade. The location of the port is 
reported at the top of the interface. Figure 19 shows the interface for an HD-BNC I/O blade 
installed in Slot 2 with only the information for the outputs displayed.

Figure 19  Example of Port Configuration Interface — HD-BNC I/O Blade 

For More Information on...
• the available SDI I/O options on the Port Configuration Interface, refer to “Configuring the SDI 

I/O Ports”.

ULTRIX-IP-IO and ULTRIX-IPX-IO Blades
When an ULTRIX-IP-IO or ULTRIX-IPX-IO blade is installed in a router slot, selecting a specific port on 
the rear panel map displays configurable options for that port. You can configure the sender, and 
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receiver streams the port will manage. Refer to “ULTRIX-IP-IO Setup” for details on using this 
interface.

Figure 20  Example of Port Configuration Interface — ULTRIX-IP-IO Port Selected

Table 14 summarizes the fields displayed in the options in the Port Configuration interface for the 
ULTRIX-IP-IO and ULTRIX-IPX-IO blades.

 
Table 14  Port Configuration — ULTRIX-IP-IO or ULTRIX-IPX-IO Blades

Item Parameters Description
Port Status 
(read-only)

OK (Green) The selected port is ready to accept stream setting 
changes

NOT READY 
(Red)

Failure to communicate with the port. The router 
will continue to re-establish connection with the 
port until it is successful.

Sender Bandwidth 
(read-only)

# of 25Gb used Reports the amount of data the router is currently 
transmitting on the specified port

Receiver Bandwidth 
(read-only)

FREE Reports the amount of data the router is currently 
receiving on the specified port

Senders

Port slot.port.type.ch Specifies the blade port when subscribing to 
streams

Name <text> Specifies a unique identifier for the sender stream

Type Indicates whether the stream includes video or 
audio data

Signal Format # Indicates the video format detected on the stream

Codec # Specifies the AES67 standard that the blade will 
default to for all IP-based audio sender streams

Channels # Specifies the maximum number of audio channels 
available for configuration within the specified 
stream

Transport IP # Specifies the IP address for the stream

UDP Port # Indicates the port associated with the IP address 
and the communication protocol for the stream
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Redundancy Indicates if Redundancy Mode (protection 
switching) is enabled for the specified port

Session ID # Indicates the ID number assigned to the blade 
within the system

Stream ID # Indicates the ID number assigned to the specific 
stream within the system

Alarm Severity Indicates any detected errors for the specific stream

Alarm Description

Receivers

Port slot.port.type.ch Specifies the port for the receiver stream

Name <text> Specifies a unique identifier for the receiver stream

Type Indicates whether the stream includes video or 
audio data

Signal Format # Indicates the video format detected on the stream

Codec # Specifies the AES67 standard that the blade will 
default to for all IP-based audio receiver streams

Channels # Specifies the maximum number of audio channels 
available for configuration within the specified 
stream

Transport IP # Specifies the IP address for the stream

UDP Port # Indicates the port associated with the IP address 
and the communication protocol for the stream

Redundancy # Indicates if Redundancy Mode (protection 
switching) is enabled for the specified port

Session ID # Indicates the ID number assigned to the blade 
within the system

Stream ID # Indicates the ID number assigned to the specific 
stream within the system

Alarm Severity Indicates any detected errors for the specific stream

Alarm Description

Table 14  Port Configuration — ULTRIX-IP-IO or ULTRIX-IPX-IO Blades

Item Parameters Description
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Frame Configuration Interface
The Frame Configuration interface is organized into a series of sub-tabs that provide options for 
configuring the global settings of the router. By default, the Communications tab is selected.

Figure 21  Example of a Frame Configuration Interface

Communication Tab
The Communications tab shows the network settings and Network Time Protocol (NTP) settings. 
You can also monitor the status of the Ethernet connection of the Ultrix router. From here you can 
verify the network settings of the active Ethernet port on the router, and view the mode of the 
control system (primary/client). Refer to “Getting Started” for details on configuring these settings.

Alarms Tab
From the Alarms tab you can specify what components the Ultrix router monitors such as the 
power supplies, fans, network status, the SD Card, the chassis battery, and the interior chassis 
temperature. 

By default, the Ultrix monitors the following components (these options are enabled):

• System Error
• Temperature
• Primary Power
• Redundant Power
• SD Card Presence
• Battery
• Storage Space
• Fan 1
• Fan 2
• Fan 3 (applicable only to the ULTRIX-NS-FR1, ULTRIX-NS-FR2, and ULTRIX(-NS)-FR5)
• Fan 4 (applicable only to the ULTRIX-NS-FR2, and ULTRIX(-NS)-FR5)
• Fan 5 (applicable only to the ULTRIX(-NS)-FR5)

The Alarms tab also displays read-only State column that reports the status of each enabled alarm 
using color indicators which vary in severity from green (valid), yellow (caution), to red (alarm). For 
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example, if the SD Card status is set to red in the Alarms tab, an SD Card is not detected or the SD 
Card not mounted correctly inside the chassis.

Fans & Power Tab
The Fans & Power tab displays read-only fields that report on the fan status and PSU connections of 
the Ultrix router. Color indicators vary in severity from green (valid), yellow (caution), to red (alarm). 
In the case of multiple messages, the most severe alarm is reported for a single row in the tables.

Table 15 summarizes the fields and menus displayed in the Fans & Power tab.

Table 15  Frame Configuration — Fans & Power

Item Parameters Description
Fans

Fan Name FAN # Indicates the specific fan within the chassis

Slot #, x Indicates the specific fan within the chassis where # 
represents the physical slot and x the location 
(front, middle, back)

Fan State Active (Green) Indicates that the chassis core componentsa 
temperature is within the normal range (below 
70°C (158°F)) and the fans are running without 
errors detected

Inactive (Yellow) The chassis fan is not currently enabled or installed. 

Warning (Red) An error condition is detected on the chassis fan 
and an alarm is raised. Verify that the fan is 
installed correctly.

Fan Speed (%) # Indicates the current speed of the chassis fans

Fan Speed State OK (Green) The fans are running at the specified Minimum Fan 
Speed value

Caution (Yellow) Indicates that at least one chassis core component 
temperature is between 70°C and 80°C (158°F and 
176°F). The Minimum Fan Speed value is 
overridden.

Warning (Red) Indicates that at least one chassis core component 
temperature is above 80°C (176°F). The Minimum 
Fan Speed value is overridden and the fans are 
running at the maximum speed.

Minimum Fan 
Speed

40-100 Sets the speed of the interior chassis fans. This 
value will be overridden when a chassis core 
component is detected to be at a temperature 
above 70°C (158°F).

Power Supplies

PSU # Indicates the specific power supply unit installed 
within the chassis
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References Tab
The References tab is organized into two areas: Detect References, and Triggers.

• The Detect References area displays read-only fields that report the status on the reference 
signal. Refer to “Specifying a Default Reference Format” for details.

• The Triggers area provides options for configuring the reference signal for the routing system. 
From this table you can configure up to four reference triggers which then can be assigned to the 
inputs and outputs of the router. Refer to “Configuring a Reference Trigger for the Ultrix 
Router” for details.

Audio Mixer Tab
Configures the inbuilt audio mixer (if an ULTRIMIX-MXR license is enabled on the frame). Refer to 
“ULTRIMIX-MXR” for details on configuring the settings on this tab.

Ultrix-IP Tab
 The Ultrix-IP settings are only available when an ULTRIX-IP-IO or ULTRIX-IPX-IO blade is installed 

in at least one of the rear panel slots.

The Ultrix-IP tab provides options for monitoring and configuring the individual SFP+ ports, the 
transport protocol, and PTP settings that are required for the streaming of video and/or audio. The 
options are organized into sub-tabs: Port Bandwidth, IP System, Port Network, PTP, NMOS, and 
LLDP. Table 16 summarizes the fields and menus displayed on the Ultrix-IP tabs.

Power State Active (Green) Normal operation; no hardware errors associated 
with the PSU 

Inactive (Yellow) A hardware error is detected on the specified PSU. 
Verify that the PSU is correctly installed, and that 
power is available.

Warning (Red) Indicates the minimum number of PSUb are not 
detected

Ultricool Server 
Enabled

Selected Enables the ability for the router to accept control 
connections from an Ultricool. 

Cleared Disables this feature. Select this option if your 
routing system does not include an Ultricool.

a. This term refers to the installed I/O blades, and the ULTRIX-UCCI module.
b. The ULTRIX(-NS)-FR5 requires a valid connection to an Ultripower. An ULTRIX(-NS)-FR2 requires a minimum 

of 2 PSU to be connected at all times. For ULTRIX(-NS)-FR1 routers, a minimum of 1 PSU is required.

Table 15  Frame Configuration — Fans & Power

Item Parameters Description



Ultrix User Guide (v28-rev5) Navigating the Device Configuration Interfaces • 59

Table 16  Frame Configuration — Ultrix-IP

Item Parameters Description
Port Bandwidth

This tab provides an estimate of the actual bandwidth of the Ethernet links:
• all packets received on the Ethernet links (media and processor traffic)
• transmit bandwidth (packets sent from the processor to the Ethernet links)
• receive bandwidth (packets sent on the link and forward to the processor)
This tab also provides counters for the receive errors, transmit errors, packet size ranges, and 
general bytes.

IP System

This tab reports on the media traffic, whether the router port is enabled to send SMPTE ST 
2022-7 streams within a protection switching network, the Ember+ connection status, and the 
DNS status.

Port Network

Port slotx.porty Specifies the port on the ULTRIX-IP-IO or 
ULTRIX-IPX-IO blade you are configuring where:
• x represents the physical slot that the blade is 

installed in
• y represents the physical port on the blade

Link UP A valid network connection is detected on this port

DOWN The port is experiencing a connection error to the 
network

Speed (Gbps) # Indicates that the link is operating at the specified 
speed

MAC Address #:#:#:#:#:# Indicates the MAC Address currently assigned to 
the Ultrix router for the specified port

FEC # Reports if your module includes a built-in FEC 
(DR/FR/LR)

IP Mode Static The user manually supplies the network settings for 
the specified blade port

DHCP Automates the assignment of the network settings 
for the specified blade port. This is the default.

IP #.#.#.# Indicates the IP Address currently assigned to the 
selected blade port. The default is 128.0.0.0 <port 
#>.

Subnet Mask #.#.#.# Indicates the subnet mask for the specified blade 
port. The default is 255.255.255.0.

PTP

Profile IEEE 1588 Default The ULTRIX-IP timing uses the IEE1588 standard

AES67 Media The ULTRIX-IP timing uses the AES67 Media 
standard

SMPTE ST 2059-2 The ULTRIX-IP timing uses the SMPTE ST 2059-2 
standard. This is the default.
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Domain # Specifies that the ULTRIX-IP is within the specified 
group of clocks in your network

Priority 1 # Assigns the first priority level to the ULTRIX-IP 
during a Grandmaster election where a value of:
• 1 is the highest priority
• 255 is the lowest priority
This is applicable when the Slave Only is set to False

Priority 2 # Assigns the secondary priority level to the ULTRIX-IP 
during a Grandmaster election where a value of:
• 1 is the highest priority
• 255 is the lowest priority
This is applicable when the Slave Only is set to False

Slave Only True Defines the ULTRIX-IP as a follower only device in 
the system; the ULTRIX-IP cannot be used as a 
Grandmaster or Master device

False The ULTRIX-IP can be used as a Grandmaster or 
Master device

Slot slotx.porty Specifies the port on the ULTRIX-IP-IO or 
ULTRIX-IPX-IO blade you are configuring where:
• x represents the physical slot that the blade is 

installed in
• y represents the physical port on the blade

State LOCKED Status of PTP on the system

FREE RUN

Grand Master ID # Reports the ID number assigned to the 
Grandmaster within the system

Priority # # Standard PTP fields used to determine who wins a 
PTP election

Clock Class # Standard PTP field that states the class of the clock 
used on the system

Offset from Master # Correction time offset from the master in 
nanoseconds

Mean Path Delay # Average time in nanoseconds it takes a packet to 
traverse end to end from the PTP master

Steps Removed # Specifies how long the ULTRIX-IP will wait for a 
delay request

Port slotx.porty Specifies the port on the ULTRIX-IP-IO or 
ULTRIX-IPX-IO blade you are configuring where:
• x represents the physical slot that the blade is 

installed in
• y represents the port on the blade

Status Slave Status of PTP on the interface

Listening

Table 16  Frame Configuration — Ultrix-IP

Item Parameters Description
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Versions Tab
This tab summarizes the firmware and what is installed in each slot of the router. 

Filters Tab
Use the options in the Filters tab to determine what information is reported/monitored based on 
the signal type.

Link Up The link for the specified port is valid

Down The link for the specified port is invalid (fails)

Sync Interval # Specifies often the ULTRIX-IP port sends Sync 
messages

Announce Interval # Specifies how often the ULTRIX-IP sends Announce 
messages

Announce Receipt 
Timeout

# Controls how long the ULTRIX-IP port will wait 
before declaring the Grandmaster absent and 
initiating a new election

NMOS

Control Access 
Interface

Indicates the ports that are enabled for NMOS communication

NMOS Service Ports IS-04 Specifies the port the NMOS IS-04 Node service is 
listening on

IS-05 Specifies the port the NMOS IS-05 Connection 
service is listening on

IS-08 Specifies the port the NMOS IS-08 Connection 
service is listening on

IS-10 Specifies the port the NMOS IS-10 Connection 
service is listening on

RDS > Discovery RDS Allows the user to set an RDS IP in the Registry 
Service Address field and forces the router to 
register to a specific RDS

mDNS The router uses mDNS to automatically register in 
an RDS on the network with the lowest priority

Security Indicates whether the Security Options are configured for the port. 
Refer to “NMOS IS-10 Setup”.

Auth. Server Indicates if the port is configured to register to a specific NMOS IS-10 
Authorization Server on the network. Refer to “NMOS IS-10 Setup”.

DNS Domain Indicates the network domain the port is subscribed to

LLDP (read-only)

The Link Layer Device Protocol (LLDP) tab reports which device/port is connected to each 
media ethernet (eth#) interface available on the ULTRIX-IP and ULTRIX-IPX blades. When a field 
is blank, the external device has not provided that status.

Table 16  Frame Configuration — Ultrix-IP

Item Parameters Description
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SFP Configuration Interface
The SFP Configuration interface is applicable when:

• at least one ULTRIX-SFP-IO blade is installed; or, 
• at least one AUX port is populated in an installed blade.

From this interface you can configure each populated AUX and/or SFP port on the blade. This 
interface is organized into two sub-tabs: AUX Ports and SFP Ports.

For More Information on...
• cabling your blade, refer to the ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 Installation Guide.

Figure 22  Example of the AUX Ports Configuration Interface

AUX Ports Tab
The information in the AUX Ports tab is organized into two areas: a table on the left that lists the 
slots with available AUX ports, and a table on the right that provides details on each SFP port of a 
selected slot. Each row of the table reports the port name, type of SFP module installed, and the 
number of MADI channels set for that SFP (if applicable). Refer to “Configuring an AUX Port”.

SFP Ports Tab
The information in the SFP ports tab is organized into two areas: a table on the left that lists the 
slots with available SFP ports, and a table on the right that provides details on each SFP port of a 
selected slot. Each row of the table reports the port name, and type of SFP module installed. Refer 
to “ULTRIX-SFP-IO Setup”.

Licenses Interface
The Licenses interface displays the License Keys tab, and a tab for each licensed feature that is 
enabled on the router.
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Figure 23  Example of the Licenses Interface

 The Licenses interface takes up to 35 seconds to register any changes to the table entries.

License Keys Tab
Use the fields in this tab to manage the licenses for your router. From here you can view which 
licensed features on which slots are enabled, and enter license keys for new features. 

For More Information on...
• the available licensed features, refer to “Software License Keys” for details.

UltriMix Tab
Use the options on this tab to enable or disable embedded audio support per slot. Refer to 
“Configuring an Audio Matrix” for details.

UltriScape Tab
The UltriScape tab reports on the number of UltriScape licenses installed, and the number of 
UltriScape Heads enabled on the Ultrix router. From this tab, you can assign an UltriScape Head to a 
physical OUT socket on the router. Refer to the Ultriscape User Guide for details.

 At least one UltriScape license must be installed for a slot before you can assign an UltriScape 
Head to a router output in that slot.

The UltriScape tab is organized into three columns:

• Head — read-only fields that report the physical address name of an UltriScape output.
• Port — used to enable/assign an UltriScape Head.
• Format — used to select the an UltriScape output format.

UltriSync Tab
The UltriSync tab reports on the number of UltriSync-3G and UltriSync-UHD licenses installed, and 
the number of slots with the licensed enabled on the Ultrix router. The UltriSync tab is organized 
into three columns:

• Port — read-only fields that report the physical address name of an Ultrix router output.
• 3G License — used to enable the UltriSync-3G on the specified port.
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• UHD License — used to enable the UltriSync-UHD on the specified port.

 The UltriSync-UHD is only available for the ports of a slot depending on the type of blade installed 
in that slot. Refer to “UltriSync Configuration” for details.

UltriSRC Tab
The UltriSRC tab reports on the number of UltriSRC licenses installed, and the number of AUX ports 
with the license enabled on the Ultrix router. The UltriSRC tab is organized into two columns:

• Port — read-only fields that report the physical address name of the Ultrix AUX port.
• License — used to enable the UltriSRC on the specified port.

Refer to “UltriSRC Configuration” for details.

UltriProc Tab
The UltriProc tab is organized into two tables: the left table provides the options for selecting the 
data rate and assigning the license to an I/O type. The table on the right lists the available ports and 
provides the option to enable/disable the UltriProc feature. Refer to “UltriProc Setup” for details.

UltriStream Tab
The UltriStream tab lists the available slots that this license can be assigned to, the type of blade, 
and the port name. The License column provides the option to enable/disable the license for each 
slot. 

 UltriStream is only available for the AUX D ports on the supported blades. Refer to “UltriStream 
Setup” for details.

Ultrimix-Dante Tab
The Ultrimix-Dante tab lists the available slots that this license can be assigned to, the type of blade 
and the port name. The License column provides the option to enable/disable the license for each 
slot. 

 Ultrimix-Dante is only available for the AUX C ports on the supported blades. Refer to 
“Ultrimix-Dante Setup” for details.
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Software License Keys
The Ultrix routers have software options that license functions and features. This chapter outlines 
the available software licensed features, and how to install a software key for a licensed feature. 

Before You Begin
When installing a software license key on the Ultrix router:

• You must have the DashBoard client installed and communicating with the Ultrix router that you 
wish to install the key for.

• Ensure that you are using DashBoard version 9.10 or higher. This information is available by 
selecting Help > About DashBoard from the DashBoard main toolbar.

License Keys Overview
Table 17 provides a brief summary on the types of licensed features available for the Ultrix router.

 The per slot UltriMix license comes standard with every Ultrix router.

Table 17  List of Ultrix Licensed Features

License Description
Ultrimix-Dante Enables 64 x 64 input/output audio channels via ethernet on the 

AUX C port of an ULTRIX-HDX-IO or ULTRIX-MODX-IO blade

ULTRIMIX-MXR A license that enables the configuration and use of audio mixer 
soft panels.

UltriProc-3DLUT A license that enables color correction, Proc Amps, and HDR 
conversion on Ultrix I/Os but also enables SDR/HDR conversion 
with a 3D-LUT RGB Cube file. Only applicable to ULTRIX-HDX-IO or 
ULTRIX-MODX-IO blades.

UltriProc A license that enables color correction, Proc Amps, and HDR 
conversion on Ultrix I/Os; can be assigned to inputs or outputs. 
Only applicable to ULTRIX-HDX-IO or ULTRIX-MODX-IO blades.

UltriScape Each license enables one Multiviewer Head (output) per slot.
Each slot supports up to three Multiviewer Heads.

UltriSpeed A license that enables the use of UHD 12Gbps SDI signaling on all 
slots of the Ultrix router.
The 12Gbps SDI signaling through an SFP module installed in an 
AUX port is also supported. You must order the SFP module 
separately.
This license is required if you wish to configure a UHD Gearbox.

UltriSRC A per input license enabling Sample Rate Conversion (SRC) on 
MADI audio inputs. This allows MADI inputs that are not 
synchronized to the frame reference.

UltriStreamOut A license that enables the ability to encode one NDI stream of a 
configured UltriScape Multiviewer Head per ULTRIX-HDX-IO or 
ULTRIX-MODX-IO blade.
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Installing a License Key
Ross Video uses license keys to control user access to specific Ultrix features. You can obtain a key 
for an Ultrix licensed feature from Ross Video Technical Support.

To install an Ultrix license key

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Systems sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Ultrix node.

The Device Configuration interface opens.

6. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

UltriSync A per input 3G frame sync license enabling alignment to router 
sync.

Ultrisync-UHD A per input frame sync license to support UHD video rates. Each 
slot supports up to 3 Ultrisync-UHD ports.
Requires software version 4.2.0 or higher and is applicable only to 
the ULTRIX-HDBNC-IO and ULTRIX-SFP-IO blades.

Ultriscape-CA A license that enables the display of CEA-608, CEA-708, and OP-47 
closed caption data on a Multiviewer Head.

Ultricore-EMBER+ A license that enables the use of the EMBER+ protocol for video 
and audio streaming via an ULTRIX-IP-IO or ULTRIX-IPX-IO blade.

Ultricore-NVISION A license that enables the use of the NVISION protocol on all slots 
of the Ultrix router.

ULTRICORE-PRO A licensed that provides full Ultricore Profiles support on Ultrix 
frames.

Ultricore-SNMP A license that enables basic SNMP monitoring on Ultrix routers. 

Table 17  List of Ultrix Licensed Features

License Description
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7. Make a note of the character string in the Request Code field for the license you wish to enable.

8. Contact Ross Video Technical Support using the information found in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from step 7.

b. You will be given a License Key for the licensed feature.

9. Enter the provided License Key in the applicable License Key field of the Licenses tab.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

10. Click Apply in the row for the License Key you entered in step 9.

11. Verify that the Count field is updated to report each installed License Key.

To activate a license for a specific slot/head

1. Install the license key as outlined in the procedure “To install an Ultrix license key”.

2. In the Licenses sub-tab, select the required sub-tab.

• Each row in the tab represents a slot or UltriScape head in the Ultrix router (with slot 1 as the 
topmost slot in the router). 

• The Port column in the tab represents the I/O (or output for the head). 

 Click Clear Offline Ports to hide the I/O ports if the slot does not have a blade installed. Click 
Show Offline Ports to list those ports in the tab columns.

• The Format column represents the video format assigned to that head.

3. In the Port column, select the cell for the slot/head you want to enable.

A drop-down menu displays that lists the available ports.

4. Select Enable to apply the license.

Removing a License Key
When you want to move an Ultrix licensed feature from one slot to another in the same router, you 
must first disable the Ultrix feature on the current Ultrix router. 
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 Removing a License Key also removes user access to all of the Ultrix features associated with that 
License Key.

To remove a Ultrix license key

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The License Keys sub-tab is automatically selected.

6. To remove a license key for a specific slot:

a. Select the sub-tab for the license type you want to remove.

Each row in the sub-tab represents a slot in the Ultrix router. Each column represents a type 
of licensed feature.

b. Select None or Disable to remove the license for the selected slot.

 If available, click Disable All to remove all the licenses of this type from all slots.

 If you wish to apply the same license key to another slot, follow the steps outlined in the 
procedure “Installing a License Key”.

7. To remove a license key from the router:

a. On the License Keys sub-tab, located the row for the licensed feature you want to remove.

b. Click Cancel in the row. 

Locking Access to the Licenses
The Ultrix includes a password-protected feature that prevents unauthorized changes to license 
keys. When the License tab is locked, users require a password to access/edit the license key 
information. This feature is disabled by default (the License tab is editable).

Enabling the Port License Lock
To lock the tab, you must enable the Password Protected settings in the System Status > Setup tab.

To enable the lock on the Port License tab

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. In the Password Protected Settings area, select the Protect all Licensed features with a 
password box.

4. Click Apply at the bottom of the Setup tab.

Changing the Password
It is recommended to change the password from the default value that is assigned at the factory.

 A password must be at least 8 characters long.



Ultrix User Guide (v28-rev5) Software License Keys • 69

To change the password

1. Click Change Password.

The Enable Password Protection dialog opens.

2. If you are changing the password from the default value:

a. In the Password field, type r0ssUltrix.

b. Click Apply.

The Change Password dialog opens.

3. If you are changing the password from a value other than the default:

a. In the Password field, type the character string for the current password.

b. Click Apply.

The Change Password dialog opens.

4. Use the Password field to type the current password.

5. Use the New Password field to type the character string for the new password.

6. Use the Confirm Password field to type the same character string you entered in step 5.

7. Click Apply.

The Change Password dialog closes and the Port License tab is now locked.

Unlocking the Port Licenses via Password
A user can unlock the Port License tab by clicking the Unlock button and entering a password.

To unlock the Port Licenses tab via password

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

6. Click Unlock... .

The Protected Access dialog opens.

7. In the Password field, type the password as defined in step 5 of the procedure “To enable the 
lock on the Port License tab”.

8. Click Apply.
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The Protected Access dialog closes and the Licenses tab is now editable.

 To re-lock the Licenses tab, click Lock.
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Enabling a Service
The Ultrix routers support a set of third-party protocols that enable the router to communicate with 
devices in your routing system. Before creating a connection point (in your database) to each 
device, you must first enable the required protocol(s) on the Ultrix router, and configure any 
settings required for communication. 

This chapter outlines how to enable a communication protocol, and configure the additional 
settings on the router for each protocol (if required). A summary of the supported commands is 
also provided. 

If you have questions about the operation of your Ross devices, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

For More Information on...
• how to create connection points in a database, refer to the Ultrix and Ultricore Database Guide.

Enabling a Communication Service
Use the options in the System > Configuration > Connections > Services interface to enable or 
disable each required service (protocol). This allows your router to communicate with an external 
device that uses the enabled third-party protocol.

To enable a service

1. Locate the Ultrix node in the Tree View of DashBoard

2. Expand the Ultrix node to display a list of sub-nodes.

3. Expand the System sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Connections sub-node.

The Connections interface opens in the DashBoard window with the Incoming Connections tab 
automatically selected.
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6. Select the Services tab.

The Services tab lists the available communications protocols and provides options for 
enabling/disabling each protocol for the router.

 Some services require that a license key is also enabled on your router. Refer to the “Software 
License Keys” to learn more.

7. Enable or disable a service by selecting or clearing the associated box. Choose from the 
following:

• SSH service — Enables the ability to log onto the Ultrix router via an SSH server. Secure Shell 
(SSH) Login is a client-server protocol used by system administrators to securely log onto 
remote systems and execute commands over an unsecured network. SSH may also be used 
by Ross Technical Support for advanced troubleshooting.

• FTP service — Enables the ability to communicate with the Ultrix router over an FTP 
connection.

• Walkabout — Enables the Ultrix router to communicate with Ross Video devices in the 
Walkabout system.

• Ember Plus — Enables the Ultrix router to communicate with a third-party control system via 
the Ember+ media distribution protocol.

• GVG Native — Enables the Ultrix router to communicate via the GVG Series 7000 Native 
protocol and is available over an RS-422 or RS-232 serial connection, or ethernet connection.

• Nvision — Enables the Ultrix router to communicate via a limited sub-set of the NVISION 
serial NP0010 protocol, and the NVISION NP16 ethernet protocol. 

• Probel SW-P-08 — Enables the Ultrix router to communicate via the Probel SW-P-08 protocol. 
This protocol is available over an RS-422 or RS-232 serial connection, as well as an ethernet 
connection.

• RossTalk — Communications via the RossTalk protocol (a plain text based protocol that 
allows control of Ross Video equipment).

• TSL — Enables the Ultrix router to communicate via the TSL UMD v3.1, TSL UMD v4.0, and TSL 
UMD v5.0 protocols.

• NK — Enable this option if there are Ross NK series devices or signal types the Ultrix router 
itself does not handle. The Ross NK series devices must be connected to the ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable communication with the 
Ultrix router.

8. Click Apply.
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Configuring the Service Settings
The Protocol Servers tab lists the currently active servers running in the routing system. This tab is 
auto-populated based on the external devices on the same network as your router and using the 
protocols enabled in the Services tab. Some services require you to configure additional settings on 
the router. This section briefly summarizes those additional settings.

For More Information on...
• the supported protocols, refer to “Server Options and Supported Commands”.

To configure the protocol settings

1. Locate the Ultrix node in the Tree View of DashBoard

2. Expand the Ultrix node to display a list of sub-nodes.

3. Expand the System sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Connections sub-node.

The Connections interface opens in the DashBoard window with the Incoming Connections tab 
automatically selected.

6. Select the Protocol Services tab.

7. Click Options (located in the bottom toolbar).

The Server Options dialog opens.



74 • Enabling a Service Ultrix User Guide (v28-rev5)

8. Locate the options for the third-party protocol you wish to configure for communications.

9. Refer to the following sections for a summary of the settings based on the protocol.

10. Click Apply.

The Server Options dialog closes and the new settings are applied.

Third-Party Protocols
The Ultrix control system is able to control third-party matrix devices. Two popular routing 
protocols are available to enhance compatibility: GVG Series 7000 and Probel SW-P-08.

You must define an interface for the system to access third-party matrix devices. The connection 
point must be compatible with the settings of the external device you are trying to control.

Before proceeding, ensure that you have the following connection specifics:

• Communication protocol 

• Communication type (TCP/IP or serial1)

Ethernet Communication
The Ethernet interfaces to these protocols are automatically started with Ultrix and no further 
configuration is necessary. However, you must configure your external control systems to match 
the settings outlined in Table 18. The Protocol Options are outlined with the respective protocol 
details in the following sections.

The Ultrix router can communicate with third-party external devices via a TCP connection. By 
default, Ultrix provides a server process for the following Ethernet protocols:

1. Only available natively. Serial connections from Ultrix requires an external USB-serial converter.

Table 18  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788
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Serial Communication
Ultrix may communicate directly with third-party devices using a native serial protocol. A 
USB-to-Serial converter must be used to give the Ultrix a serial communication port. Refer to 
Table 19 for information on the supported protocols.

Only USB-serial devices based on these chip-sets are supported: FTDI Chip, Belkin, Prolific PL 
2303, and Silicon Labs CP210x. 

 A serial connection point must be implemented on Ultrix before communications can start. The 
settings may be changed from the protocol defaults to suit your requirements. The Protocol 
Options are outlined with the respective protocol details in the following sections.

Server Options and Supported Commands
Some protocols require additional settings be configured on the router. The following sections 
outline these required settings based for each protocol.

GVG Series 7000 Native Protocol Commands
The router supports the GVG Series 7000 Native protocol and is available over an RS-422 or RS-232 
serial connection, as well as an ethernet connection. Refer to Table 20 for connection details.

TSL UMD v3.1 TCP: 5727
UPD: 4490

TSL UMD v4.0 TCP:5728
UDP: 4491

TSL UMD v5.0 TCP: 5729
UDP: 4492

Table 19  Supported Protocols — Serial Connections

Protocol
Settings

Type Baud Data Bits Parity Stop Bits
GVG Native Series 7000 RS232 or RS422 38400 8 None 1

Probel SW-P-08 RS232 or RS422 38400 8 None 1

TSL UMD v3.1 RS422 or RS485 38400 8 Even 1

TSL UMD v4.0 RS422 or RS485 38400 8 Even 1

TSL UMD v5.0 RS422 or RS485 38400 8 Even 1

Table 20  Default GVG Native Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Table 18  Supported Protocols — Ethernet Connection

Protocol Default Port
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Table 21 summarizes the Server Options for the GVG Series 7000 Native protocol.

  

To send GVG Native commands to the router

1. Create a network connection to the router on TCP/IP Port 12345.

2. A valid connection is reported in the Connections > Incoming Connections interface.

3. Refer to Table 22 for a list of supported GVG Native Protocol commands.

Parity None

Stop Bits 1

Ethernet
Port (incoming) 12345

Port (outgoing) 12345a

a.For outgoing connections, port 12345 is the default value but is 
user configurable.

Table 21  Server Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on protocol 

layer 4 (Ethernet only)

No Do not send acknowledgments. This is the default.

Table 22  GVG Native Protocol Commands

Message
Notes

Command Description
BK[,parameter]

BK,D Force next QD command to return 
status of all destinations

Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all 
destinations being returned.

BK,E Request status of level 4 echo setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response (e.g. 
Take commands).
This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific destination from 
having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination status by 
name

QD[,dest_name] Query Destination status by name No information is returned for unmatched destination levels

Qd[,dest_name] Query Destination status by name Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by indexa

Qi,destIndex,lvlIndex Query Destination status by indexa The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by indexa No information is returned for unmatched destination levels

Table 20  Default GVG Native Connection Types

Setting
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For More Information on...
• these commands, refer to the GVG protocol documentation.

NVISION Commands
This section outlines the NVISION protocol commands supported by the router.

 Ensure that the Ultricore-NVISION license is installed for your router. Refer to the Ultrix User 
Guide for details.

Table 23 summarizes the settings in the Server Options dialog for the NVISION protocol.

  

NVISION NP16 Ethernet Protocol

The router supports the NVISION NP16 Ethernet protocol. Table 24 outlines the default values for 
the router when using NP16.

Qj Query Destination status by indexa Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter

QN,S Query source names/labels As defined inactive database

QN,D Query destination names/labels As defined inactive database

QN,L Query level names/labels As defined inactive database

QN,IS Query names via source indexa

QN,ID Query names via destination indexa

QT Query date and timea

TA,dest_name,nbr_sources,src_name_
entry1[,...src_name_entryn]

Takes sources (on specified levels) to 
specified destination, by name rather 
than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or specified 
levels

Src_name_entryn = src_name[,levelbitmap]
No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level indexa

TJ,destIndex,nbr_sources,srcIndex,lev
el_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified levels) to 
specified destinations by index rather 
than name; allows breakaways

TS,salvo_name Request Take Salvo TS,salvo_name

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.

a.Zero-based hex logical index numbering.

Table 23  Server Options — NVISION protocol

Option Setting Notes
Offset 0 The Ultrix level matches the NVISION level

1 The Ultrix level is the NVISION level plus 1

Table 24  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 22  GVG Native Protocol Commands

Message
Notes

Command Description
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NP16 Commands

The NP16 protocol defines the message format as follows: 

Protocol ID | Sequence Number | byte count | Command

Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultrix response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 25.

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 
in Ultrix. This is true for sources, destinations, and level values.

Refer to Table 25 for a list of supported NP16 commands.

NVISION NP0010 Serial Protocol

The router supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 26 outlines the router default values for an NP0010 serial connection.

Refer to Table 27 for a list of supported NP0010 commands.

Table 25  NP16 Protocol Commands

Message
Notes

Command Description
0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only

Table 26  Default Connection Types — NVISION NP0010 Serial

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 115200

Data Bits 8

Parity No

Stop Bits 1

Table 27  NP0010 Protocol Commands

Message
Notes

Command Description
0x50 Take Non-timestamped version only

0x51 Destination status Get destination status

0x55 Lock destination Assert a destination lock
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Probel SW-P-08 Protocol Commands
The router supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection. Table 28 provides the default values for this protocol.

 

Table 29 summarizes the settings in the Server Options dialog for the Probel SW-P-08 protocol.

  

0x56 Protect destination Assert a destination protect

0x58 Release destination lock/protect Releases the destination lock and protect

0x66 Destination LPR state Get destination locked/protect/released 
status

Table 28  Default Probel SW-P-08 Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet
Port (incoming) 8910

Port (outgoing) 8910a

a.For outgoing connections, port 8910 is the default value but is 
user configurable.

Table 29  Server Options — Probel SW-P-08 protocol

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received command 
format (e.g. if received a non-extended command, 
reply in a non-extended format). This is the default.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. This is the default.

Table 27  NP0010 Protocol Commands

Message
Notes

Command Description
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Table 30 lists the supported Probel SW-P-08 Serial Protocol commands.

Unused Field # Send number (0-15) in either Level or Matrix field - 
which ever is not used as per Matrix Mode setting. The 
default is 0.

Do not wait for ACK Yes Ultrix will not wait for message acknowledgments 
between connect responses

No Ultrix will wait for message acknowledgments between 
connect responses. This is the default.

Batch Collate Timea # milliseconds Wait up to 100 milliseconds for multiple commands 
received before processing. The default is 0 (which 
disables this feature). 

Batch Collate Split Size # received 
commands

Wait up to 100 received commands before processing. 
The default is 0 (which disables this feature). 

a.When both Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will release the 
batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 30  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status
Cmd22: Byte max dest 191
Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group Salvo 122 Crosspoint Connect On Go Group Salvo 
Acknowledge

Add crosspoint to preset 
group

Table 29  Server Options — Probel SW-P-08 protocol

Option Setting Notes
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to the router

1. Create a network connection to the router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 31 for a list of supported 
commands.

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

124 Crosspoint Group Salvo Interrogate 253 Extended Crosspoint Group Salvo Tally Preset group status

Table 31  RossTalk Protocol Commands

Message
Notes

Command Description
GPI ## Execute the salvo number corresponding to the 

numerical ## extension of the command
For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the Ultrix 
database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

Table 30  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
Notes

Cmd ID Description Cmd ID Description
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For More Information on...
• adding a RossTalk label to an Ultriscape layout, refer to the Ultriscape User Guide.

TSL UMD Protocol v3.1 Commands
Table 32 outlines the default values for the router when using TSL UMD v3.1.

TIMER ##:END Request Timer ID to end

TXTLABEL ID:<id>; TEXT:<text>; 
BGCLR:<bgcolor>; TXTCLR:<textcolor>

Where:
• <id> is a unique “rosstalk id” associated with 

an Ultriscape RossTalk display object. This 
field is compulsory.

• <text> is the text to be displayed. This field is 
optional.

• <bgcolor> is the background color of the text 
label. Specified in comma separated RGB 
format using 2 byte hex values (e.g. 
RR,GG,BB). This field is optional.

• <textcolor> is the text color of the text label.                
Specified in comma separated RGB format 
using 2 byte hex values (e.g. RR,GG,BB). This 
field is optional.

There is a 20 character maximum.
Messages with only the id field will be ignored. 
The following is an example of a message:
TXTLABEL ID:25; TEXT:CAM1; 
BGCLR:0x00,0x00,0x00; 
TXTCLR:0xFF,0xFF,0xFF

Note that <bgcolor> and <textcolor> are 
specified as R,G,B triplet. For example:
• 255,255,255 or 0xff,0xff,0xff is white

• 0,0,0 or 0x0,0x0,0x0 is black

• 255,0,0 or 0xff,0x0,0x0 is red 

XPT D:<dest> S:<source> I:<user_id> [L:<levels>] Crosspoint command for a router TAKE where:
• <dest> is the logical destination ID from the 

active database (1-based)

• <source> is the logical source ID from the 
active database (1-based)

• <user_id> is the numeric user/panel ID that 
will be used to request the switch

• <levels> is an optional parameter specifying 
comma-separated list of 1-based level IDs to 
switch (for breakaway, e.g. L:1,2,4). If no 
levels are specified, a follow switch (all valid 
levels) is requested. 

• <levels> supports ranges specified by two 
numbers separated by dash (e.g. L:1-16)

Range start value must be less than the end 
value
Single levels and ranges can be mixed in the 
list (e.g. L:1,3,4-8,12-17)
There are no spaces between numbers or 
ranges
Invalid numbers or improperly specified 
ranges will be ignored 
An argument is separated from its value using 
a single colon (:)
Command arguments are separated single 
spaces
The arguments may be specified in any order, 
(e.g. these are equivalent: XPT D:1 S:4 I:2 and 
XPT S:4 I:2 D:1)
Examples:
• ID 7 requesting to switch Dest 2 to Source 1 

on Levels 1,3,5 and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16

Table 32  Default Connection Types — TSL UMD v3.1

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5727

UDP Port 4490

Table 31  RossTalk Protocol Commands

Message
Notes

Command Description
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Protocol Implementation

The router implements the protocol with the following structure:

 DisplayID|Control|DisplayData

Table 33 lists the supported TSL UMD Protocol v3.1 commands.

Refer to Table 34 when using TSL UMD v3.1 and configuring PiP Tallies in an UltriScape Head.

TSL UMD Protocol v4.0 Commands
 Table 35 outlines the default values for the router when using TSL UMD v4.0.

Table 33  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description UltriScape System Use

Display Address 0 - 126 display identification enumeration DisplayID associated with source or destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

a.Green/Red may be swapped by configuring the Global Tally Settings in the UltriScape Head interface.

Bit 1 Tally 2 status Tally 2 (Green)a

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD display text

Table 34  UltriScape Tally Display — TSL UMD v3.1

Red Tally Green Tally Display
ON ON RED IS ON

ON OFF RED IS ON

OFF ON GREEN IS ON

OFF OFF OFF (no tallies are lit)

Table 35  Default Connection Types — TSL UMD v4.0 

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5728

UDP Port 4491
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Protocol Implementation

The router implements the protocol with the following structure: 

Header | Control | DisplayData | VBC | XData

Table 36 lists the supported TSL UMD Protocol v4.0 commands.

TSL UMD Protocol v5.0 Commands
Table 37 outlines the default values for the router when using the TSL UMD v5.0 protocol.

Table 36  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description UltriScape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea

a.Where 0=off, 1=Red, 2=Green, 3=Amber

Not implemented

Bits 2-3 Text display valuea Sets text background color

Bits 4-5 Left hand tally valuea Displayed in either border or text background; 
can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented
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Table 38 summarizes the settings in the Server Options dialog for the TSL UMD v5.0 protocol.

  

Protocol Implementation

Ultrix implements the protocol with the following structure: 

PBC | Ver | Flags | Screen | DMSG (Index, Control, Length, Text)

Table 39 lists the supported TSL UMD Protocol v5.0 commands.

Table 37  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5729

UDP Port 4492

Table 38  Server Options — TSL UMD v5.0 protocol

Option Setting Notes
Wrapping Yes Wrap commands for TCP mode

No Do not wrap commands (UPD mode). This 
is the default.

PBC in Count Value Yes Include the Packet Byte Count field when 
calculating the byte count value

No Do not include the Packet Byte Count field 
in the byte count value. This is the default.

Table 39  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description UltriScape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG

Index 16bit Display Address DisplayID associated with source or 
destination

Control



86 • Enabling a Service Ultrix User Guide (v28-rev5)

Bits 0-1 Right hand tally valuea Sets right-hand tally indicator color

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text

a.Where 0=Off, 1=Red, 2=Green, 3=Amber

Table 39  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description UltriScape System Use
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Timing and Reference Setup
This chapter outlines how to configure the reference and time settings for your Ultrix router.

For More Information on...
• cabling the reference source for your router, refer to the Ultrix Installation Guide.
• monitoring the reference status, refer to “Monitoring the Reference Signal”.

Specifying a Default Reference Format
If you did not connect a reference source signal to the REF port on the Ultrix rear panel, you can still 
configure a Default Reference format using the options in the Frame Configuration interface. Note 
that this Default Reference setting only applies to start-up with no reference source connected.

Keep the following in mind:

• If you connect a valid reference source to the REF port, it will take precedence over the Default 
Reference setting.

• If the connected reference source becomes unavailable, the Ultrix router will use the last known 
good reference format until a re-boot or power cycle occurs (at which time the Default Reference 
setting will be applied). 

• If the Ultrix router does not have a valid reference signal connected to it, UltriScape still needs a 
reference to output correctly. Specifying the Default Reference Format provides an internal 
reference signal of either NTSC or PAL rates to allow UltriScape to still output with no system 
reference signal connected.

To specify the default reference format for the Ultrix router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the References tab.

7. Use the Detect Reference area to manage the reference formats for the Ultrix router. 

Specifying the Time Source
The Ultrix router requires an external time source in order to accurately report the time-of-day. The 
options in the Frame Configuration interface enable the selection of time/date source via an NTP 
Server in your facility, or you can set the device time to match the computer which is running the 
current DashBoard client.

Using an NTP Server as the Time Source
 Before proceeding, contact your IT Department to learn the IP address(es) of the NTP server(s) in 

your facility. 
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To specify an NTP Server as the time source for the Ultrix router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens and the Communications tab is automatically selected.

6. Locate the NTP Servers area on the Communications tab. 

7. If you are using one NTP server, enter the IP address in the Address field of the Server 1 row.

8. If using a backup NTP server:

a. Enter the IP address of the first NTP server in the Address field of the Server 1 row.

b. Enter the IP address of the backup NTP server in the Address field of the Server 2 row.

9. Select the NTP Enabled box.

10. Verify that the Status field(s) in the NTP Servers table report a valid connection to the listed IP 
address(es). You may need to refresh the interface as follows:

a. Close the Device Configuration interface.

b. Re-open the Device Configuration interface by repeating steps 1 to 4 to update the field(s).

Using the DashBoard Client Computer as the Time Source
This section outlines how to set the Ultrix to the local time without using an NTP Server. Instead, 
you will set the time to the values reported by the DashBoard client computer you are using.

 The time the Ultrix reports is not linked to this computer. It is a once off setting of the time to 
match the computer time when the Set to PC Time button is selected on the Ultrix interface. If 
the DashBoard client computer time changes, you will need to update the time reported on the 
router by repeating the procedure below.

To specify the DashBoard client computer as the time source for the Ultrix router

1. Expand the Devices node.

2. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

3. Select .

The Frame Configuration page opens and the Communications tab is automatically selected.

4. Locate the NTP Servers area on the Communications tab. 

5. Click Set to PC Time. This button is located in the top right corner of the Communications tab.
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Configuring a Timing Offset
You can choose to offset the Ultrix System Status and Device interfaces with respect to UTC Time or 
Daylight Saving Time. Note that the UTC offset does not include any Daylight Saving offset that may 
be in force. The Daylight Saving Time is enabled separately.

 At startup, the UTC Offset is set to 0 to ensure the displayed time matches the system time. 

To specify an offset

1. Expand the Devices node.

2. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

3. Select .

The Frame Configuration page opens and the Communications tab is automatically selected.

4. Locate the time offset options at the top of the System Clock area.

5. To specify an UTC offset, select your current time zone offset from the UTC drop-down menu. 

Once set, the offset will be added or subtracted based off of the system clock, including NTP. 

6. To add one hour to the currently selected UTC Offset (and enable Daylight Saving Time to the 
clocks displayed in the System Clock and Device interfaces), select the Use Daylight Saving 
Time box. 

7. Click Set UTC Offset to apply your changes.

Configuring a Reference Trigger for the Ultrix Router
If multiple reference formats will be fed into the Ultrix router, you can configure a reference trigger 
with a custom switching point. This is useful when you will be manually changing the reference 
signal format that is fed into the REF port on the Ultrix rear panel.

 A variety of switching points across the routing switchers may be required to deal with the range 
of digital video formats that are available. 

To configure the reference trigger for the router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the References tab.

7. Locate the Triggers area in the References tab.
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 Refer to the Ultrix Installation Guide for information on the available REF ports and cabling 
requirements.

The Detected field indicates the format of the reference signal connected to the connected REF 
port on the router.

8. Use the SDI Video Format field to select the switch timing that will be used by the router when 
switching inputs/outputs.

9. If you selected Custom in step 8, use the Custom field to specify the time (number of 
microseconds) from the start of the custom switching line to the actual switching event. The 
maximum value is 65,535us.

10. Repeat steps 8 and 9 to configure additional triggers as required.
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Configuring the SDI I/O Ports
Ultrix is capable of switching video signals1 from 270Mbps to 12Gbps2. This format flexibility 
permits SD, HD, 3G and UHD video signals to be used seamlessly in the same system. Ultrix also 
comes complete with an audio matrix side-chain to enable multiplexing, de-multiplexing, channel 
swapping and processing of the SDI embedded audio.

This chapter provides a general overview of the available options when configuring the SDI I/O and 
AUX ports on the ULTRIX-HDX-IO and ULTRIX-HDBNC-IO blades.

For More Information on...
• the options available on the Port Configuration interface, refer to “Port Configuration 

Interface”.
• configuring the UHD Gearbox, refer to “UHD Gearbox Configuration”.
• configuring the ULTRIX-IP-IO ports, refer to “ULTRIX-IP-IO Setup”.
• configuring the ULTRIX-IPX-IO ports, refer to “ULTRIX-IPX-IO Setup”.
• configuring the ULTRIX-SFP-IO ports, refer to “ULTRIX-SFP-IO Setup”.
• configuring the ULTRIX-MODX-IO ports, refer to the ULTRIX-MODX-IO User Guide.
• the audio features of the Ultrix router, refer to “Configuring an Audio Matrix” and 

“Ultrimix-Dante Setup”.

Using the Device Configuration Interface
The Device Configuration interface in DashBoard enable you to define the physical outputs, inputs, 
and communication ports of the Ultrix router. You can also monitor the overall status of the router, 
or just the status of a specific signal path or port on the rear panel. Use the top toolbar of the 
interface to navigate the interfaces for configuring your blades and ports on the router.

•  Port Configuration — reports individual I/O port status and settings. Selecting a slot 
updates the table for all installed ports. Selecting a port displays only the options for that port 
(the label under the port icon is lit blue).

•  SFP Configuration — configure each populated AUX port on the blade. Also provides 
options for configuring ports on the ULTRIX-SFP-IO blade.

For More Information on...
• the Device Configuration interface, refer to “Navigating the Device Configuration Interfaces”.

Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where:

• Frame identifies the physical router chassis housing the matrix/matrices.
• Slot identifies which slot in the matrix the socket is located in.
• Port identifies the physical input or output socket.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within an SDI stream.

These designators may be assigned more user friendly names if required. Refer to the Ultricore and 
Ultrix Database Guide for details.

1. SMPTE standard rates.
2. Requires the UltriSpeed license.
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Configuring an AUX Port
The various modules available for Ultrix provide SFP+ slots for expansion of the base module I/O 
blade. Refer to the Ultrix SFP Modules Guide for a list of available SFP modules from Ross Video.

Keep the following in mind:

• The FLEX slot in the ULTRIX(-NS)-FR5 does not support any I/O in the AUX ports.
• The ULTRIX-SFP-IO blade only supports MADI in the AUX A and AUX B ports.
• The ULTRIX-IP-IO blade supports Ultriscape outputs (SDI video) only on AUX 1 and AUX 2.
• The ULTRIX-IPX-IO blade supports Ultriscape outputs (SDI video) only on AUX A and AUX B.

 Some licensed features require access to specific AUX ports on the blade. Refer to “UltriStream 
Setup” and “Ultrimix-Dante Setup”.

Before You Begin
You may also need to install an:

• UltriSpeed license for each slot that includes an SFP-HDB-IN-12G and/or SFP-HDB-OUT-12G.
• UltriScape license for each AUX port that will be used to provide an UltriScape head output.
• UltriSRC license for each AUX port configured for asynchronous MADI input.

Configuring an AUX Port
Once the SFP module is installed in an AUX port, you must specify the port type. Select SDI Video for 
video SFP types, or MADI for audio SFP types. MADI audio SFP types allow you to specify the channel 
quantity (either 56 or 64) as per your facilities' standard.

The SFP Configuration interface is organized into two sub-tabs: AUX ports, and SFP ports. The AUX 
Ports tab lists all the AUX ports for all blades in the Ultrix chassis. The SFP Ports tab lists all the 
ULTRIX-SFP-IO blade ports.

For More Information on...
• configuring an AUX port on the ULTRIX-MODX-IO blade, refer to the ULTRIX-MODX-IO User Guide.
• configuring an SFP port on the ULTRIX-SFP-IO blade, refer to “Configuring an SFP Port”.

To configure an AUX port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The SFP Configuration page opens with the AUX Ports tab selected.
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6. From the Slots table, select the router slot for the port you want to configure.

The tab updates to display a list of available ports based on the slot(s) selected.

7. Locate the row for the port you want to configure.

8. In the SFP column, select either SDI Video or MADI as appropriate for the fitted port.

9. Click Apply to save your changes. 

Configuring the SDI I/O Ports
The Port Configuration interface displays the available SDI configuration options in a table format. 
Use the top toolbar to select a specific blade, or click Multi to select multiple blades of the same 
type. Use the Views toolbar to filter the table rows. For example, in Figure 24 the user is viewing the 
ULTRIX-HDX-IO blade in slot 3, but has filtered the table to display only the Input Ports.

Figure 24  Example of an ULTRIX-HDX-IO Blade in the Port Configuration Interface

This section outlines the options in the Port Configuration interface for the Ultrix based on the 
Views settings. Some options may depend on the blade type and installed license keys.

Baseband View
When in Baseband view, you can choose to view options based on the port or channel, and signal 
type (inputs or outputs).
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Baseband > Ports > Inputs View

Table 40 summarizes the options when Views is set to Baseband > Ports > Inputs. (Figure 24)

Table 40  Port Configuration — Views > Baseband > Ports > Inputs

Item Parameters Description
Group # Indicates the Gearbox group where Group 1 is the 

first in the blade

Physical Address slot#.port[#] Lists the physical ports, in ascending order, of the 
Ultrix router. Each row represents a port.

Video (read-only) # If a port is used for video signals, this field indicates 
the video format

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

Timing Lines 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of lines.

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference.

Timing Pixels 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of pixels. 

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Timing Pixels 
(read-only)

Async There is no timing relationship between the input 
signal and the frame reference

Frame Sync 
Delay

# frame(s) Specifies the frame buffer size for the selected input 
port

LoS Statea Black Sets the input to black during the loss of signal

Freeze Sets the input to the last valid frame of video before 
the loss of signal

2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Signal Medic 
(read-only)b

Not available This port does not support the Gearbox feature.

Good This port is included in a Gearbox setup.

Replaced This port can be included in a Gearbox setup but is 
currently not included in the 12G link.
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Baseband > Ports > Outputs View

Table 41 summarizes the options when Views is set to Baseband > Ports > Outputs.

Matte Gen Disable Disable an internally generated test pattern. This is 
the default.

Static Generates a static color matte

Bouncing Box Generates a static color matte with a 
complimentary colored moving box

Luma Sequence Generates a luminance shifting sequence based on 
chosen color

Matte Format # Specifies the signal format of the generated test 
pattern. If you select Auto, the test pattern 
automatically matches the incoming signal type.

Use Default 
Color

Selected

Cleared

Matte Color # Specifies the color of the test signal

Audio Bypass Selected When Audio Bypass is enabled for an input, the 
audio will follow the SDI regardless of any individual 
audio channel routing or configuration on the 
output. 
The individual channels of an input in Bypass mode 
are still de-multiplexed and available for audio 
routing via the audio matrix.

Cleared Disables this feature

a. This affects UltriScape and routed destinations.
b. Use this field to replace a missing 3G signal when one or more of the four 3G signals for a Gearbox configuration 

are unavailable.

Table 41  Port Configuration — Views > Baseband > Ports Outputs

Item Parameters Description
Group # Indicates the Gearbox group where Group 1 is the 

first in the blade

Physical Address 
(read-only)

slot#.port[#] Lists the physical ports, in ascending order, of the 
Ultrix router. Each row represents a port.

Video (read-only) # If a port is used for video signals, this field indicates 
the video format

Audio 
(read-only)

# If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).

Table 40  Port Configuration — Views > Baseband > Ports > Inputs

Item Parameters Description
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2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. 

Disable The indicated I/O is not included in a Gearbox 
configuration

Sub-Image ID 3G Some legacy equipment does not accept a 2SI 
SMPTE-352 payload identifier for quad-link SDI. You 
may need to select this if you are connecting legacy 
equipment to the specified output on the Ultrix.

2SI Set the SMPTE-352 payload identifier to 2SI for 
quad-link.

Clean Switch 
Status 
(read-only)

Locked The specified output is locked to its input.

Not Locked The specified output is not locked to its input.

Clean Switch Selected Clean Switch is applied to the specified output. The 
Clean Switch Delay value is applied.

Cleared Clean Switch is not applied to the specified output.

Clean Switch 
Mode

Reference Clean Switch is based on the reference signal 
available on the REF port of the router

Input Clean Switch is based on the input signal available 
on the specified port of the router

Clean Switch 
Delay

# Specifies the Clean Switch buffer depth. Select 
between 1/16 to full line to clean switch between 
signals with slight timing offsets.

Trigger # Specifies which reference signal trigger to use. Refer 
to the user guide for your router.

Table 41  Port Configuration — Views > Baseband > Ports Outputs

Item Parameters Description
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Baseband > Channels > Inputs View

Table 42 summarizes the columns that display when Views is set to Baseband > Channels > Inputs. 

Transition Cut The audio input channel is immediately switched to 
its selected output. A transition to or from Dolby® 
will always be a Cut transition regardless of what 
the Transition setting is set to.

V Fade The original audio input channel fades down to 
silence followed by the new input channel fades up 
from silence to unity gain level

X Fade The original audio input channel fades down to 
silence as the new input fades up from silence, and 
both will be mixed

Cut Fade The original audio input channel cuts to silence and 
the new input fades up from silence to unity gain 
level

Fade Cut The original audio channel fades down to silence 
and the new input is cut in at unity gain level.

Quiet Cut The original audio channel performs a V Fade 
transition with a 5ms duration

Duration (ms) # Specifies the length of the audio fade, in 
milliseconds, between audio transitions

Table 42  Port Configuration — Views > Baseband > Channels > Inputs

Item Parameters Description
ID (read-only) slot#.port[#].ch Auto-generated identifier for the channel where:

• slot# represents which slot in the matrix the 
socket is located in

• port[#] identifies the physical input or output 
socket

• ch identifies the audio channel within an SDI 
stream

For example, slot1.out[4].audio.ch10.

Label 
(read-only)

<text> Reports the text label that identifies the port in 
other interfaces of the database. This virtual label is 
used instead of the slot.port.type.channel format 
for logical label assignment. 
For example, you might re-name the port: 
slot1.AUXA.audio.ch1 to OUT AES 1.

Signal 
(read-only)

Provides status information on the specified channel.

Table 41  Port Configuration — Views > Baseband > Ports Outputs

Item Parameters Description
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Baseband > Channels > Outputs View

Table 43 summarizes the columns that display when Views is set to Baseband > Channels > 
Outputs. 

Gain (dB) # Provides a +/- 20dB gain range in 0.50dB 
increments. If you have added a gain to an input 
channel, the gain value specified for the output 
channel is an addition. 
For example, if you set the gain for an input to 10dB, 
then specify a gain of 2dB on the output, the total 
gain will be 12dB on the final output

Invert Selected Inverts the polarity of the audio signal for the 
selected channel

Cleared Disables this feature

Sum Selected Sum two adjacent audio channels. Each selected 
channel will carry the average of the two input 
channels ((A+B)/2). 
Select the Sum box for the first channel. The Sum 
box for the second channel is automatically 
selected.
When the input is summed, the original signals are 
no longer available for output.

Cleared Disables this feature

Audio Delay 
(ms)

# Applies up to 500ms of delay per channel. Note that 
an UltriSync license must be enabled to the port.

Table 43  Port Configuration — Views > Baseband > Channels > Outputs

Item Parameters Description
ID (read-only) slot#.port[#].type.ch Auto-generated identifier for the channel where:

• slot# represents which slot in the matrix the 
socket is located in

• port[#] identifies the physical input or output 
socket

• type identifies the generic signal type (e.g. audio)
• ch identifies the audio channel within an SDI 

stream
For example, slot1.out[4].audio.ch10.

Label 
(read-only)

<text> Reports the text label that identifies the port in 
other interfaces of the database. This virtual label is 
used instead of the slot.port.type.channel format 
for logical label assignment. 
For example, you might re-name the port: 
slot1.AUXA.audio.ch1 to OUT 1.

Signal 
(read-only)

Provides status information on the specified channel.

Table 42  Port Configuration — Views > Baseband > Channels > Inputs

Item Parameters Description
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Loss of Input Signal
If the input signal is absent, the output is automatically set to SDI black and Ultrix uses the last 
known and valid video format detected on the output. This feature is similar to a “squelch” control. 
High-speed digital devices will try to lock to any signal. If there is no direct input, they will try to 
equalize noise (to a point), possibly resulting in down-stream equipment having issues with a 
non-valid SDI stream. If there is a router input that is either not terminated, or the upstream device 
outputs a non-valid signal, then the input is forced to SDI black.

Gain (dB) # Provides a +/- 20dB gain range in 0.50dB 
increments. If you have added a gain to an input 
channel, the gain value specified for the output 
channel is an addition. 
For example, if you set the gain for an input to 10dB, 
then specify a gain of 2dB on the output, the total 
gain will be 12dB on the final output

Invert Selected Inverts the polarity of the audio signal for the 
selected channel

Cleared Disables this feature

Sum Selected Sum two adjacent audio channels. Each selected 
channel will carry the average of the two input 
channels ((A+B)/2). 
Select the Sum box for the first channel. The Sum 
box for the second channel is automatically 
selected.
When the input is summed, the original signals are 
no longer available for output.

Cleared Disables this feature

Tone Mode Enable Enable test tones for the specified channel

Disable Disables this feature

Tone Freq # Specifies the type of test tone to embed in the 
output

Table 43  Port Configuration — Views > Baseband > Channels > Outputs

Item Parameters Description
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UltriSync Configuration
This chapter provides an overview of the UltriSync licenses, and how to configure the UltriSync 
settings for an input port.

Overview
UltriSync allows the re-timing of asynchronous or time offset input signals to the frame reference. 
UltriSync is a per input feature and requires a license for each input that will be used by the 
UltriSync. There are two license types:

UltriSync
This license allows for SDI data rates up to 3Gbps (1080p). This license is available on AUX A, AUX B, 
and Inputs 1-16 (a maximum of 18 ports). 

UltriSync-UHD
This license allows the Frame Sync to operate at up to 12Gbps (2160p) data rates. This license is 
available for the ULTRIX-HDBNC-IO, ULTRIX-HDX-IO, or ULTRIX-SFP-IO blades only.

• This license is available on 3 inputs per ULTRIX-HDBNC-IO or ULTRIX-SFP-IO blade:
› AUX B or Input 1
› Input 5 or Input 6
› Input 11 or Input 12

• On the ULTRIX-HDX-IO, this license is provides the following port assignments (with a maximum 
of 16 ports):
› AUX A or Input 1, Input 2-4
› AUX B or Input 5, Input 6-8
› AUX C or Input 9, Input 10-12
› AUX D or Input 13, Input 14-16

Before You Begin
Ensure to:

• Monitor the video input signals via the Timing Lines and Timing Pixels fields in the Port 
Configuration page. These fields report the amount of detected timing offset (in lines and pixels 
respectively) between the incoming signal and the frame reference signal. The timing fields are 
updated every 15 seconds. This information is useful in deciding where to install an UltriSync 
license as follows:
› If there is an input that is out of time with regards to the frame reference, then it would 

beneficial to synchronize it with the frame reference.
› If the timing is +/- half-line, then UltriClean can accommodate the synchronization. The amount 

of pixels per line depends on the video standard being used. For example, 1080p is actually 
1920x1080 pixels (nominally), so 1920 pixels makes one line.

• Install one (or more) UltriSync licenses. Refer to “Installing a License Key”.
• Verify that the video source signals are the same format as the frame reference.
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Configuring UltriSync for an Input Port
UltriSync allows configuration of the frame buffer size between 1 frame and 2 frames. Data is 
clocked out of the buffer using the frame reference, thus timing arbitrarily timed input signals to a 
common clock. The size of the buffer can determine its resilience to incoming signal disturbances.

To assign an UltriSync license to an input port

1. Install the license key as outlined in the procedure “Installing a License Key”.

2. From the Device Configuration interface, select .

The License page displays with the License Keys tab selected.

3. Select the UltriSync tab.

Each row in the tab represents a port on the Ultrix router with each column a type of UltriSync 
license.

4. Select the box in the applicable License column for the port you want to enable an UltriSync 
license for.

To configure the UltriSync settings for an input port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

6. In the Physical Address column, locate the row for the input port you wish to configure.

7. In the FrameSync Delay column, select the buffer size for the required port. Choose from the 
following:

• 1 frame — ensures a short delay (up to 1 frame) in router throughput, but is susceptible to 
incoming stream disturbances like a non-clean upstream switch.

• 2 frames — delays the signal between 1 and 2 frames depending on signal to reference 
timing offset. If an incoming signal is corrupted at a line or single frame rate, then a 2 frame 
buffer can repeat the last known good frame for the corrupted frame thus ensuring a clean 
output.

  If there is a 1 or 2 frame timing difference between the audio and video, try setting the 
FrameSync Delay to 1 frame to minimize the difference.
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UltriClean Configuration
This chapter provides an overview of the UltriClean licensed feature, and how to configure the 
Clean Switch mode for an output port.

Overview
UltriClean allows users to enable a Clean Switch mode and apply a line buffer (delay) on a per 
output basis. Incoming video is buffered based on the timing of the input, and is then output based 
on the timing of the Ultrix system reference (including any offsets added in the Triggers setup). 
Users can then switch between inputs that are not perfectly co-timed without perceiving any 
glitches of the incoming data. Video source timing must remain within the buffer to properly switch 
between sources (buffer depth is user-configurable).

Before You Begin
Ensure that:

• All video sources must be the same video format, locked to the same reference, and vertically 
timed to within the selected Clean Switch window.

• Reference triggers are correctly configured. The trigger format for the selected trigger must 
match the input video format or an equivalent custom trigger set up to comply with RP-168 
Switch point. Refer to “Configuring a Reference Trigger for the Ultrix Router” for details on 
setting up a reference trigger.

Notes on Timing
It possible that you may find a discrepancy on an output from Ultrix when trying to set the 
horizontal time to zero with respect to the reference. 

This is because there is a certain amount of latency through the Ultrix router even with Clean Switch 
disabled for the port. Due to our industry leading internal processing engine which supplies 
advanced features, a certain amount (though minimal) of delay should be expected. This should not 
pose a problem for most digital downstream equipment. If you do encounter a problem, we 
recommend using an external line sync device (such as our SFS-8622 openGear card) to zero time 
the Ultrix router output.

While it may be technically possible to zero time (horizontally) the output of the Ultrix router, it is 
not recommended for the following reasons:

• While you can zero time the output if you disable Clean Switch for that output, there will still be a 
large timing window that you have to exceed in order to get the output timing to re-sync. This is 
due to the line sync is always enabled even though it is put into a very low line length mode 
(resulting in a small the timing window). As a result, every timing adjustment applied to the input 
is ignored on the output until the window is exceeded. Once it is exceeded, the output timing 
jumps. You will need to adjust the timing incrementally until the timing is set to zero. This is 
further complicated during a power cycle where the timing may not be exactly zero as the 
window may have moved slightly on re-boot.

• The frame syncs output timing is hard coded to match the timing of a synchronous input that is 
zero timed at the input to the router.

It is recommended that all synchronous inputs to the router be zero timed to the inputs of the 
router instead of trying to zero time the router outputs.
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Configuring Clean Switch Mode for an Output Port
The Clean Switch mode uses the input signal timing to decide when a frame of active picture begins. 

To configure the Clean Switch mode for an output port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

6. In the Physical Address column, locate the row for the output port you wish to configure.

7. To enable Clean Switch mode for an output, select the Clean Switch box for the output you 
want to configure. 

8. Use the Clean Switch Mode menu to specify timing source. Choose from the following:

• Reference — The Clean Switch is based on the reference signal available on the REF port of 
the router.

• Input — The Clean Switch is based on the input signal available on the specified port of the 
router.

To configure the Clean Switch timing window

1. Navigate to the Port Configuration interface as outlined in “To configure the Clean Switch 
mode for an output port”.

2. In the Physical Address column, locate the row for the output port you wish to apply a delay to.

3. Click in the Clean Switch Delay cell for the output you want to configure. 

A drop-down menu displays.

4. Use the drop-down menu to specify the buffer size to apply.

 This will effectively delay the signal up to the amount specified minus signal-to-reference offset 
for a maximum delay of the chosen setting.

 Select Full Line to add one full line of delay to the output. This will align the output horizontally 
with the reference but with one full line delayed vertically (two lines when using 3G Level B). This 
option is useful if you want a horizontally timed output.
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UltriSRC Configuration
This chapter outlines how to assign an UltriSRC license to an input port.

For More Information on...
• cabling your MADI inputs, refer to the Ultrix Installation Guide.
• configuring an AUX port, refer to “Configuring an AUX Port”.
• audio matrices with MADI, refer to “MADI Overview”.

Assigning UltriSRC to an Input Port
The UltriSRC license is a per port license enabling Sample Rate Conversion for MADI audio inputs. 
The sample rate conversion will re-sample incoming MADI up to 48kHz. This allows MADI sources 
that are not reference-locked to the Ultrix.

To assign an UltriSRC license to an input port

1. Install the license key as outlined in the procedure “Installing a License Key”.

2. From the Device Configuration interface, select .

3. Select the UltriSRC tab.

Each row in the tab represents a physical AUX port on the Ultrix. 

Each column in the second table represents a type of licensed feature and indicates whether it 
is enabled for that input.

4. Select the box in the License column for the physical port you want to enable an UltriSRC 
license for.
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Configuring an Audio Matrix
The UltriMix sub-system provides advanced audio integration, including the ability to embed and 
de-embed audio on all of the inputs and outputs of the router. Users also have complete flexibility 
to process, swap, sum, mute, or route any discrete or embedded audio input to any output. UltriMix 
is perfect for applications where audio is constantly changing, and it can be added as needed 
without throwing away any initial investment in the system.

The Ultrix routers include the following features:

• 16 AES audio channels coming from each input SDI video stream
• Asynchronous processing of all audio channels
• Support for MADI on the AUX ports when a SFP-MADI-COAX, SFP-MADI-850MM, or 

SFP-MADI-1300MM is installed
• Audio channel status Dolby® bit capture and overwrite capabilities

Audio Routing Overview
The Ultrix router handles high-bandwidth, broadcast-quality, digital video and audio signals, and 
embedded audio signals. The Ultrix router can perform signal processing functions like audio 
shuffling and insert into and extra from MADI streams.

Each SDI I/O allows for up to 1 stream of 16 channels of 48kHz sampled, 24bit audio, for a total of 16 
channels. If there are audio channels that are received at a higher rate than 48kHz, the number of 
channels is limited. 

Before You Begin
Keep the following in mind when using the UltriMix feature:

• By default, all embedded audio is de-multiplexed at each input and passed through processing 
(proc-amps) and the audio matrix. 

• Each input has an Audio Bypass configuration option. When Audio Bypass is enabled for an input, 
the audio will follow the SDI regardless of any individual audio channel routing or configuration 
on the output. The individual channels of a input in Bypass mode are still de-multiplexed and 
available for audio routing via the audio matrix.

• Re-mapping of all audio channels from source to destination with transitions is available 
• Audio processing controls are available for each audio channel (gain, sum, invert, tone insert)
• Audio summing of any two adjacent channel pairs is available (1 + 2, 3 + 4, 5 + 6, etc.)

General Configuration Workflow
You may wish to use the following process when defining the database for your audio workflow.

Figure 25  Process for Configuring the Audio Channels
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Enabling the Audio Matrix
You must enable the audio matrix (UltriMix) before you can map the individual audio channels.

 It is recommended to enable/disable the UltriMix feature before database configuration.

To enable the audio matrix

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

6. Select the UltriMix sub-tab.

7. Locate the row for the slot you wish to enable the UltriMix feature for.

8. From the UltriMix column, select Enable.

9. Repeat steps 7 and 8 as required.
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Audio Matrix Routing and Processing
Table 44 summarizes the audio mapping options when using SDI embedded audio or MADI signals.

Table Legend

Notes on Using the Audio Bypass
• Selecting Audio Bypass in the Device Configuration interface forces the embedded audio of the 

input SDI stream to bypass the audio routing section and be routed with the SDI to a Destination 
for all embedded audio channels. 

• Selecting Audio Bypass in the Device Configuration interface for MADI inputs or outputs results in 
a non-valid situation where MADI channels cannot be routed.

Table 44  Audio Mapping Options

Source Destination

ResultAudio 
Mapping

Input Proc 
Amp 

Available

Audio 
Mapping

Output 
Proc Amp 
Available

EMB


EMB


Switches based on logical configuration (with full 
breakaway support)

EMB, PT


EMB


Switches logical configuration (but passes through each 
channel defined as pass-through from the SDI input 
content)

EMB, DS
X

EMB
X

Switches logical configuration (but mutes for each 
channel that has “disconnect” defined)

EMB  MADI  Follows breakaway operation based on logical mapping

EMB, PT


MADI
X

Switches logical configuration (but passes through each 
channel defined as pass-through from the SDI input 
content)

EMB, DS
X

MADI
X

Switches logical configuration (but mutes for each 
channel that has “disconnect” defined) 

MADI


MADI


Switches based on logical configuration (with full 
breakaway support)

MADI, PT  MADI X Not Valid

MADI, DS
X

MADI
X

Switches logical configuration (but mutes for each 
channel that has “disconnect” defined)

 Feature is enabled/available or SDI embedded audio is mapped to audio levels.

X Feature is not enabled/available or no audio levels are mapped

EMB Source or destination is mapped for SDI embedded audio channels

MADI Source or destination is mapped for MADI audio channels

PT ‘passthrough[1].audio’ is defined for some or all source levels

DS ‘disconnect[1].audio’ is defined for some or all source levels
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Defining the Database Audio Levels
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). Refer to “Defining the Levels in a Database” for instructions on how to define a level in your 
database. For each audio level, you will assign a port channel.

 If an audio level is not defined for a given input or output channel of the port, then the output will 
remain at its default selection (slot1.in[1].audio.chxx). For example, if OUT 3 is selected to IN 
10 but only channels 1 - 4 are defined in the logical map, then OUT 3 will have channels of IN 1 
audio mapped to channels 5 - 16. 

In Figure 26, Levels 2-6 are defined for audio channels.

Figure 26  Example of Defined Audio Levels in a Database

MADI Overview
Multi-channel Audio Digital Interface (MADI) is the industry standard for the transmission of up to 
64 audio channels on a single cable. The Ultrix router supports the following SFP module options 
that provide the ability to route discrete MADI:

• SFP-MADI-COAX — the AUX port can receive and transmit MADI signals of 125Mbps over 75 
coaxial cables via HD-BNC connectors.

• SFP-MADI-850MM, SFP-MADI-1300MM — the AUX port can receive and transmit MADI optical 
signals as defined in SMPTE 297-2006.

Figure 27  Example of Ultrix Audio Interconnect using Two SFP-MADI-COAX Options

For More Information on...
• the specifications for your SFP module, refer to the Ultrix SFP Modules Guide.
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Before You Begin
Ensure an SFP Module that supports MADI is physically installed in an AUX port of the Ultrix router.

 Downstream equipment of the Ultrix MADI output may report signal on all channels due to Ultrix 
setting status bits. This is to ensure maximum equipment compatibility.

Configuring an AUX Port for MADI
Each SFP Module that supports MADI includes an IN (Rx) connector and an OUT (Tx) connector. 

 External MADI devices must be timed to the Ultrix reference signal unless an UltriSRC license is 
enabled for a given SFP port.

For More Information on...
• on the input and output connections for your module, refer to the Ultrix SFP Modules Guide.

MADI Inputs

A MADI input source is identified in the routing system using the nomenclature 
Frame.Slot.Port.Type.Channel. For example, ultrix.slot4.AUXA-in1.audio.ch5 where AUXA 
represents the physical AUX port the SFP module is installed, and ch5 represents Channel 5 in the 
MADI signal.

You must define the MADI input channels in the database for your Ultrix router to be able to route 
the individual MADI channels.

MADI Outputs

A MADI output source is identified in the routing system using the nomenclature 
Frame.Slot.Port.Type.Channel. For example, ultrix.slot4.AUXB-out1.audio.ch64 where AUXB 
represents the physical AUX port the SFP module is installed in, and ch64 represents Channel 64 in 
the MADI signal.

You must define the MADI output channels in the database for your Ultrix router to be able to route 
the individual MADI channels.

Mapping the Audio Channels
You can configure audio channels from DashBoard. Note that source and destination logical 
mapping is required to complete the setup of the Ultrix embedded audio routing.

For More Information on...
• mapping the audio channels in a database, refer to the Ultricore and Ultrix Database Guide.

Specifying the Audio Transition Mode
You can specify an audio transition mode for each audio channel output. 

To set the audio transition mode for an audio channel

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.
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5. Select .

The Port Configuration page opens.

6. Select the I/O Module (slot) containing the output(s) you wish to configure.

7. Select Outputs from the Views toolbar.

The Port Configuration page updates to display the options for the selected outputs.

8. Use the Transition field to set the audio transition mode for the audio channel. Choose from 
the following:

• Cut — The audio input channel is immediately switched to its selected output. A transition to 
or from Dolby® will always be a Cut transition regardless of what the Transition setting is set 
to.

• V Fade — The original audio input channel fades down to silence followed by the new input 
channel fades up from silence to unity gain level.

• X Fade — The original audio input channel fades down to silence as the new input fades up 
from silence, and both will be mixed.

• Cut Fade — The original audio input channel cuts to silence and the new input fades up from 
silence to unity gain level.

• Fade Cut — The original audio channel fades down to silence and the new input is cut in at 
unity gain level.

• Quiet Cut — The original audio channel performs a V Fade transition with a 5ms duration.

9. Use the Duration field to specify the length of the audio transition in milliseconds.

Applying Proc Amps to the Embedded Audio Input
Ultrix includes Processing Amplifiers (Proc Amps) for the audio inputs. For each audio channel of an 
input signal, you can set the Bypass Mode, invert selected channels, and sum two adjacent audio 
channels or apply audio delay. The Proc Amp settings are applied before going through the audio 
matrix.

To set up processing of the embedded audio input

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the Ultrix rear panel map, select the port for the audio input you wish to process.

The Port Configuration tab updates to display the audio options for the selected input.

7. Select the Audio Bypass box to a prevent breakaway switching of untimed sources. The router 
will alarm when the audio signal becomes asynchronous to the reference signal provided on 
the REF port of the router.

 Select the Audio Bypass box if the input is asynchronous to other inputs. This will avoid any 
improper mapping of the associated audio channels onto other asynchronous outputs. 

8. To apply a gain to a channel, use the associated Gain field to select a value between -20dB and 
20dB.



Ultrix User Guide (v28-rev5) Configuring an Audio Matrix • 113

9. To invert a channel, select the associated Invert box. 

10. To sum two adjacent audio channels, select the Sum box for the first channel.

The Sum box for the second channel is automatically selected.

 Each selected channel will carry the average of the two input channels ((A+B)/2). When the input 
is summed, the original signals are no longer available for output.

11. Apply up to 500ms of delay per channel.

 The audio delay feature requires an UltriSync license applied to the port.

12. If required, repeat steps 6 to 11 for each audio input you want to configure.

Applying Proc Amps to the Embedded Audio Outputs
The Ultrix router includes Processing Amplifiers (Proc Amps) for the audio outputs. Proc Amp 
adjustments are applied in the following order:

1. Gain — This option provides a +/- 20dB gain range in 0.50dB increments. If you have added a 
gain to an input channel, the gain value specified for the output channel is an addition. For 
example, if you set the gain for an input to 10dB, then specify a gain of 2dB on the output, the 
total gain will be 12dB on the final output.

2. Invert — This option enables you to invert the polarity of the audio signal for the selected 
channel.

3. Sum — This option enables the selected channels to carry the average of the specified channels 
((A+B)/2). 

To configure the embedded audio outputs

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the Ultrix rear panel map, select the port for the output you wish to configure.

The Port Configuration interface updates to display the audio options for the selected output.

7. Use the Trigger menu to specify which reference signal trigger to use. Refer to “Configuring a 
Reference Trigger for the Ultrix Router” for details.

8. To apply a gain to a channel, use the associated Gain field to select a value between -20dB and 
20dB.

9. To invert a channel, select the associated Invert box. 

10. To two adjacent audio channels, select the Sum box for the first channel.

The Sum box for the second channel is automatically selected.

 Each selected channel will carry the average of the two channels ((A+B)/2). When the output is 
summed, the original signals are no longer available for output.

11. To insert a test tone into a channel:
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a. Use the Tone Freq menu to specify the type of test tone to embed in the output. 

a. Use the Tone Mode menu to enable test tones for that channel.

12. Repeat steps 6 to 11 for each channel you wish to configure.

Examples of Audio Configured Databases
UltriMix enables access to the 16 audio channels embedded in the SDI stream. 

Muting Embedded Channels
Once the various channels are mapped to levels, then we may treat those channels individually akin 
to them being independent physical connections to the router. For example, we may define a 
source to the router as:

With this mapping, we may route the embedded channels to any other audio enabled destination 
by selecting levels required prior to making our route selection.

Consider the case where only the first audio group (Embedded channels 1, 2, 3 and 4) are needed 
for routing. What occurs to the other 12 channels of the SDI stream that are not mapped?

The remaining audio channels within the SDI stream are still there and even though they are not 
explicitly defined within the logical map. They will remain at a default routing of 1-to-1 (i.e.; input #1 
embedded channel #8 will always be routed to output #1 embedded channel #8). It may be 
undesirable to have these extra embedded audio channels routed this way, so a “Disconnect” may 
be defined for the input channels not required. 

Switching Bilingual Sources
This example assumes the following setup:

• Embedded audio channels 1 and 2 are the primary channels.
• Incoming sources have English on Embedded channels 1 and 2, and French on 3 and 4.

The Sources are defined as follows:

The Destinations are defined as follows:

Source SDI Level 1 Level 2 Level 3 Level 4 ...
Input1 SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 ...

... ... ... ... ... ... ...

Source SDI Level 1 Level 2 Level 3 Level 4 Level 5 ... Level 16
Input1 SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 Disconnect ... Disconnect

...... ... ... ... ... ... ... ...

Sources SDI Level A1 Level A2 Level A3 Level A4 ...
SRC1 EN SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 ...

SRC1 FR SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 SDI.in[1].ch1 SDI.in[1].ch2 ...

Destinations SDI Level A1 Level A2 Level A3 Level A4 ...
Dest 1 SDI.out[1] SDI.out[1].ch1 SDI.out[1].ch2 SDI.out[1].ch3 SDI.out[1].ch4 ...

... ... ... ... ... ... ...



Ultrix User Guide (v28-rev5) Configuring an Audio Matrix • 115

To route Src1 to Dest1 and swap the Primary Audio from English to French

1. Select the Destination.

2. Select the Source.

The resulting status would be:

The Destination will have the video from SDI.in[1] but embedded channels Level A1 and Level A2 
will have the input SDI embedded channels 3 and 4 respectively which we have previously defined 
as being our French language stereo pair. Note that in this example the English language stereo pair 
are still available but now on the destination channels Level A3 and Level A4.

If pair Level A3 and Level A4 are not required to be muted, the source definitions change to contain 
a 'disconnect' in the Level A3 and Level A4 levels (and any other levels requiring muting): 

Embedded Channel Routing
Embedded audio routing encompasses the following scenarios:

• Embedded channels to embedded channels
• Embedded channels to MADI channels
• MADI channels to Embedded channels
• MADI channels to MADI channels

To accommodate these scenarios, the database source table defines many individual channels in 
addition to the standard SDI plus audio source. In the examples below, In 1 is our SDI and audio 
source - our normal “audio follow video” source. Also defined are the individual embedded audio 
channels that will allow routing of these to other audio destinations.   

 If all 16 channels of embedded audio are not required or used, then only the in-use channels 
need be defined. This can serve to reduce the source table size to just the required definitions.

Status SDI Level A1 Level A2 Level A3 Level A4
Dest1 SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 SDI.in[1].ch1 SDI.in[1].ch2

Sources SDI Level A1 Level A2 Level A3 Level A4 ...
SRC1 EN SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 disconnect[1].ch1 disconnect[1].ch1 ...

SRC1 FR SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 disconnect[1].ch1 disconnect[1].ch1 ...
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The Source definitions for SDI IN 1 and its individual embedded audio channels are defined as 
follows:

The Destinations for SDI outputs are defined as follows:

The Source definitions for MADI inputs are defined as follows:

The Destinations for MADI outputs are defined as follows:

Embedded Channels to Embedded Channels
If we wish to perform the route as illustrated below (a channel swapping route) where the audio.ch3 
and audio.ch4 are to be routed to destination audio.ch1 and audio.ch2, we need to route the 
embedded channels individually as our default mapping provides no common control levels 
between source audio.ch3 and audio.ch4 and destination audio.ch1 and audio.ch2.

To route Audio Channels 3 and 4 from Src1 to SDI OUT 1 Channels 1 and 2

1. Select the Destination (Out 1).

Sources SDI Level A1 Level A2 ... Level A15 Level A16
In1 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

In1 ch1 audio.ch1 audio.ch1 ... audio.ch1 audio.ch1

In1 ch2 audio.ch2 audio.ch2 ... audio.ch2 audio.ch2

... ... ... ... ... ... ...

In1 ch16 audio.ch16 audio.ch16 ... audio.ch16 audio.ch16

Destination SDI Level A1 Level A2 ... Level A15 Level A16
Out1 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

Out2 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

... ... ... ... ... ... ...

Sources SDI Level A1 Level A2 ... Level A15 Level A16
MADIch1 audio.ch1 audio.ch1 ... audio.ch1 audio.ch1

MADIch2 audio.ch2 audio.ch2 ... audio.ch2 audio.ch2

... ... ... ... ... ...

MADIch63 audio.ch63 audio.ch63 ... audio.ch63 audio.ch63

MADIch64 audio.ch64 audio.ch64 ... audio.ch64 audio.ch64

Destination SDI Level A1 Level A2 ... Level A15 Level A16
MADIch1 audio.ch1 ...

MADIch2 audio.ch2 ...

... ...

MADIch63 audio.ch63 ...

MADIch64 audio.ch64 ...
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2. Perform the first switch (Switch the SDI Level) as follows:

a. Select the SDI Level.

b. Select the Source (In 1).

c. Press TAKE to switch.

3. Perform the second switch (Source In1ch3 on Audio Level 1) as follows:

a. Select Level A1.

b. Select the Source (In1 ch3).

c. Press TAKE to switch.

4. Perform the third switch (Source In1ch4 on Audio Level 2) as follows:

a. Select Level A2.

b. Select the Source (In1ch4).

c. Press TAKE to switch.
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The Level buttons serve to indicate the Destination channels we are routing to.

Embedded Channels to MADI Channels
To route embedded channels to MADI channels, select a MADI channel destination, then select the 
appropriate source. If the current level mask or breakaway contains level A1, then level A1 does not 
need specific selection. As the destination MADIchx contains only physical port assignments in level 
A1, then all other levels are ignored.

The following illustrates routing source In1 embedded ch3 and ch4 to our MADI destination on ch5 
and ch6 respectively:

1. Select the Audio Level.

2. Perform the first switch (Source In1ch3 to Destination MADIch5) as follows:

a. Select the Destination (MADIch5).

b. Select the Source (In1ch3).

c. Press TAKE to switch.

3. Perform the second switch (Source In1ch4 to MADIch6) as follows:

a. Select the Destination (MADIch6).

b. Select the Source (In1ch4).

c. Press TAKE to switch.
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MADI Channels to Embedded Channels
Routing MADI input ch5 and ch6 to SDI embedded ch1 and ch2 of Out 2 is as follows:

1. Select the Destination (OUT 2).

2. Perform the first switch as follows:

a. Select Level A1.

b. Select the Source (MADIch5).

c. Press TAKE to switch.

3. Perform the second switch.

a. Select Level A2.

b. Select the Source (MADIch6).

c. Press TAKE to switch.

MADI Channels to MADI Channels
Routing MADI inputs to MADI outputs is as follows:

1. Select the Destination.

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE

DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2



120 • Configuring an Audio Matrix Ultrix User Guide (v28-rev5)

2. Perform the first switch.

a. Select the Destination (MADIch3).

b. Select the Source (MADIch5).

c. Press TAKE to switch.

3. Perform the second switch.

a. Select the Destination (MADIch4).

b. Select the Source (MADIch5).

c. Press TAKE to switch.
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UHD Gearbox Configuration
Ultrix provides maximum performance and quality with standard configurations supporting data 
rates up to 12Gbps. In addition, you can purchase the UltriSpeed software license that enables 
12Gbps performance throughout every signal path within the router. When combined with the 
inherent capabilities within the router, the UltriSpeed license also enables routing of the emerging 
single link UHD (50Hz, 60Hz) standard alongside Quad-link UHD signals, and seamlessly switch 
these signals back and forth to each other.

 The Ultrix Gearbox function supports the two sample interleave (2SI) format of quad link. Note 
that Square Division Quad Split is not implemented.

Example Setup for Multiplexing
Assign Gearbox Group 1 on the Ultrix router to be 4:1 (multiplex four 3Gbps inputs into a single 
12Gbps output). The router OUT 1 BNC is the combined signal of IN 1-4. The OUT 2, 3, and 4 BNCs 
are reserved by the system.

Figure 28  Example of Gearbox Workflow of an Ultrix Router — Multiplexing to a 12Gbps Signal

Table 45  Example Mapping for Multiplexing

Name Channel 1 Channel 2 Channel 3 Channel 4
Source
QUAD IN slot2.in[1] slot2.in[2] slot2.in[3] slot2.in[4]

Destination
12G OUT slot2.out[1]
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Example Setup for De-multiplexing
Assign Gearbox Group 1 on the Ultrix router to be 1:4 (de-multiplex a single 12Gbps input into four 
3Gbps outputs). The router OUT 1, 2, 3, and 4 BNCs are the split output signals.

Figure 29  Example of Gearbox Workflow of an Ultrix Router — De-multiplexing a 12Gbps Signal

Gearbox Overview
A Gearbox is a group of four consecutive inputs or four consecutive outputs that are automatically 
grouped together in the Ultrix database. The first port of the Gearbox group is used for routing and 
UltriScape, while the remaining three ports in the group are reserved but not used (they are not 
listed in the Third Party Matrices, Sources, and Destinations tabs of the database).

• When you enable a Gearbox input group, Ultrix multiplexes the signals of the four 3Gbps Level A 
channels together. 

• When you enable a Gearbox output group, Ultrix takes the signals of the four 3Gbps Level A 
channels together and provides a single 12Gbps signal to an output.

The most common application of a Gearbox is when there are quad channels coming in and out of 
the Ultrix router. The first channel is used as the port for those I/O to define single level of logical 
I/O while only the audio on the first channel is available.

For More Information on...
• cabling for a Gearbox application, refer to the Ultrix Installation Guide.

Table 46  Example Mapping for De-multiplexing

Name Channel 1 Channel 2 Channel 3 Channel 4
Source
12G IN slot1.in[4]

Destination
QUAD OUT slot2.out[1] slot2.out[2] slot2.out[3] slot2.out[4]
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Signal Medic
The Signal Medic is a function that attempts to ‘repair’ the incoming Gearbox signal group if one of 
the four input stream is temporarily interrupted. The Signal Medic will replace the missing stream 
with an interpolated version derived from the other incoming signals. 

For More Information on...
• the Signal Medic options, refer to Table 40.

Gearbox Timing
Ultrix Gearbox requires all four of the input signals be within 350ns of each other. Cable lengths to 
the Gearbox input should be as matched as practicable.

For More Information on...
• the cable length specifications, refer to the Ultrix Installation Guide.

Configuring the Ultrix Router for Multiplexing Quad Input Signals
When I/O ports are enabled for a Gearbox, the first port of the group is the designated port for 
mapping (the other three ports of the group are reserved but not used). 

Before You Begin
Ensure the following steps are completed before configuring the router to multiplex a 12Gbps 
signal:

1. Install the UltriSpeed software license for the Ultrix router that will multiplex the four 3Gbps 
into one 12Gbps signal.

2. Set up a connection between the external device that will provide the four 3Gbps input signals 
and the Ultrix router, ensuring the four input signals are cabled to the Ultrix rear panel as 
outlined in Table 47. 

3. Set up a connection between the Ultrix router and the external device that will receive the 
12Gbps signal.

4. Make a note of the physical IN BNCs on the Ultrix router that will receive the 3Gbps signals.

5. Make a note of the physical OUT BNC on the Ultrix router that will transmit the 12Gbps signal.

Assigning Physical Router Inputs to a Gearbox Group
The Gearbox inputs are automatically arranged in groups of four (e.g. slot1.in[1] to slot 1.in[4] is 
one group). You can enable up to four Gearbox groups per Ultrix slot.

To assign router inputs to a UHD Gearbox group

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

Table 47  Gearbox Mapping — Default Input Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 slot#.in[1] slot#.in[2] slot#.in[3] slot#.in[4]

2 slot#.in[7] slot#.in[8] slot#.in[9] slot#.in[10]

3 slot#.in[13] slot#.in[14] slot#.in[15] slot#.in[16]
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3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the top toolbar, select the slot that the UltriSpeed license was installed for.

7. In the Physical Address column, locate the first input port in the Gearbox group you wish to 
configure for multiplexing four 3Gbps signals.

8. In the 2-SI Group column, click the cell for the first input port of the Gearbox group.

A drop-down menu opens.

9. Select Enable.

The new setting is applied to the selected port and the three associated ports in the same 
Gearbox group. Note that only the first input in the Gearbox group (e.g. slot1.in[1]) will display 
in the Matrix I/O lists in the Database > Third Party Matrices and Database > Sources tabs.

Assigning a Multiplexed 12Gbps Signal in the Database

You can assign the new 12Gbps signal in the Ultrix database much like assigning an input of any 
other signal type. However, the new 12Gbps signal is now the first input in the Gearbox group (e.g. 
slot1.in[1]) to a Destination in the database. 

The original 3Gbps signals will still display in the Matrix I/O lists in the Ultrix database and can still 
be managed as individual sources in the database. 

Example of a Gearbox Database for Inputs

Table 48 provides an example of mapping the Gearbox inputs in an Ultrix database.

For More Information on...
• managing the sources in a database, refer to the Ultricore and Ultrix Database Guide.

Configuring the Ultrix Router for De-multiplexing a 12Gbps Signal
The Ultrix router is capable of de-multiplexing a 12Gbps SDI sources into four separate 3Gbps SDI 
output signals. 

Before You Begin
Ensure the following steps are completed before configuring the router to de-multiplex a 12Gbps 
signal:

Table 48  Example of Gearbox Input Database Mapping

Source Name SDI Level A1 Level A2
GearBox In 1 Slotx.in[1].sdi.ch1 Slotx.in[1].audio.ch1 Slotx.in[1].audio.ch2

GearBox In 2 Slotx.in[7].sdi.ch1 Slotx.in[7].audio.ch1 Slotx.in[7].audio.ch2

GearBox In 3 Slotx.in[13].sdi.ch1 Slotx.in[13].audio.ch1 Slotx.in[13].audio.ch2
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1. Install the UltriSpeed software license for the Ultrix router that will de-multiplex the 12Gbps 
signal.

2. Set up a connection between the external device that will provide the 12Gbps signal to the Ultrix 
router.

3. Setup a connection between the Ultrix router and the external device that will receive the four 
3Gbps signals.

4. Make a note of the physical IN BNC on the Ultrix router that will receive the 12Gbps.

5. Make a note of the physical OUT BNCs on the Ultrix router that will transmit the processed 
3Gbps signals.

Configuring the Ultrix Router for De-multiplexing a 12Gbps Signal
De-multiplexing an 12Gbps signal produces four 3Gbps SDI signals. These SDI signals can then be 
assigned to separate Ultrix router outputs.

To assign the de-multiplexed signals to a Gearbox group

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the top toolbar, select the slot for the Gearbox group.

7. From the Views area of the tab, click the last button and select Outputs from the I/O dialog.

The Port Configuration page updates to displays the ports configured as Outputs for the slot.

8. In the Physical Address column, locate the first output port in the Gearbox group you wish to 
configure for multiplexing.

9. In the 2-SI Group column, click the cell for the first output port of the Gearbox group.

A drop-down menu opens in the column.

10. Select Enable.
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The new setting is applied to the selected port and the three associated ports in the same 
Gearbox group.

Assigning the De-multiplexed 12Gbps Signal to a Destination in the Database

You can assign the new 3Gbps signals as outputs in the Ultrix database much like assigning a 
destination of any other signal type. Refer to “Defining the Destinations in a Database” for details 
on configuring destinations in your database.

You can still assign the original 12Gbps signal as a source in the Ultrix database much like assigning 
a source of any other signal type. Refer to “Defining the Sources in a Database” for information 
on managing the sources in a database.

Example of a Gearbox Database for Outputs

Table 48 provides an example of mapping the Gearbox outputs in an Ultrix database.

Table 49  Example of Gearbox Output Database Mapping

Destination 
Name SDI Level A1 Level A2

GearBox Out 1 Slotx.out[1].sdi.ch1 Slotx.out[1].audio.ch1 Slotx.out[1].audio.ch2

GearBox Out 2 Slotx.out[7].sdi.ch1 Slotx.out[7].audio.ch1 Slotx.out[7].audio.ch2

GearBox Out 3 Slotx.out[13].sdi.ch1 Slotx.out[13].audio.ch1 Slotx.out[13].audio.ch2
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ULTRIX-IP-IO Setup
This chapter outlines how to configure receivers and senders for the Ultrix router to be used in 
video and audio streaming when an ULTRIX-IP-IO blade is installed in a slot of an Ultrix router 
chassis.

 The ULTRIX-IP-IO supports multicast IP Addresses in the range of 225.x.x.x to 239.x.x.x. Note that 
some addresses in this range are reserved by IANA.

For More Information on...
• the installation and cabling of the ULTRIX-IP-IO, refer to the Ultrix Installation Guide.

What are Receivers, Senders, and Streams?
The following terms may be used throughout this chapter:

Device

A physical, virtual, or software application that may include multiple sources, destinations, senders, 
or receivers.

Flow

The continuous raw media content. It can contain more than one essence (e.g. an audio flow can 
contain multiple channels, and an SDI flow may contain audio and video essences).

A flow is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is 
one type of stream which can carry the flow.

Flows cannot generally be passed around natively, and need to be encapsulated in a stream. Flows 
from the same source are considered “editorially equivalent”, but may be encoded differently. For 
example, a video source may be encoded as 4:2:2 YCbCr uncompressed, 4:4:4 RGB uncompressed, 
and h.265 encoded. Each of these would be a separate flow from a common source.

Receiver

An element within a device that receives exactly one stream, which contains one flow from a 
network.

Sender

An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream

One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, SMPTE ST 
2110-20 Video, or SMPTE ST 2110-30 Audio.

Before You Begin
This section provides information to keep in mind before setting up Ultrix-IP streams.

 Each ULTRIX-IP-IO blade has four ENET ports with 25Gb bandwidth per port. The ports are 
grouped into two pairs where the first pair is ENET 1 and ENET 2; the second pair is ENET 3 and 
ENET 4.
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Audio Streams
Keep the following in mind when setting up audio IP streams:

• Each ENET pair can support a maximum of 8 audio streams.
• Only ENET 1 and ENET 3 support audio streams at this time.
• ENET 2 and ENET 4 are used only for redundant audio streams.
• Each audio stream can carry from 1 to 16 channels.

Video Streams
Keep the following in mind when setting up video IP streams:

• The ULTRIX-IP-IO supports multicast IP Addresses in the range of 225.x.x.x to 239.x.x.x for video 
and audio.

• When using 1080p or lower video formats, each ENET pair can support up to 8 video streams with 
a maximum of 16 streams per ULTRIX-IP-IO blade.

• When using UHD 6G formats (2160p 30/29.97/25Hz), each ENET pair can support up to 4 video 
streams with a maximum of 8 streams per ULTRIX-IP-IO blade.

• When using UHD 12G formats (2160p 60/59.94/50Hz), each ENET pair can support up to 4 video 
streams with a maximum of 8 streams per ULTRIX-IP-IO blade. If the Redundant option is enabled 
for the ENET pair, up to 4 video streams (2 streams in the first port and 2 redundant streams in 
the second port) are available.

• When using a mix of UHD 6G and 12G formats, each ENET pair can support up to 4 video 
streams. For example, 3x12G streams and 1x6G stream.

Redundant Streams
The ULTRIX-IP-IO blade also provides protection switching as per SMPTE 2022-7. This option can be 
enabled for each pair on the blade.

Keep the following in mind when setting up redundant streams:

• You will need to assign a unique IP address to each stream (primary and secondary).
• ENET 2 is reserved for redundant streams when the Redundant option is enabled for that ENET 

pair.
• ENET 4 is reserved for redundant streams when the Redundant option is enabled for that ENET 

pair.
• When an ENET pair is in redundant mode, the stream must be added to the first port of the ENET 

pair (ENET 1 or ENET 3) and a duplicate (secondary) stream is automatically added to the second 
port (ENET 2 or ENET 4 respectively).

Automatic Sender Session Description Protocol (SDP) Updates
When a sender stream is active and its SDI input video format changes to a different and valid 
format, if the new format is allowed by the session (as defined by the Adaptive Input Allowed Input 
Rates setting) and results in an overall system valid configuration (no Ultrix-IP bandwidth limit will 
be exceeded), the sender stream will update itself to use this new format, generating a new version 
of its SDP. The Session and NMOS IDs do not change when the sender stream SDP update is 
performed. This allows the existing streams to adapt so that the Ultrix-IP does not need to track 
new streams. This feature is always enabled and cannot be disabled.

Ultrix-IP monitors all active connections on the system and when senders are updated, the system 
will issue a connection update to all affected receivers with the latest information about the sender 
(the updated SDP description). When using an Ultricore BCS, the Ultricore BCS automatically 
updates the receivers when the subscribed sender changes. 
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This feature is helpful to avoid receivers to be configured with a stale version of the associated 
sender. If the parameters of a sender change, an SDP update is triggered, which is then forwarded 
to all receivers affected by the identified update.

Quick Updates when Streaming from the Ultricore BCS

When the format of the SDI input video changes, the Ultrix-IP updates its own sender and SDP, and 
the Ultricore BCS is notified of this change. The Ultricore BCS then issues a connection update to all 
receivers using this sender. The ST 2110 stream and SDP file are also updated and the video sender 
resumes with the new format.

Protection from Invalid Video Scenarios

If a loss of signal occurs, an automatic SDP update will not occur. In addition, when an input with a 
non-matching frame rate is detected, an alarm in DashBoard is raised. The SDP file remains 
unchanged, but the sender does not transmit the packets. This prevents the entire system from 
switching to an invalid video format or unstable video input.

Using any Supported Control Protocol

The advertised SDP file updates to reflect a valid video format change through all supported control 
protocols, including NMOS, Ember+, and DashBoard advertised network streams. This enables the 
Ultrix-IP to use the new SDP file, and enables the user to update the connections of any active 
receivers to the new format without having to recreate the sender streams.

Requirements

To take advantage of this feature, you will need to:

• Configure the receivers and senders and ensure they are active on the router. If a sender is 
disabled (not active), the incoming changes on the router port of the ULTRIX-IP-IO blade will not 
cause any change on the active configuration.

• When configuring the senders, specify the video format(s) you want to stream via the Adaptive 
Input Allowed Input Rates option for each applicable ULTRIX-IP-IO blade port. 

Overview
The generalized work flow of configuring your ULTRIX-IP-IO is:

1. Download and install the latest version of the DashBoard client software.

2. Contact your IT department for the required IP addresses for your ULTRIX-IP-IO ports.

3. Cable the ULTRIX-IP-IO ports.

4. Configure the protocol settings for the ULTRIX-IP-IO.

5. Configure the Port Network settings.

6. Define the Network Stream Groups.

7. Specify the timing requirements for the ULTRIX-IP-IO.

8. Configure the sender streams for the ULTRIX-IP-IO.

9. Make your connections.

10. Continue to set up your database as outlined in the Ultricore and Ultrix Database Guide.
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Setups with an Ultricore BCS
An Ultricore BCS with the Ultrix-IP license enables the video senders/receiver endpoints to be 
reported as available ports to the router database. The video senders/receivers are seen as part of 
a single video-IP matrix, and the audio senders/receivers are part of a single audio-IP matrix. 

When a video sender stream is active and the video format changes on the SDI input of that 
stream, the Ultricore BCS will automatically detect the update and then updates all the receivers 
subscribed to that sender. This allows the existing streams to adapt.

Refer to the Ultricore BCS User Guide for details on setting up and configuring the Ultricore BCS in 
your routing system.

Figure 30  Example Setup with an Ultricore BCS Redundancy System
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Configure the Protocol Settings
The Ultrix-IP supports media distribution based on NMOS, and Ember+. This section outlines each 
protocol.

 Any changes made to the ULTRIX-IP-IO settings requires a frame reboot.

Configuring the NMOS Settings
The Network Media Open Specifications (NMOS) is enabled by default on the device if one or more 
ULTRIX-IP-IO blades are present. The Ultrix router will automatically look for advertised NMOS 
registries using mDNS and will publish the Device Name and other info in the Frame Configuration 
> Ultrix-IP > NMOS interface. You can also choose to register the router when using Registry Service 
Discovery (RDS).

To configure the NMOS settings

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

The Port Network sub-tab is automatically selected in the left toolbar.

7. Select the NMOS tab on the left toolbar.

 It is not recommended that your media network and management network use the same subnet.

8. Use the Static RDS box to determine how the router will register in an RDS system.

• Selecting the box allows the user to set an RDS IP in the Registry Service Address field and 
forces the router to register to this specific RDS.

• Clearing the box configures the router to use mDNS to automatically register in an RDS on 
the network with the lowest priority.

9. Use the Channel Mapping field to specify the port used for the RDS.

10. Use the Connection Port field to specify the port the NMOS IS-05 Connection service is 
listening on.

11. Use the Node Port field to specify the port the NMOS IS-04 Node service is listening on.

12. Click Apply to save your changes.

Ember+ Communications
Each ULTRIX-IP-IO blade provides two Ember+ ports for controllability. One port will export the first 
8 streams and the second port provides access from streams 9 to 16. The Ember+ port will be 
available on Port 9095 for the IP address assigned to each ULTRIX-IP-IO ports 1 and 3. If accessing it 
through the Ultrix Frame Configuration > Ultrix-IP System interface, the ports will be distributed 
based on slot position as follows:

• Streams 1-8 to Port 500x8
• Streams 9-16 to Port 500x9
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where x is the router slot that the ULTRIX-IP-IO is installed in.

 If the Ultrix router includes two ULTRIX-IP-IO blades, and the intention is to control it via Ember+, 
a total of 4 Ember+ port connections are needed.

To establish a connection between the Ember+ client and the Ultrix, you will need to:

1. Add the Ultrix in the Ember+ client interface using the IP Address assigned to the Ultrix router.

2. Enable SDP patching with the Ember+ client to establish video and audio receivers on the Ultrix.

3. Ensure that all network streams have a consistent audio channel count.

Establishing a Connection

Ensure that SDP patching is enabled with the Ember+ client to establish receivers on the Ultrix.

 Ultrix implements BESS v1.1 for Ember+ support to communicate with third-party controllers.

Mapping

You will need to configure the Senders, and then use the Ember+ controller interface (e.g. Lawo 
VSM) to map the sources to the targets. Refer to the documentation that came with your Ember+ 
controller for details.

Configuring the Port Network
By assigning an IP Address to each port of the ULTRIX-IP-IO blade, you are able to uniquely identify 
it on the network and control it via the DashBoard interface. Each port can be configured separately 
for media traffic.

 All ENET ports are set to DHCP by default.

To assign the network settings for an ULTRIX-IP-IO port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

The Port Network sub-tab is automatically selected in the left toolbar.

7. In the Ultrix-IP Port Network table, locate the row for the slot#.port# you wish to configure.

8. If you are manually configuring the Ethernet settings:

a. Click the cell in the IP Mode column and select Static.

b. Use the IP field to specify the static IP Address for the port. This is the IP Address that is used 
to control and communicate with the specified port.

c. Use the Subnet Mask field to specify the subnet mask for the port. 

d. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN) the ULTRIX-IP-IO will use.
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9. If you want the network settings for the port to be automatically obtained, and DHCP service is 
available on your control network, click the cell in the IP Mode column and select DHCP.

10. Click Apply to save the new settings.

11. Repeat this procedure for the second port you wish to configure.

12. Click Reboot to apply the new settings. This button is located at the bottom of the interface.

The Ultrix is temporarily taken off-line during the reboot.

13. Verify the new settings reported on the Frame Configuration status fields.

Configuring the Timing Settings
The Ultrix supports the Precision Time Protocol (PTP) as defined in the IEEE 1588-2008 standard and 
the SMPTE ST-2059 specification.

 The Ultrix behaves only as a follower and cannot be used as a Boundary Clock or Grandmaster.

Configuring the PTP Settings
You can synchronize the Ultrix to real-time clocks of other devices in the same network. You create 
a profile (use the default settings or create a custom profile) that identifies the Ultrix to the 
Grandmaster clock.

 There are several criteria that PTP clocks compare to determine who will be master and who will 
be follower (called the Best Master Clock Algorithm, or BMCA), and they are evaluated in order: 
Priority1, clock class, accuracy, scaled log variance, Priority2, clock ID (similar to the MAC address). 
Practically, Priority1 is the only setting configured on all clocks to control the outcome of the 
Grandmaster election. If Priority1s are equal, the next criterion is evaluated (clock class) and the 
criteria are evaluated in succession until a Grandmaster is determined.

To configure a PTP default profile for the Ultrix

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select Ultrix-IP > PTP.
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7. Use the Profile menu to specify the standard/specification used for PTP. The default is SMPTE 
ST 2059-2.

 The Domain is automatically set if the Custom PTP Profile is not selected.

8. Click Apply.

To create a custom PTP profile for the Ultrix

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select Ultrix-IP > PTP.

7. Select the Custom PTP Profile box.

8. Use the Domain menu to specify the sub-domain the PTP clock is assigned to. The default is 
127.

 There can be multiple PTP domains operating concurrently within a network. The domain is a 
field in all PTP message headers. Messaging between entities are segregated by domain (e.g. the 
Ultrix is an endpoint configured for domain 128 and ignores messages from a neighboring clock 
configured for domain 127).

Configuring the PTP Settings for a Specific Port
Once you create a PTP profile for the Ultrix, you may want to uniquely define the PTP settings for 
each ULTRIX-IP-IO port. 

To configure the PTP settings for a specific port

1. In the Ultrix-IP > PTP tab of the Frame Configuration page, select the Custom PTP Profile box 
for the required port.

2. Use the Name field to assign a unique identifier to the port.

3. Use the Sync Interval field to specify the number of seconds at which synchronization 
messages are sent from the master clock to the specified ULTRIX-IP-IO port.



Ultrix User Guide (v28-rev5) ULTRIX-IP-IO Setup • 135

4. Use the Announce Interval field to specify the rate of announce messages that the specified 
ULTRIX-IP-IO port requests from the master clock during a unicast session.

5. Use the Announce Receipt Timeout field to specify the number of seconds the specified 
ULTRIX-IP-IO port waits for an announce interval message before timing out.

6. Click Apply.

Enabling Redundant Mode
The ULTRIX-IP-IO enables a user to protect their streams to ensure mission critical operation. Using 
SMPTE ST 2022-7, they can run the same video and audio over two separate, redundant networks in 
case an error occurs.

 This section is only applicable if your system requires protection switching.

Before You Begin
Ensure that:

• your source is capable of sending SMPTE ST 2022-7 streams
• the Ultrix is set up within a protection switching network

Enabling the Redundant Mode
By default, the Redundant mode is disabled. 

To enable the Redundant Mode for an ENET pair

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

The Port Network sub-tab is automatically selected in the left toolbar.

7. In the Ultrix-IP Port Network table, locate the ENET pair you wish to configure.

Each row in the table is an ENET port on an installed ULTRIX-IP-IO blade. 

8. Select the Redundant box for the ENET pair you wish to configure for protection switching.

9. Click Apply.

Configuring the Ultrix for Protection Switching
You will need to assign a unique IP address to each stream (primary and redundant) in the same 
multicast range 

To configure the Ultrix for protection switching

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.
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4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. Select the first port of the ENET pair you enabled the Redundant mode for in the router rear 
panel map, located at the top of the Port Configuration page.

The Port Configuration page updates to display the Summary, and Details tabs for the port. 
The port label, on the router panel map, also displays with a light-blue background. In the 
example below, the user selected slot3.port3 to configure.

7. Configure the primary Senders as outlined in “Configuring the Senders”.

8. Configure the redundant Sender stream for the ENET pair as follows:

a. In the Details > Senders tab, select the first port of the ENET pair you enabled Redundant 
Mode for.

b. Click Edit. This button is located in the bottom right corner of the tab.

The Edit Senders dialog opens.

c. Use the Secondary IP menus to specify the IP address for the secondary (redundant) 
stream. Ensure that it is the same IP Address as the primary stream.

d. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. 
Ensure that it is not the same value as the primary stream.

e. Click OK.

f. Verify the new settings are reported in the Redundancy column of the Senders tab.

9. Configure the primary Receivers as outlined in “Configuring the Receivers”.

10. Configure the redundant Receiver stream as follows:

a. Select Details > Receivers.

b. Select the row for the first port of the ENET pair you enabled Redundant Mode for.

c. Click Edit.

d. Use the Secondary IP menus to specify the IP address for the secondary (redundant) 
stream. Ensure that it is the same IP Address as the primary stream.
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e. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. 
Ensure that it is not the same value as the primary stream.

f. Click OK.

g. Verify the new settings are reported in the Redundancy column of the Receivers tab.

Configuring the Senders
You will need to specify the IP encapsulation properties for the active video and audio. For each 
input signal, you need to specify the IP encapsulation properties for the active video and audio. A 
sender stream on the ULTRIX-IP-IO can be configured with any multicast IP address in the range of 
225.x.x.x to 239.x.x.x.

Make note of the bandwidth allocation for the ULTRIX-IP-IO port to determine the available 
capacity of the port. You can add as many streams to fill up the 25Gb bandwidth of the selected 
ENET port. Once that maximum is reached, new streams will not be accepted and updates will 
only be accepted if the new bandwidth used does not exceed 25Gb.

To display the Senders tab for a port in DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. On the router rear panel map, locate the required ULTRIX-IP-IO slot.

6. Select the port on the ULTRIX-IP-IO slot you wish to configure.

The Port Configuration page updates to display the options for the port with the Summary tab 
automatically selected. 

7. Select the Senders sub-tab.

To add advertised sender streams

1. Click Default. This button is located in the bottom right corner of the tab.

The Setup Default Senders dialog opens.
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2. Use the IP Address field to specify the IP range for the sender.

In the above example, the user entered 239.8.7.1 as the starting point for the sender streams. 
Each subsequent advertised stream after this IP Address (e.g. 239.8.7.2, 239.8.7.3, 239.8.7.4 
etc.) will be added to the Senders tab.

3. Use the UDP Port field to specify the RTP port for the advertised stream.

4. Use the Video RTP Payload and Audio RTP Payload fields to specify the Real-time Transport 
Protocol (RTP) payload IDs used by that sender stream.

5. Use the Video Format field to specify the video format of the signal available for the advertised 
stream.

6. Use the options in the Adaptive Input Allowed Input Rates area to specify the video formats 
that the stream is allowed to follow should the input SDI video format change while the sender 
is enabled.

 This is not a bandwidth reservation. If a sender is set to allow 12G inputs, it is not guaranteed that 
it would follow that video format as all device setups is constrained by the available bandwidth 
on the Ethernet side. If the new video input is valid, but the overall system configuration is invalid, 
the sender will be updated but an alarm is still raised to the user to alert of a video mismatch.

When the sender is updated, all protocols or interfaces that advertise it will be updated with a 
new configuration set and SDP. This includes NMOS, Ember+, and all DashBoard tabs where the 
sender is visible.

7. Use the Audio Codec field to specify the audio compression format for the advertised stream.

8. Use the Audio Channels field to specify the maximum number of audio channels in each 
stream.

9. Select the Add Ancillary Stream box to include the ST 2110-40 ancillary data.

10. Click OK. 

The Setup Default Senders dialog closes and the Senders tab updates to list the sender 
streams advertised using the IP Address specified in step 2.

Make a note of the automatically assigned label in the Name field for each stream. This name will 
be used in the database to represent the specific stream as an output (destination).

To manually add a sender stream

1. Click Add. This button is located in the bottom right corner of the tab.

The Add Senders dialog opens.



Ultrix User Guide (v28-rev5) ULTRIX-IP-IO Setup • 139

2. Use the IP Address field to specify the sender. 

The audio and ancillary (ANC) data will receive the selected IP address with one for audio and 
the second for the ANC.

3. Edit the UDP Port to specify the source port to transmit the data.

4. Use the Type menu to select the type of stream that will be available at the specified IP Address.

 It is recommended to not edit the UDP Port field as this field is auto-populated by the advertised 
stream.

5. Use the Output menu to assign the SDI input signal to the sender stream.

6. If you selected Video & Audio, or Video in step 4, use the Video Format menu to specify the 
video format of the signal available to the sender.

7. Use the options in the Adaptive Input Allowed Input Rates area to specify the video formats 
that the stream is allowed to follow should the input SDI video format change while the sender 
is enabled.

 This is not a bandwidth reservation. If a sender is set to allow 12G inputs, it is not guaranteed that 
it would follow that video format as all device setups is constrained by the available bandwidth 
on the Ethernet side. If the new video input is valid, but the overall system configuration is invalid, 
the sender will be updated but an alarm is still raised to the user to alert of a video mismatch.

When the sender is updated, all protocols or interfaces that advertise it will be updated with a 
new config set and SDP. This includes NMOS, Ember+, and all DashBoard tabs where the sender 
is visible.

8. If you selected Video & Audio, or Audio in step 4:

a. Use the Audio Codec menu to specify the audio compression format for the sender.

b. Use the Audio Channels menu to specify the maximum number of audio channels in the 
specified stream.

9. Click OK.

The Add Senders dialog closes and the new stream is added to the Senders tab.

Make a note of the automatically assigned label in the Name field for the stream. This name will 
be used in the database to represent the specific stream as an output (destination).

To edit a sender stream

1. Select the row for the sender stream you wish to edit in the Senders tab.

2. Click Edit.

3. Edit the fields as required.

 The fields with yellow backgrounds are read-only and cannot be edited.

4. Click OK.

Configuring the Receivers
Receivers are the representation of connections on the router and report the information related to 
all traffic that is received. Receivers can be manually created by manually specifying the IP and UDP 
ports of the sender on the Port Configuration tab, but usually the process of managing receivers is 
done by the external network device. 

This section outlines what is currently present/active on the Port Configuration tab and outlines 
how to manually specify receivers on the router using this interface.
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To display the Receivers tab for a port in DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. On the router rear panel map, locate the required ULTRIX-IP-IO slot.

6. Select the port on the ULTRIX-IP-IO slot you wish to configure.

The Port Configuration page updates to display the options for the port with the Summary tab 
automatically selected. 

7. Select the Receivers sub-tab.

To add a series of receivers

1. In the Receivers sub-tab, click Default. This button is located in the bottom right corner of the 
tab.

The Setup Default Receivers dialog opens.
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2. Use the IP Address field to specify the IP range for the receiver.

In the above example, the user entered 239.19.8.1 as the starting point for the receiver streams. 
Each subsequent advertised stream after this IP Address (e.g. 239.19.8.2, 239.19.8.3, 239.19.8.4 
etc.) will be added to the Receivers tab.

3. Use the UDP Port field to specify the RTP port the receivers will use.

4. Use the Video Format field to specify the video format of the signal the receivers will output.

5. Use the Audio Codec field to specify the audio compression format for the receiver streams.

6. Use the Audio Channels field to specify the maximum number of audio channels in each 
stream.

7. Click OK. 

The Setup Default Receivers dialog closes and the Receivers tab updates to list the receiver 
streams using the IP Address specified in step 2.

Make a note of the automatically assigned label in the Name field for each stream. This name will 
be used in the database to represent the specific stream as an input (source).

To manually add a single receiver

1. In the Receivers tab, click Add. This button is located in the bottom right corner of the tab.

The Add Receivers dialog opens.

2. Use the IP Address menu to specify the IP Address for the transport stream for the receiver.

3. Use the UDP port menu to specify the UDP port number of the transport stream for the 
receiver.

4. Use the Type field to specify the type of signal.

 Selecting Video+Audio automatically creates table entries for one video and multiple audio 
streams.

5. If you selected Video or Video+Audio in step 4, use the Video Format field to specify the video 
format for the stream.

6. If you selected Audio or Video+Audio in step 4, use the # of Audio Channels field to specify 
the audio channels in the stream.

7. Use the Transport IP field to specify the UDP IP address of the transport stream for the signal.

8. Click OK to create a new entry in the Receivers tab.

The Add Receivers dialog closes and the Receivers tab updates with the new receiver stream.

Make a note of the automatically assigned label in the Name field for the stream. This name will 
be used in the database to represent the specific stream as an input (source).

Troubleshooting
Table 50 provides brief explanations for some common stream setup messages.
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Using Senders and Receivers in the Router Database
Throughout the DashBoard interface, the senders and receiver streams (outputs and inputs 
respectively) of a router (or matrix) are referred to by hierarchical dotted notation: 
Slot.Port[x].Type.Channel where:

• Slot identifies which slot in the router chassis the ULTRIX-IP-IO blade is located in.
• Port[x] identifies the physical port on the ULTRIX-IP-IO blade.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within the stream. If the stream is video, the channel 

number is fixed to 1.

Table 50  Troubleshooting the Error Messages

Error Message Cause
Cannot set default due to 
maximum allowable streams has 
reached

ENET pair has reached the maximum number of allowable 
streams

Cannot add 2160P59 video due to 
maximum allowable UHD streams 
has reached

Primary and Secondary UDP port 
cannot be the same

When in Redundant mode, the primary and secondary 
streams must have the same IP address but different UDP 
ports assigned.

This IP port does not have enough 
bandwidth to add 2160P29 video 
stream

The ENET port has reached the maximum 25G bandwidth.

slot#.port# is a redundant IP port. 
It is reserved for redundant 
senders.

The ENET pair is in Redundant mode and you cannot edit 
the second port (ENET 2 or ENET 4) of the pair.

UHD video must be assigned to 
output 1, 2, 3, 4, 9, 10, 11, or 12.

The UHD video stream (6G or 12G) format must be assigned 
to one of the inputs/outputs 1-4 or 9-12.

Address x.x.x.x:x is being used by 
slotx.out[y].#.chz

Each stream must have a unique network address

Video Format mismatch detected The input video format does not match those 
selected/enabled in the Adaptive Input Allowed Input 
Rates setting of the sender stream, or input is not valid.
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Figure 31  Example of Senders in the Port Configuration Interface

 These designators may be assigned more user friendly names if required. Refer to the Ultricore 
and Ultrix Database Guide for details.

Integration Examples
This section describes use cases for video streams.

Using 3G HD Video
The following setups use 3G HD video or lower formats. All streams can fit within the first ENET port 
but there is a maximum of eight video streams per pair.

Redundancy Mode is Disabled

Figure 32 shows two ULTRIX-FR5 routers with the first router (Frame A) transmitting eight 3G HD 
video streams and the second router (Frame B) receiving eight 3G HD streams.



144 • ULTRIX-IP-IO Setup Ultrix User Guide (v28-rev5)

Figure 32  Example of ULTRIX-IP-IO with 3G HD Video Streams

In this setup you would configure eight video streams with 1080p 59.94 format (including the audio 
streams) without redundancy. 

1. For Frame A you would configure eight video sender streams with 1080p 59.94 format (pairing 
two audio sender streams per video stream).

2. For Frame B you would configure eight video receiver streams with 1080p 59.94 format (pairing 
two audio receiver streams per video stream).

3. Ensure that the receiver IP address on Frame B matches the existing sender address on Frame 
A.

Redundancy Mode is Enabled

In this setup, there are eight video streams with 1080p 59.94 format (including the audio streams) 
but the Redundancy Mode is enabled. All streams can fit within the first ENET port but there is a 
limit of eight video streams per pair. The second ENET port is reserved for the redundant streams.

Figure 33 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting eight 3G HD 
primary video streams and eight 3G HD secondary streams. The second router (Frame B) receives 
two sets of eight 3G HD streams (primary and secondary).
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Figure 33  Example of ULTRIX-IP-IO with 3G HD Video Streams — Redundancy Mode

In this setup you would configure eight video streams with 1080p 59.94 format (including audio 
streams) with the Redundancy Mode enabled for each ENET pair in use.

1. For Frame A you would:

a. configure two sets of eight video sender streams with 1080p 59.94 format (pairing two audio 
sender streams per video stream).

b. enable Redundant Mode for the ENET pair where ENET 1 will transmit the primary streams 
and ENET 2 will transmit the secondary (redundant) streams.

2. For Frame B you would:

a. configure two sets of eight video receiver streams with 1080p 59.94 format (pairing two 
audio sender streams per video stream).

b. enable Redundant Mode for the ENET pair. ENET 1 will receive the primary streams and 
ENET 2 will receive the secondary (redundant) streams.

Using UHD 12G Video Format
When using UHD 12G video formats (60/59.94/50Hz), there is a limit of two video streams per ENET 
port with a maximum of three video streams per ENET pair.
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Redundancy Mode is Disabled

Figure 34 shows two ULTRIX-FR5 routers with one (Frame A) transmitting three 12G UHD video 
streams and the second router (Frame B) receiving three 12G UHD streams.

Figure 34  Example of ULTRIX-IP-IO with 12G UHD Video Streams

In this setup you would configure three video streams with 2160p 59.94 format without 
redundancy. 

1. For Frame A you would configure two video sender streams with 2160p 59.94 format on ENET 1 
and one 2160p 59.94 video sender stream on ENET 2.

2. For Frame B you would configure two video receiver streams with 2160p 59.94 format on ENET 
1 and one 2160p 59.94 video receiver stream on ENET 2.

3. Ensure that the receiver IP addresses on Frame B match the existing sender addresses on 
Frame A.

Redundancy Mode is Enabled

In this setup, there are two video streams with 2160p 59.94 format (including the audio streams) 
but the Redundancy Mode is enabled. There is a limit of two video streams per ENET port. The 
second ENET port is reserved for the redundant streams.
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Figure 35 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting two 12G UHD 
primary video streams and two 12G UHD secondary streams. The second router (Frame B) receives 
a primary set of two 12G UHD streams and a secondary set of two 12G UHD streams.

Figure 35  Example of ULTRIX-IP-IO with 12G UHD Video Streams — Redundancy Mode

In this setup you would configure two video streams with 2160p 59.94 format with Redundancy 
enabled for each ENET pair in use.

1. For Frame A you would:

a. enable Redundant Mode for the ENET pair where ENET 1 will transmit the primary streams 
and ENET 2 will transmit the secondary (redundant) streams.

b. configure two sets of two 12G UHD video sender streams with 2160p 59.94 format.

2. For Frame B you would:

a. enable Redundant Mode for the ENET pair. ENET 1 will receive the primary streams and 
ENET 2 will receive the secondary (redundant) streams.

b. configure two sets of two video receiver streams with 2160p 59.94 format.

Using Multiple Video Streams with Different Formats
In this setup, there are multiple video streams with different video formats with a total bandwidth 
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Figure 36 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting four 3G HD video 
streams and one 12G UHD video stream on ENET 1. The second router (Frame B) receives four 3G 
HD streams and one 12G UHD video stream on ENET 1.

Figure 36  Example of ULTRIX-IP-IO with Multiple Streams with Different Video Formats

In this setup you would configure a total of five video streams on each ENET port of each router. 

1. For Frame A you would configure:

a. four video sender streams with 1080p 59.94 format on ENET 1.

b. one 2160p 59.94 video sender stream on ENET 1.

2. For Frame B you would configure:

a. four video receiver streams with 1080p 59.94 format on ENET 1.

b. one 2160p 59.94 video receiver stream on ENET 1.

3. Ensure that the receiver IP addresses on Frame B match the existing sender addresses on 
Frame A.
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ULTRIX-IPX-IO Setup
This chapter outlines how to configure receivers and senders for the Ultrix router to be used in 
video and audio streaming when an ULTRIX-IPX-IO blade is installed in a slot of an Ultrix router 
chassis.

 The ULTRIX-IPX-IO supports multicast IP addresses in the range of 225.x.x.x to 239.x.x.x. Note 
that some addresses in this range are reserved by IANA.

For More Information on...
• the installation and cabling of the ULTRIX-IPX-IO, refer to the Ultrix Installation Guide.

What are Receivers, Senders, and Streams?
The following terms may be used throughout this chapter:

Device

A physical, virtual, or software application that may include multiple sources, destinations, senders, 
or receivers.

Flow

The continuous raw media content. It can contain more than one essence (e.g. an audio flow can 
contain multiple channels).

A flow is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is 
one type of stream which can carry the flow.

Flows cannot generally be passed around natively, and need to be encapsulated in a stream. Flows 
from the same source are considered “editorially equivalent”, but may be encoded differently.

Receiver

An element within a device that receives exactly one stream, which contains one flow from a 
network.

Sender

An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream

One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2110-20 Video, 
SMPTE ST 2110-30 Audio, or SMPTE ST 2110-40 ANC.
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Before You Begin
This section provides information to keep in mind before setting up ULTRIX-IPX-IO streams.

 Each ULTRIX-IPX-IO blade has four QSFP28 ports (ETH1-ETH4) with 100Gb bandwidth per port.

Hardware
The Ultrix software currently supports:

• 100Gb QSFP28 transceiver modules based on 4x25Gb NRZ optical lanes, either requiring no FEC 
or RS(528,514) KR4 FEC, for multi-mode or single-mode fibers, up to power class 7 (5W). For 
example, 100GBASE-SR4, 100GBASE-SWDM4, 100GBASE-PSM4, 100GBASE-CWDM4, 
100GBASE-4WDM-10/20/40, 100GBASE-CLR4, 100GBASE-LR4.

• 100Gb QSFP28 transceiver modules based on 1x100Gb PAM4 optical lane, either requiring no 
FEC or providing built-in RS(544,514) KP4 FEC, for multi-mode or single-mode fibers, up to power 
class 7 (5W). Compliant with the 100G Lambda MSA, including built-in RS(544,514) KP4 FEC. For 
example, 100GBASE-DR, 100GBASE-FR, 100GBASE-LR.

• 100Gb QSFP28 transceiver modules based on 4x25Gb NRZ over shielded balanced copper 
cabling, requiring RS(528,514) KR4 FEC. For example, 100GBASE-CR4.

 Contact Ross Technical Support about other QSFP28 transceiver modules not listed above.

Audio Streams
Keep the following in mind when setting up the ULTRIX-IPX-IO streams:

• The blade supports a maximum of 4 audio streams per SDI (64 audio streams per blade) only 
through the first ENET pair ETH1/ETH2 when used with a stand-alone router. 

• The ULTRIX-IPX-IO is compliant with the SMPTE ST 2110-30 Levels A and C (partial). This results in 
1 to 8 channels at 1ms packet time, or 1 to 16 channels at 125μs packet time.

• The Packet Time is a global setting per ULTRIX-IPX-IO slot for all receivers and senders.

Video and ANC Streams
Keep the following in mind when setting up video and ANC IP streams:

• Each ENET pair can support up to 8 redundant video/ANC streams with a maximum of 16 
streams per ULTRIX-IPX-IO blade.

Protection Switching (SMPTE 2022-7)
The ULTRIX-IPX-IO blade also provides protection switching as per SMPTE 2022-7. This option must 
be enabled globally to enable/disable it for any pair of two streams on the blade. 

Keep the following in mind when setting up redundant streams:

• You will need to assign a unique IP address to each stream (primary and secondary).
• Video and ANC streams 1 to 8 are mapped to ETH1 as the primary stream and ETH2 as the 

secondary stream. 
• Video and ANC streams 9 to 16 are mapped to ETH3 as the primary stream and ETH4 as the 

secondary stream. 
• All 64 audio streams are mapped to ETH1 as the primary stream and ETH2 as the secondary 

stream.
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Automatic Sender Session Description Protocol (SDP) Updates
When a sender stream is active and its SDI input video format changes to a different and valid 
format, if the new format is allowed by the session (as defined by the Adaptive Input Allowed Input 
Rates setting) and results in an overall system valid configuration (no ULTRIX-IPX-IO bandwidth limit 
will be exceeded), the sender stream will update itself to use this new format, generating a new 
version of its SDP. The Session and NMOS IDs do not change when the sender stream SDP update is 
performed. This allows the existing streams to adapt so that the ULTRIX-IPX-IO does not need to 
track new streams. This feature is enabled by default.

 You can disable this feature by deselecting all Adaptive Input Allowed Input Rates (HD, 3G, 6G, 
12G) and selecting a single video format. Only that format will be announced and transmitted. 
Any other format will stop packet transmission and no SDP updates will occur. Switching between 
sources with the same video format is still allowed.

This feature is helpful to avoid receivers to be configured with a stale version of the associated 
sender. If the parameters of a sender change, an SDP update is triggered, which is then forwarded 
to all receivers affected by the identified update.

When using an Ultricore BCS, the Ultricore BCS automatically updates the receivers when the 
subscribed sender changes. 

Quick Updates when Streaming from the Ultricore BCS

When the format of the SDI input video changes, the ULTRIX-IPX-IO updates its own sender and 
SDP, and the Ultricore BCS is notified of this change. The Ultricore BCS then issues a connection 
update to all receivers using this sender. The ST 2110 stream and SDP file are also updated and the 
video sender resumes with the new format.

Protection from Invalid Video Scenarios

When an input with a non-matching frame rate is detected, an alarm in DashBoard is raised. The 
SDP file remains unchanged, but the sender does not transmit the packets. This prevents the entire 
system from switching to an invalid video format or unstable video input.

Using any Supported Control Protocol

The advertised SDP file updates to reflect a valid video format change through all supported control 
protocols, including NMOS, Ember+, and DashBoard advertised network streams. This enables the 
ULTRIX-IPX-IO to use the new SDP file, and enables the user to update the connections of any active 
receivers to the new format without having to recreate the receiver connection manually when the 
sender changes.

Requirements

To take advantage of this feature, you will need to:

• Include an Ultricore BCS (or a broadcast controller) in the routing system to identify the sender 
SDP change and update all receivers associate with that SDP.

• Configure the receivers and senders and ensure they are active on the router. If a sender is 
disabled (not active), the incoming changes on the router port of the ULTRIX-IPX-IO blade will not 
cause any change on the active configuration.

• When configuring the senders, specify the video format(s) you want to stream via the Adaptive 
Input Allowed Input Rates option. 

• Use Ultricore BCS to establish routes from senders to receivers.
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Overview
The generalized work flow of configuring your ULTRIX-IPX-IO is:

1. Download and install the latest version of the DashBoard client software.

2. Contact your IT department for the required IP addresses for your ULTRIX-IPX-IO ports.

3. Cable the ULTRIX-IPX-IO ports.

4. Configure the protocol settings for the ULTRIX-IPX-IO.

5. Specify the timing requirements for the ULTRIX-IPX-IO.

6. Configure the streams for the ULTRIX-IPX-IO.

7. Continue to set up your database as outlined in the Ultrix and Ultricore Database Guide.

Setups with an Ultricore BCS
An Ultricore BCS with the Ultricore-IP license enables the video senders/receiver endpoints to be 
reported as available ports to the router database. The video and ancillary senders/receivers are 
seen as part of a single video-IP matrix, and the audio senders/receivers are part of a single audio-IP 
matrix. 

When a video sender stream is active and the video format changes on the SDI input of that 
stream, the Ultricore BCS will automatically detect the update and then updates all the receivers 
subscribed to that sender. This allows the existing streams to adapt.

Refer to the Ultricore BCS User Guide for details on setting up and configuring the Ultricore BCS in 
your routing system.

Configure the Protocol Settings
The ULTRIX-IPX-IO supports media distribution based on NMOS, and Ember+. This section outlines 
how to configure each protocol.

 Changes made to the ULTRIX-IPX-IO settings may require a frame reboot.

Configuring the NMOS Settings
The Network Media Open Specifications (NMOS) is enabled by default on the device if one or more 
ULTRIX-IPX-IO blades are present. The Ultrix router will automatically look for advertised NMOS 
registries using mDNS and will publish the Device Name and other info in the Frame Configuration 
> ULTRIX-IPX-IO > NMOS tab. You can also choose to register the router when using Registry Service 
Discovery (RDS).

To configure the NMOS settings

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.
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7. Select the NMOS tab on the left toolbar.

8. Select the row for the router slot you wish to configure.

The NMOS dialog opens for the selected slot. In the following example, the user selected Slot 1.

 It is not recommended that your media network and management network use the same subnet.

9. Use the Control Access Interfaces options to enable or disable control via each port.

10. Select the Add BCP-022-01 box to enable AWA BCP-002-01 natural grouping of NMOS resources 
by the Ultrix. This option is disabled by default.

11. Use the Service Ports fields to specify each TCP port as follows:

• Use the IS-04 field to specify the port the NMOS IS-04 Node service is listening on.
• Use the IS-05 field to specify the port the NMOS IS-05 Connection service is listening on.
• Use the IS-08 field to specify the port the NMOS IS-08 Connection service is listening on.
• Use the IS-10 field to specify the port the NMOS IS-10 Connection service is listening on

12. To force the Ultrix to register to a specific Registry Service Discovery on the network:

a. Select the Static RDS box.

b. Use the Address field to set the static IP that the router will use to register to this specific 
RDS.

c. Use the RDS Port field to specify the port used for the RDS.

d. Use the RDS Version field to specify the version of the NMOS registry API.

NMOS IS-10 Setup

The following procedure is only applicable if you have both an NMOS Authorization Server and an 
RDS that is enabled for secure communication via NMOS IS-10.

To configure the ULTRIX-IPX-IO for NMOS IS-10

1. From the Frame Configuration page, select Ultrix-IP > NMOS.

2. Select the row for the router slot you wish to configure.
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The NMOS dialog opens for the selected slot. In the following example, the user selected Slot 1.

3. Select the Enable Authorization (IS-10) box to enable NMOS IS-10 Authorization for the router 
on this slot.

4. Use the Authorization Flow field to define which mode the device will use to authenticate with 
the Authorization Server. 

5. To force the Ultrix to register to a specific NMOS IS-10 Authorization Server on the network:

a. Select the Static Authorization Server box.

b. Use the Address field to set the static IP that the Ultrix router will use to connect to the 
Authorization Server.

c. Use the Port field to specify the port used for NMOS IS-10.

d. Use the Version field to specify the version of the NMOS IS-10 registry API.

e. Use the Selector field to define the location for the registry API. Refer to the IS-10 
specification for details.

6. Use the Security Options to define the NMOS IS-10 secure communication:

• Server uses secure connection — select this option if the Ultrix router will use secure 
communication when it is the server and will receive connection requests from an Ultricore 
BCS or other controller device.

• Client uses secure connection — select this option if the Ultrix router will use secure 
communication when the router is the client (for the registration with RDS and Authorization 
server).

• Validate certificates — select this option only when troubleshooting communication issues. 
This will enable the system setup to bypass the actual validation of the client provided 
certificates. This option should not be selected for production services.

• Server certificates — Click Set to open a dialog to set the server certificates by creating 
entries that references the uploaded security files based on its types/Algorithm used. The 
files are uploaded via the Security files field. The files are used by the server to validate 
certificates and it needs to have a key algorithm, private keys, and certificate chain file.
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7. Use the Files > Security files > Manage to upload security files as follows:

• The categories are pre-defined and not all are required for all setups. For example, some 
systems might not need a Diffie-Hellman file but most systems will require a Certificates 
authorities.

• Once these files are uploaded, they become available for the user to select via the Security 
Options > Certificates authorities file field and the Diffie-Hellman parameters file field.

To enable ACME support

1. Select the Enable ACME box.

2. Use the Server URL field to type the IP address of the ACME server the Ultrix will connect to.

3. Select the Certificate Received box to enable the Ultrix router to report when a valid ACME 
certificate is sent by the NMOS device. The status is reported in the ACME column on the main 
page of the NMOS tab.

Ember+ Communications
If the Ultricore-EMBER+ license is enabled, each ULTRIX-IPX-IO blade provides16 streams via one 
port. The Ember+ port will be available on Port 9095 for the IP address assigned to each 
ULTRIX-IPX-IO port. If accessing it through the Ultrix Frame Configuration > Ultrix-IP > System 
interface, the ports will be distributed based on slot position as follows:

• Streams 1-16 to Port 50xx8 where xx is the router slot that the ULTRIX-IPX-IO is installed in.

To establish a connection between the Ember+ client and the Ultrix, you will need to:

1. Add the Ultrix in the Ember+ client interface using the IP Address assigned to the Ultrix router.

2. Enable SDP patching with the Ember+ client to establish video and audio receivers on the Ultrix.

3. Ensure that all network streams have a consistent audio channel count.

Establishing a Connection

Ensure that SDP patching is enabled with the Ember+ client to establish receivers on the Ultrix.

 Ultrix implements BESS v1.1 for Ember+ support to communicate with third-party controllers.

Mapping

You will need to:

1. Configure the sender sessions in DashBoard.

2. Use the Ember+ controller interface (e.g. Lawo VSM) to map the sources to the targets. Refer to 
the documentation that came with your Ember+ controller for details.

Configuring the Port Network
By assigning an IP Address to each QSFP28 port of the ULTRIX-IPX-IO blade, you are able to uniquely 
identify it on the network and control it via the DashBoard interface. Each QSFP28 port can be 
configured separately for media traffic.

To assign the network settings for an ULTRIX-IPX-IO port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.
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The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

7. Select the Port Network sub-tab.

8. Locate the row for the slot > port you wish to configure.

 All QSFP28 ports are set to DHCP by default.

9. If you are manually configuring the network settings:

a. Click the cell in the IP Mode column and select Static.

b. Use the IP Address field to specify the static IP Address for the port. This is the IP Address 
that is used to control and communicate with the specified port.

c. Use the Subnet Mask field to specify the subnet mask for the port. 

10. To select the FEC mode:

a. Select the cell in the FEC column.

b. Perform one of the following:

• Select the FEC mode that matches the ULTRIX-IPX-IO port and the corresponding switch 
port; or

• Select Disabled for modules with built-in FEC (DR/FR/LR).

11. If you want the network settings for the port to be automatically obtained, and DHCP service is 
available on your control network, click the cell in the IP Mode column and select DHCP.

12. Repeat this procedure for each QSFP28 port you wish to configure.

13. Verify the new settings reported on the Frame Configuration status fields.

Configuring the Timing Settings
The Ultrix supports the Precision Time Protocol (PTP) as defined in the IEEE 1588-2008 standard and 
the SMPTE ST-2059 specification.

 The Ultrix behaves only as a follower and cannot be used as a Boundary Clock or Grandmaster.
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Configuring the PTP Settings
You can synchronize the Ultrix to real-time clocks of other devices in the same network. You create 
a profile (use the default settings or create a custom profile) that identifies the Ultrix to the 
Grandmaster clock.

 There are several criteria that PTP clocks compare to determine who will be master and who will 
be follower (called the Best Master Clock Algorithm, or BMCA), and they are evaluated in order: 
Priority1, clock class, accuracy, scaled log variance, Priority2, clock ID (similar to the MAC address). 
Practically, Priority1 is the only setting configured on all clocks to control the outcome of the 
Grandmaster election. If Priority1s are equal, the next criterion is evaluated (clock class) and the 
criteria are evaluated in succession until a Grandmaster is determined.

To configure a PTP default profile for the Ultrix

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

7. Select the PTP sub-tab.

8. Use the Profile menu to specify the standard/specification used for PTP. The default is SMPTE 
ST 2059-2.

 The Domain is automatically set.

9. Click Apply.

To create a custom PTP profile for the Ultrix

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.
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4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select Ultrix-IP > PTP.

7. Use the Profile menu to select a standard/specification used for PTP.
8. Edit the required parameter(s) according to the PTP parameters used by the system.

 There can be multiple PTP domains operating concurrently within a network. The domain is a 
field in all PTP message headers. Messaging between entities are segregated by domain (e.g. the 
Ultrix is an endpoint configured for domain 128 and ignores messages from a neighboring clock 
configured for domain 127).

Configuring the PTP Settings for a Specific Port
Once you create a PTP profile for the Ultrix, you may want to uniquely define the PTP settings for 
each QSFP28 port. 

To configure the PTP settings for a specific port

1. From the Frame Configuration page, select Ultrix-IP > PTP.

2. Locate the PTP Ports area of the PTP tab.

3. Locate the row for the port you wish to configure.

4. Use the Sync Interval field to specify the number of seconds at which synchronization 
messages are sent from the master clock to the specified ULTRIX-IPX-IO port.

5. Use the Announce Interval field to specify the rate of announce messages that the specified 
ULTRIX-IPX-IO port requests from the master clock during a unicast session.

6. Use the Announce Receipt Timeout field to specify the number of seconds the specified 
ULTRIX-IPX-IO port waits for an announce interval message before timing out.

7. Click Apply.

Specifying an NTP Server as the Time Source
You can choose to use an NTP Server as the system time source for an ULTRIX-IPX-IO blade. 

 The media time source is always provided by PTP.

 Before proceeding, ensure the Ultrix is configured to access the NTP Server in your facility. Refer 
to “Using an NTP Server as the Time Source” for details.
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To specify an NTP Server as the time source for an ULTRIX-IPX-IO

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

7. Select the NTP sub-tab.

The sub-tab lists each ULTRIX-IPX-IO slot as a separate row.

8. Locate the row for the required ULTRIX-IPX-IO slot you wish to enable NTP as the time source.

9. Select the Enabled box for that row.

Configuring the Senders
For each sender output, you need to specify the IP encapsulation properties for video, audio, and 
ancillary sender streams. A sender stream on the ULTRIX-IPX-IO can be configured with any 
multicast IP address in the range of 225.x.x.x to 239.x.x.x.

Make note of the bandwidth allocation for the ULTRIX-IPX-IO port to determine the available 
capacity of the port. You can add a maximum of 8 video sessions per ETH port. Once that 
maximum is reached, new streams will not be accepted and updates will only be accepted if the 
new bandwidth used does not exceed 100Gb.

 The stream count for each ENET redundant pair is 8+8. The first ENET pair (ETH1, ETH2) 
transports output streams 1 to 8. The second ENET pair (ETH3, ETH4) transports output streams 9 
to 16.

To display the Add Senders menu for a port in DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.
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3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. On the router rear panel map, select the required ULTRIX-IPX-IO slot.

The Port Configuration page updates to display the options for the blade with the Summary 
tab automatically selected. 

6. Click Add Senders.

To add advertised sender streams

1. From the Add Senders menu, click Default. 

The Add Default Sender Session dialog opens.

2. Use the Transport IP field to specify the IP range for the sender.

3. Use the UDP Port field to specify the RTP port for the advertised stream.

4. Use the Session Types options to select the type of stream(s) that will be available at the 
specified IP range and UDP port.

5. If you selected Video in step 4:

a. Select the Video tab from the dialog toolbar.

b. Use the options in the Adaptive Rates area to specify the video formats that the stream is 
allowed to follow should the input SDI video format change while the sender is enabled. 

c. Use the RTP Payload field to specify the Real-time Transport Protocol (RTP) payload IDs used 
by that sender stream.

 This is not a bandwidth reservation. If a sender is set to allow 12G inputs, it is not guaranteed that 
it would follow that video format as all device setups is constrained by the available bandwidth 
on the Ethernet side. If the new video input is valid, but the overall system configuration is invalid, 
the sender will be updated but an alarm is still raised to the user to alert of a video mismatch.

When the sender is updated, all protocols or interfaces that advertise it will be updated with a 
new configuration set and SDP. This includes NMOS, Ember+, and all DashBoard tabs where the 
sender is visible.

6. If you selected Audio in step 4:

a. Select the number of Audio sessions per sdi from 1 to 4.

b. Select the Audio tab from the dialog toolbar.
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c. For each session:

• Use the Audio Channels to select the audio channels to be transported by each audio 
stream. One audio channel can be transported in multiple sessions.

• Use the Audio Codec to specify the audio encoding format for each audio stream.
• Use the RTP Payload to specify the Real-time Transport Protocol (RTP) payload IDs used 

by each audio stream.

7. If you selected Ancillary in step 4:

a. Select the Ancillary tab from the dialog toolbar.

b. Use the RTP Payload field to specify the Real-time Transport Protocol (RTP) payload IDs used 
by that sender stream.

8. Click Add session. 

The Add Default Sender Session dialog closes and the Port Configuration page updates to list 
the sender streams advertised using the IP Address specified in step 2.

To manually add a sender stream

1. From the Add Senders menu, click Custom. 

The Add Custom Sender Session dialog opens.

2. Use the Output options to assign the SDI input signal to the sender stream.

3. Use the Session Types options to select the type of stream(s) that will be available at the 
specified IP Address.

4. If you selected Video in step 3:

a. Select the Video tab from the dialog toolbar.

b. Use the Transport IP field to specify the sender. 

c. Edit the UDP Port to specify the source port to transmit the data. 

d. Use the RTP Payload field to specify the Real-time Transport Protocol (RTP) payload IDs used 
by that sender stream.

e. Use the Adaptive Rates options to specify the video formats that the stream is allowed to 
follow should the input SDI video format change while the sender is enabled. 

 This is not a bandwidth reservation. If a sender is set to allow 12G inputs, it is not guaranteed that 
it would follow that video format as all device setups is constrained by the available bandwidth 
on the Ethernet side. If the new video input is valid, but the overall system configuration is invalid, 
the sender will be updated but an alarm is still raised to the user to alert of a video mismatch.
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When the sender is updated, all protocols or interfaces that advertise it will be updated with a 
new configuration set and SDP. This includes NMOS, Ember+, and all DashBoard tabs where the 
sender is visible.

5. If you selected Audio in step 3:

a. Select the number of Audio sessions per sdi from 1 to 4.

b. Select the Audio tab from the dialog toolbar.

c. For each session:

• Use the Audio Channels to select the audio channels to be transported by each audio 
stream. One audio channel can be transported in multiple sessions.

• Use the Audio Codec to specify the audio encoding format for each audio stream.
• Use the RTP Payload to specify the Real-time Transport Protocol (RTP) payload IDs used 

by each audio stream.
• Use the Transport IP field to specify the sender for the audio stream. 
• Edit the UDP Port to specify the source port to transmit the audio data. 

6. If you selected Ancillary in step 3:

a. Select the Ancillary tab from the dialog toolbar.

b. Use the Transport IP field to specify the sender for the ancillary stream. 

c. Edit the UDP Port to specify the source port to transmit the ancillary data. 

d. Use the RTP Payload field to specify the Real-time Transport Protocol (RTP) payload IDs used 
by that sender stream.

7. Click Add session.

The Add Senders Session dialog closes and the Port Configuration page updates to list the 
sender streams advertised using the IP Address specified in step b.

Configuring the Receivers
Receivers are the representation of connections on the router and report the information related to 
all traffic that is received. Receivers can be manually created by manually specifying the IP and UDP 
ports of the sender on the Port Configuration tab, but usually the process of managing receivers is 
done by the external broadcast controller. 

 The Ultrix supports one-to-many connections (where one source can be routed to multiple 
targets) via ST-2110 multicast distribution. This enables you assign the same transport IP to 
multiple receivers of the same type. Note that you must still assign an unique IP for each sender 
stream configured.

This section outlines what is currently present/active on the Port Configuration tab and outlines 
how to manually specify receivers on the router using this interface.

To display the Add Receivers menu for a port in DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. On the router rear panel map, locate the required ULTRIX-IPX-IO slot.

6. Select the port on the ULTRIX-IPX-IO slot you wish to configure.
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The Port Configuration page updates to display the options for the port with the Summary tab 
automatically selected. 

7. Click Add Receivers.

To add a default receiver

1. From the Add Receivers drop-down menu, select Default. 

The Add Default Receiver Session dialog opens.

2. Use the Session Types options to specify the type of data the streams will include.

3. Use the IP Address Group options to specify how to define the series of receiver streams.

4. Use the Transport IP field to specify the IP range for the receiver.

5. Use the UDP Port field to specify the RTP port the receivers will use.

6. If you selected Video in step 2:

a. Select the Video tab from the dialog toolbar.

b. Verify the Video Format field reports the video format of the signal the receivers will output.

c. Use the Timing Mode options to determine whether the stream output will be aligned to the 
router reference, or if a timing offset is applied to timestamps in the sender's RTP packets.

d. Verify that the IP Preview field reports the correct IP range.

7. If you selected Audio in step 2:

a. Select the number of Audio sessions per sdi from 1 to 4.

b. Select the Audio tab from the dialog toolbar.

c. For each session:

• Use the Audio Channels to select the audio channels to be transported by each audio 
stream. One audio channel can be transported in multiple sessions.

• Use the Audio Codec to specify the audio encoding format for each audio stream.
• Use the RTP Payload to specify the Real-time Transport Protocol (RTP) payload IDs used 

by each audio stream. 
• Use the Link Offset field to set the timing offset value used by this receiver.

8. If you selected Ancillary in step 2:

a. Select the Ancillary tab from the dialog toolbar. 

b. Verify the Ancillary Format field reports the format of the signal the receivers will output.



164 • ULTRIX-IPX-IO Setup Ultrix User Guide (v28-rev5)

c. Use the Timing Mode options to determine whether the stream output will be aligned to the 
router reference, or if a timing offset is applied to timestamps in the sender's RTP packets.

d. Verify that the IP Preview field reports the correct IP range.

9. Click Add session. 

The Add Default Receiver Session dialog closes and the Port Configuration page updates to 
list the receiver streams advertised using the IP Address specified in step 4.

To manually add a receiver session

1. From the Add Receivers drop-down menu, select Custom. 

The Add Receiver Session dialog opens.

 Click SDP to add receivers manually by providing the sender SDP instead of the Transport IP, UDP 
port, etc.

2. Use the Input options to assign the SDI output signal to the receiver stream.

3. Use the Session Types options to specify the type of data the streams will include.

 Selecting both Video and Audio automatically creates table entries for one video, one ancillary, 
and up to four audio streams.

4. If you selected Video in step 3:

a. Select the Video tab from the dialog toolbar.

b. Use the Video Format field to specify the video format for the stream.

c. Use the Timing Mode options to determine whether the stream output will be aligned to the 
router reference, or if a timing offset is applied to timestamps in the sender's RTP packets.

d. Use the Transport IP field to specify the UDP IP address of the transport stream for the 
signal.

e. Use the UDP port menu to specify the UDP port number of the transport stream for the 
receiver.

5. If you selected Audio in step 3:

a. Select the number of Audio sessions per sdi from 1 to 4.

b. Select the Audio tab from the dialog toolbar.
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c. For each session:

• Use the Audio Channels to select the audio channels to be transported by each audio 
stream. One audio channel can be transported in multiple sessions.

• Use the Audio Codec to specify the audio encoding format for each audio stream.
• Use the RTP Payload to specify the Real-time Transport Protocol (RTP) payload IDs used 

by each audio stream. 
• Use the Link Offset field to set the timing offset value used by this receiver.

6. If you selected Ancillary in step 3:

a. Select the Ancillary tab from the dialog toolbar.

b. Use the Video Format field to specify the video format for the stream.

c. Use the Timing Mode options to determine whether the stream output will be aligned to the 
router reference, or if a timing offset is applied to timestamps in the sender's RTP packets.

d. Use the Transport IP field to specify the UDP IP address of the transport stream for the 
signal.

e. Use the UDP port menu to specify the UDP port number of the transport stream for the 
receiver.

7. Click Add sessions.

The Add Receiver Session dialog closes and the Port Configuration page updates to list the 
new receiver stream.

Make a note of the automatically assigned label in the Name field for the stream. This name will 
be used in the database to represent the specific stream as an input (source).

Configuring the Redundant Mode for SMPTE ST-2022-7
The ULTRIX-IPX-IO enables a user to protect their streams to ensure mission critical operation. 
Using SMPTE ST 2022-7, they can run the same video, audio, and ancillary over two separate, 
redundant networks in case an error occurs.

 This section is only applicable if your system requires protection switching.

Before You Begin
Ensure that:

• your source is capable of sending SMPTE ST 2022-7 streams
• the Ultrix is set up within a protection switching network

Enabling the Redundant Mode
 By default, the Redundant mode is disabled for each session. 

To enable the Redundant Mode for a session pair

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .
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The Frame Configuration page opens.

6. Select the Ultrix-IP tab.

7. Select the IP System sub-tab.

8. In the top table, locate the primary port for the protection switching pair. 

Each row in the table is a port on an installed ULTRIX-IPX-IO blade. 

9. Select the Redundancy cell for the pair you wish to configure for protection switching.

10. Click Apply.

Configuring the Ultrix for Protection Switching
You will need to assign a unique IP address to each stream (primary and redundant).

To configure the Ultrix for protection switching

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. Configure the primary sender stream as outlined in “Configuring the Senders” and set the 
Redundancy to Enabled.

7. Configure the secondary sender stream as outlined in “Configuring the Senders” and set the 
Redundancy to Enabled.
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a. Use the Secondary IP menus to specify the IP address for the secondary (redundant) 
stream. Ensure that it is not the same IP address as the primary stream.

b. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. 
Note that the secondary UDP port can be the same as the primary stream.

8. Configure the primary receiver stream as outlined in “Configuring the Receivers” and set the 
Redundancy to Enabled.

9. Configure the secondary receiver stream as outlined in “Configuring the Receivers” and set 
the Redundancy to Enabled.

a. Use the Secondary IP menus to specify the IP address for the secondary (redundant) 
stream. Ensure that it is not the same IP address as the primary stream.

b. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. 
Note that the secondary UDP port can be the same as the primary stream.

Troubleshooting
Table 51 provides brief explanations for some common stream setup messages.

Table 51  Troubleshooting the Error Messages

Error Message Cause
Cannot set default due to 
maximum allowable streams has 
reached

The ENET pair has reached the maximum number of 
allowable streams.

Cannot add 2160P59 video due to 
maximum allowable UHD streams 
has reached

Primary and Secondary UDP port 
cannot be the same

When in Redundant mode, if the primary and secondary 
streams have the same IP address, the UDP ports must be 
different.

This IP port does not have enough 
bandwidth to add a new stream

The port has reached the maximum 100G bandwidth.

slot#.port# is a redundant IP port. 
It is reserved for redundant 
senders.

The ENET pair is in Redundant mode and you cannot edit 
the second port (ENET 2 or ENET 4) of the pair.

Address x.x.x.x:x is being used by 
slotx.out[y].#.chz

Each stream must have a unique network address.

Video Format mismatch detected The input video format does not match those 
selected/enabled in the Adaptive Input Allowed Input 
Rates setting of the sender stream, or input is not valid.

100G link is down One of the following is occurring:
• The cable and/or optical module is not properly 

connected.
• There is an FEC setting mismatch between the 

ULTRIX-IPX-IO and switch endpoints. If your module 
includes a built-in FEC (DR/FR/LR), the ULTRIX-IPX-IO FEC 
Mode must be set to Disabled. Refer to “Configuring the 
Port Network”.
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ULTRIX-SFP-IO Setup
This chapter outlines how to utilize the ports for the Ultrix router when an ULTRIX-SFP-IO blade is 
installed in a slot of an Ultrix router chassis.

For More Information on...
• the installation and cabling of the ULTRIX-SFP-IO, refer to the ULTRIX-FR1, ULTRIX-FR2, and 

ULTRIX-FR5 Installation Guide.

Overview
The Ultrix router automatically detects when the ULTRIX-SFP-IO blade is installed. Each signal is 
made available in the Ultrix routing system much like those available via the standard IN and OUT 
HD BNCs for each slot. The signals are initially named using the standard 
Frame.Slot.Port.Type.Channel nomenclature where Port is reported as the physical AUX and/or SFP 
port on the Ultrix rear panel that the module is installed in. The options in the SFP Configuration 
interface for a module are the same as those for video and audio signals on the BNCs.

  MADI SFP modules are only supported in the AUXA and AUXB ports.

For More Information on...
• the supported modules for the ULTRIX-SFP-IO blade, refer to the ULTRIX-FR1, ULTRIX-FR2, and 

ULTRIX-FR5 Installation Guide and Ultrix SFP Modules Guide.

Figure 37  Example of the SFP Configuration Interface

Before You Begin
You may also need to install an:

• UltriSpeed license if the ULTRIX-SFP-IO includes an SFP-HDB-IN-12G, SFP-FIBER-12G, and/or 
SFP-HDB-OUT-12G.

• UltriScape license for each port that will be used to provide an UltriScape head output.
• UltriSRC license for each AUX port configured for asynchronous MADI input.
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Configuring an SFP Port
Once the SFP module is installed in a port, you must specify the port type. Select SDI video for video 
SFP types, or MADI for Audio SFP types. MADI audio SFP type allow you to specify the channel 
quantity - either 56 or 64 as per your facilities' standard.

The SFP Configuration interface is organized into two sections: AUX settings, and SFP settings. The 
AUX Settings lists all the AUX port settings for all blades in the frame. The SFP Settings list all the SFP 
I/O port settings.

To configure the settings for an SFP port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The SFP Configuration page opens.

6. Select the tab appropriate to the port location you wish to configure.

7. From the Slots table on the left, select the required ULTRIX-SFP-IO blade.

 Click ALL to display the available SFP/AUX ports available in the router.

The Settings table updates to display the port name, and the type of signals for each populated 
port.

8. Locate the row for the port you want to configure.

9. In the SFP column for the port, verify the type of signal the port will provide. 

10. If applicable, use the MADI I/O Size menu for the AUX port to specify the input and output 
configuration for the port.

MADI is only available in the AUX ports. The SFP I/O ports 1-16 does not support MADI I/O.

11. Click Apply to save your changes. 
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To monitor an SFP port

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. Select the button for the slot that houses the port you want to verify.

In the example below, the user selected Slot 1.

7. Select the SFP port you want to verify.

The label under the selected port is now lit blue and the page updates with information about 
the port. In the example above, the user is monitoring all ports on the blade.
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UltriStream Setup
This chapter provides information on the UltriStream licensed features for the Ultrix routers.

 The UltriStream license is supported on the ULTRIX-HDX-IO and ULTRIX-MODX-IO blades only. 

 The UltriStream license requires router software version 5.2.0 or higher.

Overview
The UltriStream licensed feature provides the ability to encode one NDI stream of a configured 
UltriScape Multiviewer Head per ULTRIX-HDX-IO or ULTRIX-MODX-IO blade. 

 The Multiviewer Head for the video source must be one from the same blade that is transmitting 
the NDI stream. For example, a licensed ULTRIX-MODX-IO blade in Slot 1 cannot send an NDI 
stream of a Multiviewer Head from a licensed ULTRIX-HDX-IO blade in Slot 2.

An UltriStream license is supported on the following routers:

• ULTRIX-NS-FR1
• ULTRIX-NS-FR2
• ULTRIX-NS-FR5
• ULTRIX-FR5
• ULTRIX-FR12

Features
An UltriStream license provides the following features:

• Configure and send one full bandwidth NDI Stream (encode only)

• Video source for the stream can be selected from any Multiviewer Head of the licensed blade1

• Supports Unicast transport modes only
• Provides monitoring of the encode stream state and video format
• Configure the names for NDI device alias, stream, and group(s)
• Assign Static or DHCP IP addresses

Before You Begin
Ensure the following:

• The AUX D port on the blade is populated with an SFP-RJ45-1G module. Refer to the Ultrix SFP 
Modules User Guide for specifications.

• Your facility IT Department provided the required network settings to be assigned to the AUX D 
port you plan to enable for the UltriStream license for.

• The UltriScape Head(s) are enabled and configured as outlined in the UltriScape User Guide.
• The UltriStream and the Ultrimix-Dante licenses cannot be enabled on the same slot. By enabling 

an UltriStream license on a slot, you will be prevented from enabling an Ultrimix-Dante license on 
that slot until you disable the applied UltriStream license.

1. Requires an UltriScape license.
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Installing an UltriStream License
Ross Video uses license keys to control user access to specific features. You can obtain a key for a 
licensed feature from Ross Video Technical Support. Use the key to assign an UltriStream license to 
a supported blade in the Ultrix router.

To install an UltriStream license key

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

6. Make a note of the character string in the Request Code field for the UltriStream license.

7. Contact Ross Video Technical Support using the information listed in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from step 6.

b. You will be given a License Key for the UltriStream.

8. Enter the provided License Key in the applicable License Key field of the Licenses tab.

 You can also right-click on the row for the License Key you are installing, copy the Request Code 
to or paste the License Key from the Microsoft® Windows® clipboard, and click Yes.

9. Click Apply in the row for the License Key you entered in step 8.

10. Verify that the Count field is updated to report each installed UltriStream License Key.

To activate an UltriStream license for a specific blade

1. In the Licenses interface, select the UltriStream sub-tab.

The interface is organized into a table with three columns. The left column (Slot) lists the 
available slots that the license can be assigned to. The center column (Card | Port) lists the type 
of blade and the port name. The right column (License) provides the option to enable/disable 
the license for the specified slot.

 All NDI capable blades use the AUX D port for UltriStream.

2. Verify that the top Licenses read-only field reports the total number of purchased UltriStream 
licenses for the router. In the example above, there are a total of 4 licenses purchased with 1 in 
use.

3. In the table, locate the row for the slot you wish to enable the UltriStream license.

4. Use the License column to select NDI for the slot.
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Accessing the UltriStream Interface
Once an UltriStream license is enabled for a slot, you can access the UltriStream settings via the 
DashBoard Port Configuration tab. 

To display the UltriStream interface

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the Slot toolbar (at the top of the Port Configuration page), select the button for the slot 
you enabled the license on.

7. Perform one of the following:

• Set the Views to UltriStream; or
• Click the AUX D port on the blade map of the Home page .

The Port Configuration page updates to display the UltriStream interface. In the following 
example, the ULTRIX-MODX-IO blade in Slot 1 was selected.

  An NDI icon displays above an AUX D port when a license is enabled. 

Overview
The UltriStream interface is organized into three areas: an I/O map of the selected blade (top), a 
table listing the configured streams (left pane), and options for configuring the UltriStream for the 
selected AUX D port (right pane).
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Figure 38  Example of the Port Configuration > UltriStream Areas

1.  Blade I/O Map

The top includes a map of the ports available on the selected blade. Note that the AUX D port in 
the UI changes color based on the state of the NDI stream (green when the stream is valid, and 
red for error conditions). When View is set to UltriStream, the AUX D port is automatically 
selected on the Blade I/O Map and any other port is not selectable from this map. A small NDI 
icon displays over the AUX D port when an UltriStream license is enabled.

2. Status Table

The left panel includes a read-only table that lists the licensed stream(s) on AUX D. Each table row 
represents a stream and reports the Name, Type, Source, and State for that stream. Refer to 
Table 52 for more information.

Only one stream can be configured at this time.

3. Configuration Options

The right panel includes two tabs:

› Network — provides options for configuring the network settings for AUX D. Refer to Table 53.
› NDI Sender — provides options for configuring the NDI encoded stream, and read-only fields 

used to monitor the encoding status. Refer to Table 54.

When a blade is selected that does not have an UltriStream license enabled, the UltriStream > 
Network and the UltriStream > NDI Sender tabs are disabled (grayed out). 

4. Configuration Status Toolbar

The toolbar is located in the bottom right corner and includes a status field and two buttons.

› The status field reports the status of changes made in the UltriStream tabs and menus. A 
status indicator can vary in severity from green (valid), yellow (caution), to red (alarm). 

› Select  to view details on the current status message.

› Click Apply to save any changes made to the UltriStream tabs and menus.
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Network Configuration
The encoded NDI Stream will be transmitted via the AUX D port on the blade. This first requires you 
to specify how the IP address for the port is assigned (Static or DHCP). Both methods are described 
below.

When using UltriStream and Ultrimix-Dante, ensure that your NDI and Dante networks are 
separated. Combining these networks can lead to congestion, performance issues, and degraded 
Dante audio quality.

 Contact your network administrator if difficulties or problems are experienced when assigning IP 
addresses.

To configure the network settings for the AUX D port

1. Display the UltriStream interface as outlined in “To display the UltriStream interface”.

2. Select the Network sub-tab.

3. If you are manually configuring the network settings:

a. Use the Mode menu to select Static.

b. Use the IP Address field to specify the new static IP Address for the AUX D port. 

This is the IP Address that is used by the NDI protocol and Unicast transport to stream the 
video source.

c. Use the Subnet Mask field to specify the subnet mask for the AUX D port. 

d. Use the Default Gateway field to specify the gateway for communications outside of the 
local area network (LAN) the Ultrix will use.

4. If you want the network settings for the AUX D port to be automatically obtained, and DHCP 
service is available on your control network, select DHCP from the Mode menu. This is the 
default mode.

 Verify that a DHCP server is running in your network before setting the Mode to DHCP.

5. Click Apply to save the new settings.
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Configuring an NDI Sender Stream
 Configuration for UltriStream is saved across a reboot or power cycle of the Ultrix router and 

reapplied on boot.

To configure an NDI Sender stream

1. Display the UltriStream interface as outlined in “To display the UltriStream interface”.

2. Select the NDI Sender sub-tab.

3. Use the Video source menu to specify the Multiviewer Head to encode on a slot. The list 
displays only those Multiviewer Heads that are enabled.

4. Use the NDI device alias field to specify a new name that will override the host name. 

The alias name applies to the video stream on the AUX D interface. By default, the name uses 
the nomenclature of the router name (e.g. “HI_Ultrix_223”), followed by the slot (e.g. slot3).

5. Use the Stream name field to specify a unique identifier for the stream when it appears on the 
network. For example, HI_Ultrix_223_SLOT1A.

The NDI device alias and Stream name values uniquely identify a stream in the NDI protocol. For 
example, a NDI Monitor tool discovers a stream named HI_ULTRIX_223.SLOT1A(RC01), where 
the NDI device alias is HI_ULTRIX_223.SLOT1A and the Stream name is RC01. 

6. Use the Group(s) field to specify a group the NDI stream belongs to. If there are multiple 
groups, use a comma between the names. For example, Group A,group2,my_group.

Only viewers that belong to the same group can view the stream. For example, NDI Access 
Manager defines NDI Studio Monitor can view streams from the Public group.

 The Transport Mode menu is automatically set to Unicast. The AUX D port applies the User 
Datagram Protocol (UDP), R-UDP, or TCP for NDI encoding to a single stream. 

7. Click Apply to save the new settings.

DashBoard Menus Overview
This section briefly summarizes the read-only fields, menus, and editable fields available when an 
UltriStream license is applied to a router blade, and the Views is set to UltriStream.
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Status Table
Table 52 summarizes the read-only fields displayed in the table located in the left pane of the Port 
Configuration tab when Views is set to UltriStream.

Network Tab
Table 53 summarizes the options displayed in the Port Configuration > UltriStream > Network 
tab. This tab provides options for configuring the Network (AUX D port) settings.

Table 52  UltriStream — Status Table

Item Parameters Description
Name Reports the identifier assigned to the stream using the nomenclature of 

NDI device alias name(stream name).

Type Reports the type of compression used for NDI encoding

Source Reports the video source that is selected in the NDI Sender tab

State Running (Green) The sender stream is operating correctly 
without errors and the link for the AUX D 
port is valid

Stopped (Red) One of the following is occurring:
• the sender stream is no longer running
• the sender stream encountered an error

Table 53  UltriStream — Network

Item Parameters Description
Mode Static The user manually supplies the network 

settings for the AUX D port

DHCP Automates the assignment of the network 
settings for the AUX D port. This is the 
default.

IP address # Specifies the IP address assigned to the AUX 
D port. 
This address is used to communicate with 
devices on your streaming network.

Subnet mask # Specifies the subnet mask for the AUX D 
port

Default gateway # Specifies the gateway for communications 
outside of the local area network (LAN)

SFP detected 
(read-only)

Valid (Green) The SFP in the AUX D port is valid and 
operational

Invalid (Red) One of the following is occurring with the 
SFP in the AUX D port:
• the SFP is incompatible with UltriStream
• the SFP is not operational
• the SFP is not installed in the port



180 • UltriStream Setup Ultrix User Guide (v28-rev5)

NDI Sender Tab
Table 54 summarizes the options displayed in the Port Configuration > UltriStream > NDI 
Sender tab. This tab provides configuration options and read-only information about the NDI 
Encoder.

Table 54  UltriStream — NDI Sender

Item Parameters Description
Video source None Stops the NDI video stream. Select this 

option if you need to stop the video stream 
from the associated Multiviewer Head.

slot#.head# Specifies which Multiviewer Head to encode 
on a slot for the encoded sender stream. 
The list displays only those Multiviewer 
Heads that are enabled.

NDI device alias <text> Assigns a unique identifier to the video 
stream on the selected AUX D port. The 
maximum is 30 characters.
The default value contains the DashBoard 
System > Device name (e.g. 
“HI_Ultrix_222”), followed by the slot 
name (e.g. slot1). For example, 
“HI_Ultrix_222.slot1”.

Stream name <text> Assigns a unique identifier to the stream. 
The maximum is 30 characters. You can 
specify a hard-coded name (<text>) .

Group(s) <text> Assign a unique identifier to indicate a 
specific group to send the encoded stream 
as part of (or a comma-separated list of 
multiple groups, such as Group A,group 
2,my_group).
The default is Public. 

Transport mode Unicast The NDI stream will automatically be 
transmitted with an appropriate Unicast 
transport mechanism (UDP or TCP)

Status (read-only)

Stream state Running (Green) The sender stream is operating correctly 
without errors and the link for the AUX D 
port is valid

Stopped (Red) One of the following is occurring:
• the sender stream is no longer running
• the sender stream encountered an error
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Multiviewer Output Formats
Table 55 lists the resulting NDI encoded Multiviewer output format per Ultrix input reference and 
Multiviewer head format selection.

Video format # Reports the encoded video format. Verify 
that this matches the format assigned to 
the specified Multiviewer Head in the Video 
source menu. Refer to Table 55.

N/A The sender stream is unavailable. Verify 
that the link is valid and is running without 
errors.

Stream type NDI-HB (Full) The stream uses NDI High Bandwidth 
compression (or Full Bandwidth)

Table 55  NDI Encoded Output Format

Ultrix Input 
Reference Format

Multiviewer Head Output Format

1080p 1080i / 1080i-LC 2160p UC

1080p 25 1080p 50 1080i 50 1080p 50

720p 25 1080p 50 1080i 50 1080p 50

720p 50 1080p 50 1080i 50 1080p 50

PAL 1080p 50 1080i 50 1080p 50

1080i 59.94 1080p 59.94 1080i 59.94 1080p 59.94

1080p 23.98 1080p 59.94 1080i 59.94 1080p 59.94

1080p 29.97 1080p 59.94 1080i 59.94 1080p 59.94

720p 59.94 1080p 59.94 1080i 59.94 1080p 59.94

720p 23.98 1080p 59.94 1080i 59.94 1080p 59.94

NTSC 1080p 59.94 1080i 59.94 1080p 59.94

1080i 60 1080p 60 1080i 60 1080p 60

1080p 30 1080p 60 1080i 60 1080p 60

720p 24 1080p 60 1080i 60 1080p 60

720p 30 1080p 60 1080i 60 1080p 60

720p 60 1080p 60 1080i 60 1080p 60

Table 54  UltriStream — NDI Sender

Item Parameters Description
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UltriProc Setup
This chapter provides information on the SDR/HDR conversion and Color Correction options 
available when one of the UltriProc licenses is enabled on an Ultrix router.

 The UltriProc licenses are supported on the ULTRIX-HDX-IO or ULTRIX-MODX-IO blades only.

Overview
There are two UltriProc licenses available: UltriProc and UltriProc-3DLUT.

UltriProc
This license allows you to perform color correction, Proc Amps, and HDR conversion on Ultrix I/Os. 
An UltriProc can be assigned to either inputs or outputs. An UltriProc license key is required for 
each selected I/O that will be used by the UltriProc. 

UltriProc color correction is performed in the Y'CbCr color space or by RGB Color Correctors in the 
RGB color space. It is additive, allowing you to apply any combination of SDR/HDR and RGB Color 
Corrector based adjustment to a video signal. 

An UltriProc license provides the following SDR/HDR conversion features:

• Built-in HDR/SDR conversion
• Selecting a Tone Mapping mode
• SDI output Y/C clipper to pass/clip extended super-black or super-white ranges
• RGB Color Correction
• Independent ProcAmp controls for the video input and for the video output of the UltriProc
• SDI output Y/C clipper to pass/clip extended super-black or super-white ranges
• SDR/HDR transfer characteristic and colorimetry information inserted into the SDI video 352M 

payload identifier

UltriProc-3DLUT
The UltriProc-3DLUT license also allows you to perform color correction, Proc Amps, and HDR 
conversion on Ultrix I/Os but also enables SDR/HDR conversion with a 3D-LUT RGB Cube file 
including:

• BT.709 and BT.2020 colorimetry/transfer characteristics for Y/C RGB conversion
• Preloaded 3D-LUT RGB Cube files library from BBC (14 files) and NBCU (6 files)
• Ability to load custom 3D-LUT RGB Cube files to perform custom conversions
• Support for Narrow Range (Type I) and Full Range (Type III) 3D-LUT RGB Cube files

SDR/HDR Conversion
Each UltriProc license supports dynamic range and colorimetry/transfer characteristics conversion 
from/to any of these standards:

• BT.709 SDR
• BT.2020 SDR
• BT.2020 HLG
• BT.2020 PQ
• BT.2020 S-Log3
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• BT.2020 SR Live

The video input dynamic range and colorimetry/transfer characteristics settings can be manually 
configured or can be automatically detected from the SDI video input 352M payload identifier.

The video output dynamic range and colorimetry/transfer characteristics settings can be manually 
configured or can be automatically set to follow the SDI video input dynamic range and 
colorimetry/transfer characteristics.

The SDR/HDR conversion also offers the following options:

• Display light or scene light conversion
• Direct mapping or tone (up/down) mapping
• RGB Color Correction with adjustment controls for gamma, lift, gain, and offset

Installing an UltriProc License
Ross Video uses license keys to control user access to specific features. You can obtain a key for a 
licensed feature from Ross Video Technical Support. Each UltriProc license provides one proc amp 
engine that can be assigned to one physical port on the router. This section outlines how to install 
an UltriProc license and is applicable to both license types.

To install an UltriProc license key

1. Launch the DashBoard client. 

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Systems sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Ultrix node.

The Device Configuration interface opens.

6. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

7. Make a note of the character string in the Request Code field for each UltriProc license type you 
wish to install.

8. Contact Ross Video Technical Support using the information listed in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from step 7.

b. You will be given a License Key for the UltriProc.

9. Enter the provided License Key in the applicable License Key field of the Licenses tab.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

10. Click Apply in the row for the License Key you entered in step 9.

11. Verify that the Count field is updated to report each installed License Key.

To activate an UltriProc license for a specific port

1. Install the license key as outlined in the procedure “To install an UltriProc license key”.

2. In the Licenses interface, select the UltriProc sub-tab.
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The interface is organized into two tables: the left table provides the options for selecting the 
data rate and assigning the license to an I/O type. The table on the right lists the available ports 
and provides the option to enable/disable the UltriProc feature.

3. For the first slot, use the Max Data Rate menu to specify the mode. Choose from the following:

• 3G — UltriProc operates at data rates up to 3Gbps1. The license is available on the even 
numbered inputs (Input 2, 4, 6, 8, 10, 12, 14, 16) or outputs (Output 2, 4, 6, 8, 10, 12, 14, 16) 
per blade. 

• UHD Mode — UltriProc operates at data rates up to 6Gbps2 and 12Gbps3. The license is 
available on 4 inputs (Input 2, Input 6, Input 10, Input 14) or 4 outputs per blade (Output 2, 
Output 6, Output 10, Output 14). This mode also requires an UltriSpeed license.

4. Use the Assignment menu to specify the slot I/O the UltriProc will apply to.

5. Use the Mode column, select the license type to apply. Choose from the following:

• Disable — an UltriProc license is not assigned and the options are unavailable for this slot I/O.
• Enabled HDR — assigns an UltriProc license to this slot I/O. An UltriProc license can be 

assigned to any of the individual Proc Amps in the slot, either to Inputs or Outputs, and UHD 
or 3G.

• Enable 3D LUT — assigns an UltriProc-3DLUT license to this slot I/O. An UltriProc-3DLUT 
license can be assigned to any of the 8 individual Proc Amps in the slot, either to Inputs or 
Outputs, and UHD or 3G.

6. In the Port column, select the physical port you want to apply the UltriProc license to.

7. Select Enable to apply the UltriProc license to that port.

In the following example, the user applied 1 UltriProc and 1 UltriProc-3DLUT license in slot2, 
assigned the Max Data Rate to UHD, assigned the UltriProc licenses to the inputs, and enabled 
the slot2.proc1, and slot2.proc7 UltriProc engines.

1. 720p 50/59.94/60Hz, 1080i 50/59.94/60Hz, and 1080p 50/59.94/60Hz
2. 2160p 23.98/24/25/29.97/30Hz
3. 2160p 50/59.94/60Hz
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Accessing the UltriProc Settings
The UltriProc settings are accessed via the DashBoard Port Configuration tab. 

To display the UltriProc interface

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

 You can also click the port with an UltriProc license on the blade map of the Home page  to 
display the UltriProc interface.

6. Toggle the first option in Views to UltriProc. 

7. Toggle the last option in Views to Inputs.

The SDR/HDR Conversion sub-tab is automatically selected.

 A green icon displays next to a port when an UltriProc license is enabled. The example in step 8 
shows that an UltriProc-3DLUT license is enabled on Input 14 of slot 2 in an ULTRIX-NS-FR2.

8. From the table in the left pane, select the row for the UltriProc engine to configure.

In the example below, the user selected slot2.proc7 that is assigned to slot2.in[14].

Table 56 summarizes the options displayed in the SDR/HDR Conversion sub-tab for each UltriProc 
engine.

Table 56  UltriProc — SDR/HDR Conversion

Item Parameters Description
Input > Colorimetry / Transfer Characteristics

Detected (read-only) Reports the colorimetry/transfer characteristics of the input to the 
UltriProc
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Override BT.709 SDR HD colorimetry/transfer characteristics, 
Standard Dynamic Range 

BT.2020 SDR UHD wide colorimetry/transfer 
characteristics, Standard Dynamic Range

BT.2020 HLG UHD wide colorimetry/transfer 
characteristics, Hybrid Log-Gamma 
dynamic range

BT.2020 PQ UHD wide colorimetry/transfer 
characteristics, Perceptual Quantizer 
dynamic range

BT.2020 SLOG3 UHD wide colorimetry/transfer 
characteristics, Sony® S-Log3 dynamic 
range

BT.2020 SR Live Wide color gamut recommended for 
UHDTV1 video signals, Sony® standard 
range

Follow Detected Automatically extracts the dynamic range 
and colorimetry information from the SDI 
video input 352M payload identifier and 
adjusts the SDR/HDR conversion 
accordingly

Input > Proc Amp

Black Offset % Adjusts the Luma (Y) black offset of the SDI 
input

Gain # Adjusts the Luma and Chroma (Y/C) gain of 
the SDI input

Saturation # Adjusts the intensity of the input color

Hue Rotationa # Adjusts the input hue level where:
• increasing the hue rotation turns the color 

wheel clockwise;
• decreasing the hue rotation turns the 

color wheel counter-clockwise

Output > Colorimetry / Transfer Characteristics

Output BT.709 SDR HD colorimetry/transfer characteristics, 
Standard Dynamic Range

BT.2020 SDR UHD wide colorimetry/transfer 
characteristics, Standard Dynamic Range

Table 56  UltriProc — SDR/HDR Conversion

Item Parameters Description
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Output BT.2020 HLG UHD wide colorimetry/transfer 
characteristics, Hybrid Log-Gamma 
dynamic range

BT.2020 PQ UHD wide colorimetry/transfer 
characteristics, Perceptual Quantizer 
dynamic range

BT.2020 SLOG3 UHD wide colorimetry/transfer 
characteristics, Sony ® S-Log3 dynamic 
range

BT.2020 SR Live Wide color gamut recommended for 
UHDTV1 video signals, Sony® standard 
range

Follow Input Automatically follows the dynamic range 
and colorimetry information as defined in 
the Input area. In that case, no SDR/HDR 
conversion is performed but the RGB Color 
Correction processing is still available.

Output (read-only) Reports the 352M payload identifier in the SDI video output, and the 
colorimetry/transfer characteristics

Output > Proc Amp

Black Offset % Adjusts the Luma (Y) black offset of the SDI 
output streams

Gain #dB Adjusts the Luma and Chroma (Y/C) gain of 
the SDI output streams

Saturation # Adjusts the lightness of the output color

Hue Rotationb # Adjusts the output hue level where:
• increasing the hue rotation turns the color 

wheel clockwise;
• decreasing the hue rotation turns the 

color wheel counter-clockwise

Conversion Type > Tone Mappingc

Display Light Uses the EOTF of the SDI input dynamic range and colorimetry/transfer 
characteristics to convert the SDI input electrical signal to the Display 
Light units.
Uses the inverse EOTF of the SDI output dynamic range and 
colorimetry/transfer characteristics to convert the Display Light units to 
the SDI output electrical signal. 

Scene Light Uses the inverse EOTF of the SDI input dynamic range and 
colorimetry/transfer characteristics to convert the SDI input electrical 
signal to Scene Light units.
Uses the EOTF of the SDI output dynamic range and colorimetry/ 
transfer characteristics to convert the Scene Light units to the SDI 
output electrical signal

Table 56  UltriProc — SDR/HDR Conversion

Item Parameters Description
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Direct Mapping, 1-to-1 
No Scaling

Performs a straight conversion, without dynamic range compression or 
expansion, and without colorimetry/transfer characteristics 
compression or expansion

Direct Mapping, BT.2408 
Scaling

Performs a conversion as defined in ITU-BT.2408

RGB Cube Filed

Status Cube File Not Used 
(Green)

The Select File menu is set to [None]

Valid file (Green) The last Cube file selected using the RGB 
Cube file menu is imported and valid

Invalid file (Red) An error occurred importing the last 
selected Cube file. 
Verify that the file is in a supported format 
(*.cube)

Select File [None] An RGB Cube file is not currently loaded to 
this proc engine

<filename.cube> Indicates the last Cube file loaded to the 
card. Note that loading a RGB Cube File 
disables the DashBoard Tone Mapping 
options Display/Scene light and Direct/Tone 
Mapping Methods.

Range Type I - Normal Range 
[64, 960]

Scales the SDI input signal level [64,940] to 
drive the 3D-LUT input processing range 
[0,1023] and will scale the 3D-LUT output 
processing range [0,1023] back to the SDI 
output signal level [64,940].

Type III - Full Range 
[0,1023]

Drives the full 10-bit SDI input signal level 
directly to the 3D-LUT input processing 
range [0,1023] and will scale the 3D-LUT 
output processing range [0,1023] to the SDI 
output signal level [0,1023]

Global Custom 3D LUT 
Import

Click this button to display a dialog that lists the custom *.cube files 
that are available to import to the specified UltriProc engine

Output Clipping

Y’ Normal [64,940] Limits any processed luminance data to be 
between 64 and 940 in the active picture 
region of the video, coming out of the proc 
amp

Super White [64,1019] Limits any processed luminance data to be 
between 64 and 1019 in the active picture 
region of the video, coming out of the proc 
amp

Super Black [4,940] Limits any processed luminance data to be 
between 4 and 940 in the active picture 
region of the video, coming out of the proc 
amp

Table 56  UltriProc — SDR/HDR Conversion

Item Parameters Description
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Bypassing the Video Correction Settings
You can choose to bypass the video correction settings by clicking Normal (located in the bottom 
right corner of the SDR/HDR Conversion tab). Note that Normal is the default.

Figure 39  Location of the Bypass and Normal Buttons

When Normal is selected, the router port processes the video input through the SDR/HDR 
converter, the RGB Color Corrector, and performs the target transform.

When Bypass is selected, the router port passes through the video input without modifications.

Y’ Extended Luma [4,1019] Limits any processed luminance data to be 
between 4 and 1019 in the active picture 
region of the video, coming out of the proc 
amp

Cb’/Cr’ Normal [64,960] Limits the gain of the blue color difference 
and the gain of the red color difference 
data to be between 64 and 960 in the active 
picture region of the video, coming out of 
the proc amp

Wide Color [5,1019] Limits the gain of the blue color difference 
and the gain of the red color difference 
data to be between 5 and 1019 in the active 
picture region of the video, coming out of 
the proc amp

Reset All Returns all editable settings on the SDR/HDR Conversion sub-tab to 
the default values

Bypass

Bypass The video input is passed through without modifications

Normal The router is processing the video input through the SDR/HDR 
converter, and the RGB Color Corrector, and performing the target 
transform

a. This option requires an UltriProc license.
b. This option requires an UltriProc license.
c. This option requires an UltriProc license.
d. These options require an UltriProc-3DLUT license.

Table 56  UltriProc — SDR/HDR Conversion

Item Parameters Description
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Dynamic Range and Colorimetry/Transfer Characteristics Setup
UltriProc performs the SDR/HDR dynamic range and colorimetry/transfer characteristics conversion 
as specified in the Input and Output areas of the SDR/HDR Conversion tab. (Figure 40 and Figure 
41).

The default Input > Colorimetry/Transfer Characteristics > Override > Follow Detected setting 
automatically extracts the dynamic range and colorimetry information from the SDI video input 
352M payload identifier and adjusts the SDR/HDR conversion accordingly. 

Figure 40  Example of the Video Correction > Input Area

The default Output > Colorimetry/Transfer Characteristics > Follow Input setting automatically 
follows the dynamic range and colorimetry information as defined in the Input area. In that case no 
SDR/HDR conversion is performed but the other video processing featured such as the Proc Amps 
and the RGB Color Correction are still available.

Figure 41  Example of the Video Correction > Output Area

The other options are common to both the Input and the Output and are used to force a specific 
SDR/HDR conversion. The following options are available:

• BT.709 SDR — HD colorimetry/transfer characteristics, Standard Dynamic Range 
• BT.2020 SDR — UHD wide colorimetry/transfer characteristics, Standard Dynamic Range
• BT.2020 HLG — UHD wide colorimetry/transfer characteristics, Hybrid Log-Gamma dynamic 

range
• BT.2020 PQ — UHD wide colorimetry/transfer characteristics, Perceptual Quantizer dynamic 

range
• BT.2020 S-LOG3 — UHD wide colorimetry/transfer characteristics, Sony® S-Log3 dynamic range
• BT.2020 SR Live — UHD wide colorimetry/transfer characteristics recommended for UHDTV1 

video signals, Sony® standard range

 An alarm is generated if the dynamic range and colorimetry information extracted from the SDI 
video input 352M payload identifier does not match the specific SDR/HDR conversion as defined 
by the user.

Proc Amps Setup
UltriProc offers two independent Proc Amps. The Input Proc Amp is located upstream of the 
SDR/HDR conversion and the Output Proc Amp is located downstream of the SDR/HDR 
conversion. Both Proc Amps offer the same controls.
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Figure 42  Example of the Input Proc Amp (left) and Output Proc Amp (right) Settings

The Proc Amp settings are cumulative and are executed in this sequence for each input or output:

1. Black Offset — adjusts the Luma (Y) black offset of the SDI input or output signal. The value is 
reported as a percentage of the full black to white signal amplitude with an adjustment range 
from -20% to +20%, in steps of 0.1%. 

2. Gain — adjusts the Luma and Chroma (Y/C) gain of the SDI input or output signal. The value is 
reported in dB with an adjustment range from -20dB to +20dB, in steps of 0.01dB. 

3. Saturation — adjusts the intensity level of the SDI input or output color. 

4. Hue Rotation — adjust the hue levels. Increasing the hue rotation turns the color wheel 
clockwise, and decreasing the hue rotation turns the color wheel counter-clockwise. This option 
is not available with the UltriProc-3DLUT license.

Selecting a Tone Mapping Conversion Option
The Tone Mapping feature provides two SDR/HDR conversion light options: Display Light or Scene 
Light.

 Tone Mapping is not available with the UltriProc-3DLUT license.

Figure 43  Example of the Tone Mapping Settings

Display Light

The common reference for the transform is the visible light as emitted by a display monitor. When 
set to Display Light conversion, the router:

1. Uses the EOTF of the SDI input dynamic range and colorimetry/transfer characteristics to 
convert the SDI input electrical signal to the Display Light units.

2. Uses the inverse EOTF of the SDI output dynamic range and colorimetry/transfer characteristics 
to convert the Display Light units to the SDI output electrical signal.

Scene Light

The common reference for the transform is the visible light as diffused by the ambient scene. When 
set to Scene Light conversion, the router:

1. Uses the inverse EOTF of the SDI input dynamic range and colorimetry/transfer characteristics 
to convert the SDI input electrical signal to Scene Light units.

2. Uses the EOTF of the SDI output dynamic range and colorimetry/transfer characteristics to 
convert the Scene Light units to the SDI output electrical signal.
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Selecting a Tone Mapping Option
The UltriProc built-in SDR/HDR conversion mapping options are:

• Direct Mapping, 1-to-1 No Scaling
• Direct Mapping, BT.2408 Scaling

Direct Mapping, 1-to-1 No Scaling

This Direct Mapping option performs a straight conversion, without dynamic range compression or 
expansion, and without colorimetry/transfer characteristics compression or expansion. This means 
that when a HDR input stream is converted to an SDR output stream, all HDR source pixels that are 
outside the output SDR dynamic range or colorimetry/transfer characteristics will be clipped, losing 
luminance and/or color information.

Direct Mapping, BT.2408 Scaling

This Direct Mapping option performs a conversion as defined in ITU-BT.2408. 

Video Output Clipping Setup
UltriProc provides the options to enable or clip super-blacks and super-whites on the SDI video 
output Luma (Y') stream. Super-blacks are often found in common color bar test patterns such as 
the ITU-R BT.814 HDR PLUGE and others. Super-whites may be created when down converting HDR 
to SDR, where the HDR highlights will be mapped in the 100% to 109% SDR super-white range. 
Super-blacks and super-whites can also be created with the UltriProc gain and offset controls.

Figure 44 shows the Output Clipping > Y’ settings.

Figure 44  Example of Video Correction > SDR/HDR Conversion > Output Clipping

 An option to allow extended Chroma (Cb'/Cr') is also available but will rarely be used in practice to 
maintain interoperability with other equipment. 

SDR/HDR Conversion with 3D-LUT RGB Cube Files
 The UltriProc-3DLUT license is required to access the NBCU and BBC 3D-LUT libraries.

The UltriProc SDR/HDR built-in conversion engine offers limited tone mapping and inverse tone 
mapping options. To expand the capability, Ross Video offers a set of pre-loaded 3D-LUT RGB Cube 
files, each one designed to meet specific conversion requirements. It is also possible for the user to 
load custom 3D-LUT RGB cube files for specific applications.

If you decide to perform a SDR/HDR conversion using a 3D-LUT RGB Cube file, then the proprietary 
SDR/HDR transform is natively programmed into the 3D-LUT file. You still need to configure 
correctly the DashBoard SDI Input and the SDI Output options as the BT.709 or BT.2020 
colorimetry information are required by UltriProc to:

• convert the Y/C to RGB values, 
• drive the RGB 3D-LUT input, and then 
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• convert the RGB 3D-LUT output back to Y/C.

Loading a 3D LUT RGB Cube File
The DashBoard Conversion Type > RGB Cube File > Select File option allows you to select and 
load one RGB Cube file stored locally on the Ultrix. 

 Loading a RGB Cube File disables the DashBoard Tone Mapping options Display/Scene light and 
Direct/Tone Mapping Methods, and the Proc Amps > Hue Rotation setting. The corresponding 
Input and Output Gamuts (Override and Output), and Range Type are automatically selected. You 
cannot manually select these parameters.

Importing a Custom 3D LUT Cube File

 This feature is available each Proc Amp instance that has been assigned an UltriProc-3DLUT 
license.

An UltriProc-3DLUT license also enables you to upload a custom 3D LUT Cube file (to a maximum 
number of 25 files) to the Ultrix router, specify its input / output colorimetry and transfer function, 
and range type. Once loaded, a file:

• becomes accessible to all UltriProc engines operating in 3D LUT mode within that same router. 
• will automatically be added to the list of RGB cube files for loading. 
• automatically applies the input and output colorimetry/transform settings defined by the user in 

the Import table.

To import a custom 3D LUT Cube file

1. Locate the Conversion Type > RGB Cube File area.

2. Click Global Custom 3D LUT Import. 

The Custom 3D LUT RGB Cube Files dialog opens.

3. Click Import File.

The Open File dialog opens.

4. Navigate to the required cube file.

5. Click Open. 

The Progress dialog opens to indicate the status of the file import.

6. If required, edit the settings according to the expected cube file characteristics: Description, 
Input Gamut, Output Gamut, and Range Type.

 Click Delete File to remove unused cube files to free up space for new.

7. Close the Custom 3D LUT RGB Cube Files dialog.
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Specifying the 3D-LUT RGB Cube File Type
A 3D-LUT Cube File is designed to process a specific input/output signal range. The DashBoard 
option Range provides two processing signal ranges:

• Type I – Normal Range [64,940]
• Type III – Full Range [0,1023]

 The pre-loaded 3D-LUT RGB Cube files library, most BBC Cube files, and all NBCU Cube files are of 
Type III.

The Type I Normal Range scales the SDI input signal level [64,940] to drive the 3D-LUT input 
processing range [0,1023] and will scale the 3D-LUT output processing range [0,1023] back to the 
SDI output signal level [64,940]. This means that a Type I 3D-LUT Cube file will clip super-blacks or 
super-whites on the SDI input and will not be able to generate super-blacks or super-whites on the 
SDI output.

The Type III Full Range will drive the full 10-bit SDI input signal level directly to the 3D-LUT input 
processing range [0,1023] and will scale the 3D-LUT output processing range [0,1023] to the SDI 
output signal level [0,1023]. This means that a Type III 3D-LUT Cube file will be able to process 
super-blacks and super-whites on the SDI input and will be able to generate super-blacks and 
super-whites on the SDI output. 

 To allow super-blacks or super-whites on the SDI video output stream, the Video Output 
Clipping option must be set to the Extended Luma [4,1019] range. 

As described above, the functionality of the Type I Normal Range 3D-LUT RGB Cube file is a subset 
of the functionality of the Type III Full Range. For that reason, most applications will be using the 
Type III Full Range 3D-LUT RGB Cube file. 

Pre-Loaded RGB Cube Files Library
The UltriProc-3DLUT license provides a library of pre-loaded 3D-LUT RGB Cube files from the BBC 
and NBCU.

3D-LUT RGB Cube Files from BBC
These 3D-LUT files are designed and copyrighted by the BBC and are available under license. Refer 
to Table 57 for details on the available files.

Table 57  Pre-loaded 3D-LUT RGB Cube Files — BBC

BBC LUT # Conversion and Filename Info
1 BT.2100 PQ 1000 cd/m2 to BT.2100 HLG, Type III

File: BBC/ 1e_PQ1000_HLG_Type3_Transcode_nocomp-v1_6.cube

2 BT.2100 PQ 4000 cd/m2 to BT.2100 HLG, Type III

File: BBC/ 2e_PQ4000_HLG_Type3_Transcode_nocomp-v1_6.cube

3 BT.709 SDR to BT.2100 HLG direct-mapping, Type I, display-light

File: BBC/ 3a_BT709_HLG_Type1_Display_DirectMapping_nocomp-v1_6.cube

BT.709 SDR to BT.2100 HLG direct-mapping, Type III, display-light

File: BBC/ 3c_BT709_HLG_Type3_Display_DirectMapping_nocomp-v1_6.cube

4 BT.709 SDR to BT.2100 HLG direct-mapping, Type III, scene-light

File: BBC/ 4-1a_BT709_HLG_Type3_Scene_DirectMapping_nocomp-v1_6.cube

5 BT.709 SDR to BT.2100 HLG up-mapping, Type III, display-light

File: BBC/ 5c_BT709_HLG_Type3_Display_UpMapping_nocomp-v1_6.cube
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3D-LUT RGB Cube Files from NBCU
These 3D-LUT files are designed and copyrighted by the NBC Universal (NBCU) and are publicly 
available free of use. A sub-set of the NBCU 3D-LUT files are pre-loaded as part of the 
UltriProc-3DLUT license. Refer to Table 58 for details on the available files.

RGB Color Correction
This section outlines the controls that UltriProc provides to perform basic RGB color correction.

 RGB color correction is available with an UltriProc or UltriProc-3DLUT license.

6 BT.709 SDR to BT.2100 HLG up-mapping, Type III, scene-light

File: 6-1a_BT709_HLG_Type3_Scene_UpMapping_nocomp-v1_6.cube

7 BT.2100 HLG to BT.2100 PQ 1000 cd/m2, Type III

File: BBC/ 7c_HLG_PQ1000_Type3_Transcode_nocomp-v1_6.cube

9 BT.2100 HLG to BT.709 SDR down-mapping, Type III, display-light, with SDR super-whites

File: BBC/ 9c_HLG_BT709_Type3_Display_DownMapping_SuperWhite_nocomp-v1_6.cube

10 BT.2020 S-Log3 to BT.2100 HLG, Type II, scene-light (use DashBoard Type III option)

File: BBC/ 10a_S-Log3-100pc_HLG_Type2_Scene_Transcode_nocomp-v1_6.cube

11  “SR Live” S-Log3 to BT.2100 HLG, Type II, scene-light (use DashBoard Type III option)

File: BBC/ 11a_S-Log3-200pc_HLG_Type2_Scene_Transcode_nocomp-v1_6.cube

17 BT.2020 SDR to BT.2100 HLG direct-mapping, Type III, display-light, graded content

File: BBC/ 17c_BT2020_HLG_Type3_Display_DirectMapping_nocomp-v1_6.cube

18 BT.2020 SDR to BT.2100 HLG up-mapping, Type III, display-light, graded content

File: BBC/ 18c_BT2020_HLG_Type3_Display_UpMapping_nocomp-v1_6.cube

19 BT.2100 HLG to BT.2100 HLG Traditional Camera Look, Type III

File: BBC/ 19c_HLG_Camera_to_TraditionalLook_Type3_Conversion_nocomp-v1_6.cube

Table 58  Pre-loaded 3D-LUT RGB Cube Files — NBCU

NBCU LUT # Conversion and Filename Info
1 BT.709 SDR to BT.2100 HLG, Type III, display-light, direct-mapping

File: NBC/ 1-NBCU_SDR2HLG_DL_v1.1.cube

2 BT.709 SDR to BT.2100 HLG, Type III, display-light, up-mapping

File: NBC/ 2-NBCU_SDR2HLG_SL_v1.cube

3 BT.2100 HLG to BT.709 SDR, Type III, display-light, down-mapping

File: NBC/ 3-NBCU_HLG2SDR_DL_v1.1.cube

4 BT.709 SDR to BT.2100 PQ, Type III, display-light, up-mapping

File: NBC/ 4-NBCU_SDR2PQ_DL_v1.cube

5 BT.2100 PQ to BT.709 SDR, Type III, display-light, down-mapping

File: NBC/ 5-NBCU_PQ2SDR_DL_v1.cube

7 BT.2100 HLG 1000 cd/m2 to BT.2100 PQ, Type III, display-light

File: NBC/ 7-NBCU-HLG2PQ_1000nit_v1.cube

Table 57  Pre-loaded 3D-LUT RGB Cube Files — BBC

BBC LUT # Conversion and Filename Info
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Overview
Under the DashBoard Port Configuration interface, the Color Correction sub-tab provides 
controls to perform basic RGB color correction functions.

To display the Color Correction interface

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. Set the Views to UltriProc.

7. Select the Color Correction sub-tab.

 You can also click the port with an UltriProc license on the blade map of the Home page  to 
display the UltriProc interface.

8. From the table in the left pane, select the row for the UltriProc engine to apply the RGB color 
correction.

Table 59 summarizes the options displayed in the Color Correction sub-tab.

Table 59  UltriProc — Color Correction

Item Parameters Description
RGB Color Correction

RGB Enables you to adjust the Red, Blue, and Green color components 
simultaneously

R Enables you to adjust the red color component independently of the 
other components

G Enables you to adjust the green color component independently of the 
other components
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Using the RGB Color Corrector
Controls are available for the grouped RGB' and for individual R', G', and B' components. The color 
correction processing is performed as indicated by the prime symbol, in the nonlinearly coded 
(gamma-corrected) components of the video output.

The RGB Color Corrector processing functions are cumulative and are executed in this sequence:

1. Gamma In — applies a Gamma function to the RGB' stream.

2. Black Offset — adjusts the black offset of the RGB' stream. The unit is in percentage of the full 
black to white signal amplitude with an adjustment range from -20% to +20%, in steps of 0.1%. 

3. Gain — adjusts the gain of the RGB' stream. The unit is in dB with an adjustment range from 
-20dB to +20dB, in steps of 0.01dB.

4. Black Lift — lifts the black level of the RGB' stream, while applying a gain to keep the peak 
white at the same level. The unit is in percentage of the full black to white signal amplitude with 
an adjustment range from -20% to +20%, in steps of 0.1%. 

5. Gamma Out — applies an inverse Gamma function to the RGB' stream.

Monitoring the Color Conversion
The when Views is set to UltriProc, on the Port Configuration interface, a table displays in the left 
pane that provides status information. (Figure 45)

Figure 45  Example of the Monitoring Entries on the Port Configuration > UltriProc Interface

B Enables you to adjust the blue color component independently of the 
other components

Gamma In # Applies a gamma function to the RGB' 
stream

Offset (%) # Adjusts the black offset of the RGB' stream

Gain (dB) # Adjusts the gain of the RGB' stream

Lift (%) # Lifts the black level of the RGB' stream, 
while applying a gain to keep the peak 
white at the same level

Inv. Gamma Out # Applies an inverse gamma function to the 
RGB' stream

Table 59  UltriProc — Color Correction

Item Parameters Description
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Table 60 summarizes the status table entries.

 

UltriProc for SmartCore
This section applies when using SmartCore to create custom Ultritouch soft panels with the 
UltriProc features.

For More Information on...
• the SmartCore feature, refer to the Ultricore BCS User Guide.

Widgets Overview
There are three UltriProc widgets available for SmartCore: 

• Color Correct (The ultriproccolor widget)
• Conversion (The ultriprocconversion widget)

Table 60  Port Configuration — UltriProc Status Table

Item Description
Proc

slotx.proc# or
flex.proc# or
slotx.MODy.proc#

Reports the status of the UltriProc licenses where:
• x represents a router slot
• # represents the UltriProc engine (one UltriProc license key)
• y represents a module installed in an ULTRIX-MODX-IO blade of the slot

Status

On (Green) The UltriProc engine is enabled, the signal on the port is valid, and the 
Bypass mode is set to Normal 

Input Mismatch 
(Yellow)

A change in the Input > Colorimetry / Transfer Characteristics > Override 
setting is detected

Rate Mismatch 
(Yellow)

The License > Max Data Rate is set to 3G, but an UHD (6Gbps or 12Gbps) 
signal is detected

Off (Gray) The UltriProc engine is disabled and not assigned to a port

Port

slotx.y[z] or
flex.y[z] or
MODx.y[z] 

Reports the status of the port assigned to an UltriProc engine where:
• x represents the slot in the router the port is located in
• y represents the signal direction (in or out)
• z represents the physical connector on the router

Max Data Rate

3G UltriProc operates at data rates up to 3Gbpsa. The license is available on 
the even numbered inputs (Input 2, 4, 6, 8, 10, 12, 14, 16) or outputs 
(Output 2, 4, 6, 8, 10, 12, 14, 16) per blade. 

a. 1080p 50/59.94/60Hz

UHD UltriProc operates at data rates up to 6Gbpsb and 12Gbpsc. The license is 
available on 4 inputs (Input 2, Input 6, Input 10, Input 14) or 4 outputs per 
blade (Output 2, Output 6, Output 10, Output 14). This mode also 
requires an UltriSpeed license.

b. 2160p 23.98/24/25/29.97/30Hz
c. 2160p 50/59.94/60Hz
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• ProcAmps (The ultriprocamps widget)

Color Correct

This widget includes the RGB Color Corrector processing functions.

Figure 46  Example of the Color Correct Widget on an Ultritouch

Conversion

This widget includes the following functions: Colorimetry/Transfer Characteristics (input/output), 
Conversion (RGB Cube Files, Tone Mapping), and Output Clipping.

 You cannot import a RGB cube file from SmartCore.

           

       
Figure 47  Examples of the Available Conversion Widgets

ProcAmps

This widget includes the Input Proc Amps, and Output Proc Amps.

 

Figure 48  Example of the Input and Output Proc Amp Widgets
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Adding an UltriProc to the SmartCore Product Catalog
There are two methods for adding an UltriProc catalog to the SmartCore interface: by importing an 
*.xlsx file with the parameters and widgets, or manually adding the catalog. This section briefly 
outlines both methods.

Keep the following in mind:

• Decide which UltriProc engine you would like to control in SmartCore and take note of their IDs. 
This information is available in the router’s License > UltriProc interface.

• The following is an example of an *.xlsx file to import an UltriProc catalog.

When manually adding an UltriProc to SmartCore:

1. In the Product Catalog tab, click Add in the Product Data toolbar.

• Use the Model Name to assign a unique identifier to this product. For example, enter the 
label for the required UltriProc engine.

• Set the Product Type to Ultrix. 
• Set the Channels to 1.
• Set the Comms Type to opengear-json. 

2. Click Add in the Widget Data toolbar.

• Set the Enter Widget Name to one of the UltriProc widgets. See “Widgets Overview”.
• Set the Control type to video.
• Set the Sub-control type to conversion.
• Set the Number of Controls to 1.

3. Click Add in the Parameter Data toolbar for a selected WidgetID.

• Set the Param OID to the slot and proc engine ID. For example, slot2.proc1. 

4. In the Data Manager tab, click Add to connect to an Ultrix Frame and attach a Product Data 
entry.

• Set the Device Name to Ultrix_slot#.proc#. For example, Ultrix_slot2.proc1.
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• Set Product to UltriProc.
• Use the Device IP field to specify the IP address of the Ultrix router.
• Click Get Details to auto-populate the remaining fields.

5. In the Signal Path Manager tab, click Assign.

• Use the Select Device menu to select the device added in step 4.
• Set the Product Type to UltriProc.
• Set the Select Channel to 0.

Soft Panels for UltriProc
You can create a soft panel that displays one or two UltriProc windows.

To create a soft panel for UltriProc

1. Create an Ultritouch PB soft panel and ensure to include:

• the UltriProc assigned Sources and Destinations for control.
• a drawer window assigned to Presets.

This will auto reveal the UltriProc Presets for control from an Ultritouch panel when selecting a 
source or destination that has a SmartCore template attached.

2. If desired, rename button labels by editing the Widget Data > Control Sub Type menu from the 
User Assigned Parameter (UAP) menu.

3. To display two sets of SmartCore presets, add another Preset to the Home View Config > 
Drawer Window options for the panel.

To access the UltriProc options on a soft panel

1. Load the soft panel to your Ultritouch.

2. Click  to display the UltriProc options.

3. Select from Color Correct, Conversion, or Proc Amps.

4. Click  to display the UltriProc Control menu.
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Ultrimix-Dante Setup
The Ultrimix-Dante license provides 64 x 64 input/output audio channels accessible via ethernet on 
the AUX C port of the ULTRIX-HDX-IO and ULTRIX-MODX-IO blades. It utilizes the Audinate® Dante® 
proprietary IP-based audio transport system. This chapter provides information on installing the 
Ultrimix-Dante license, and configuring it for the Ultrix routing system.

 The Ultrimix-Dante license requires Ultrix router software version 5.6.0 or higher.

Overview
The Audinate Dante system provides a centralized control via the Dante Controller, a software 
application available on Microsoft® Windows® and MacOS®. This system manages the transport 
over the IP link, and presents users with a cross-connect interface that allows control of the channel 
routing only. IP control is managed by the Dante controller.

Ultrix identifies the Dante channels as a single pipeline consisting of 64 input and 64 output 
channels. Ultrimix-Dante enables the Ultrix router to include Audinate Dante audio inputs and 
outputs into the Ultrix routing matrix. Audio sources from a Dante network can be configured as 
inputs into the Ultrix router. The Ultrix router can also output audio channels to the same Dante 
network.

The Ultrimix-Dante license is supported on the following routers:

• ULTRIX-NS-FR1
• ULTRIX-NS-FR2
• ULTRIX-NS-FR5 
• ULTRIX-FR5
• ULTRIX-FR12

 The AUX B audio channels are not available for use when Ultrimix-Dante is enabled on a blade. 
AUX B can still be used to route SDI video. 

Features
The Ultrimix-Dante license provides the following features:

• Licensable on the ULTRIX-HDX-IO and ULTRIX-MODX-IO blades only
• Provides 64 input and 64 output Audinate Dante channels via the AUX C port on the blade

› non-redundant only
› requires a GigE Copper SFP
› on a separate network from UltriStream (the GigE SFP in the AUX D port of the same blade)

• AUX C audio channels are added to the routing database (we recommend separate databases for 
the AUX B and AUX C maps)

• Sampling Frequency of 48kHz 
• Support for the L24, and L16 codecs (linear PCM only)
• Capable of bridging different timing domains between the Dante network and Ultrix reference
• Dante latency (Link-offset) available: 2ms, 3ms, 4ms, 5ms, and 10ms 
• IP connection management via the Dante controller
• AES67 mode is enabled by default



204 • Ultrimix-Dante Setup Ultrix User Guide (v28-rev5)

Before You Begin
Ensure the following:

• You have access to the computer running the Dante Controller application to assign audio 
receivers and transmitters to the Ultrix router blade(s). Refer to the Audinate website for details.

• The AUX C port on the router blade is populated with an SFP-RJ45-1G module. Refer to the Ultrix 
SFP Modules User Guide for specifications.

• Your facility IT Department provided the required network settings for each AUX C port you plan 
to enable for the Ultrimix-Dante license for.

• The UltriStream and the Ultrimix-Dante licenses cannot be enabled on the same slot. By enabling 
an Ultrimix-Dante license on a slot, you will be prevented from enabling an UltriStream license on 
that slot until you disable the applied Ultrimix-Dante license.

• When Ultrimix-Dante is enabled on a slot, the UltriSRC license state cannot be changed. 
• It is recommended to create separate databases for AUX B and AUX C before installing an 

Ultrimix-Dante license.
• Ultrimix-Dante utilizes an ASRC (Asynchronous Sample Rate Converter) to bridge the Dante clock 

domain (PTP) to the Ultrix clock domain. Both the Dante and Ultrix networks have the same 
48kHz sampling frequency. 

Installing an Ultrimix-Dante License
Ross Video uses license keys to control user access to specific features. You can obtain a key for a 
licensed feature from Ross Video Technical Support. Use the key to assign an Ultrimix-Dante license 
to a supported blade in the Ultrix router.

To install an Ultrimix-Dante license key

1. Launch the DashBoard client. 

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Systems sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Ultrix node.

The Device Configuration interface opens.

6. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

7. Make a note of the character string in the Request Code field for the Ultrimix-Dante license.

8. Contact Ross Video Technical Support using the information listed in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from step 7.

b. You will be given a License Key for the Ultrimix-Dante.

9. Enter the provided License Key in the applicable License Key field of the Licenses tab.

 You can also right-click on the row for the License Key you are installing, copy the Request Code 
to or paste the License Key from the Microsoft Windows clipboard, and click Yes.

10. Click Apply in the row for the License Key you entered in step 9.

11. Verify that the Count field is updated to report each installed Ultrimix-Dante License Key.
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To activate an Ultrimix-Dante license for a specific slot

1. In the Licenses interface, select the Ultrimix-Dante sub-tab.

The interface is organized into a table with three columns. The left column (Slot) lists the 
available slots that the license can be assigned to. The center column (Card | Port) lists the type 
of blade and the port name. The right column (License) provides the option to enable/disable 
the license for the specified slot.

 All Dante capable blades use the AUX C port for Ultrimix-Dante.

2. Verify that the top Licenses read-only field reports the total number of purchased 
Ultrimix-Dante licenses for the router.

3. In the table, locate the row for the slot you wish to enable the Ultrimix-Dante license.

 The FLEX slot of the ULTRIX-FR5 does not support Ultrimix-Dante.

4. Use the License column to select Dante for the slot.

Once the license is activated on the blade:

• AUX C on the SFP Configuration > AUX Ports interface has its SFP setting set to Dante Audio.
• If AUX B was assigned to SDI Video, there is no change to the SFP setting.
• If AUX B was assigned to MADI, it is now set to None. The SDI Video will still map to SDI Video (but 

without audio). 

Accessing the Ultrimix-Dante Interface
Once an AUX C port is assigned to Dante Audio, you can access the Ultrimix-Dante settings via the 
DashBoard Port Configuration tab. The Port Configuration > Views > Ultrimix-Dante option for that 
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slot is now editable. This interface is used to configure the Ultrimix-Dante network settings, view 
performance metrics, and then monitor it during operation.

To display the Ultrimix-Dante interface

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the Slot toolbar (at the top of the Port Configuration page), select the button for the slot 
you enabled the license on.

7. Perform one of the following:

• Set the Views to Ultrimix-Dante; or
• Select the AUX C port on the blade map of the Home page .

The Port Configuration page updates to display the Ultrimix-Dante interface.

Overview
The Ultrimix-Dante interface is organized into three areas: an I/O map of the selected blade (top), a 
table listing the configured channels (left pane), and options for configuring and monitoring the 
Ultrimix-Dante channels for the selected AUX C port (right pane). A toolbar at the bottom reports 
status messages.

Figure 49  Example of the Port Configuration > Ultrimix-Dante Areas

1.  Blade I/O Map

The top includes a map of the ports available on the selected blade. Note that the AUX C port in 
the UI changes color based on the state of the SFP connection and license status (green when the 
connection is valid, and red for error conditions). When View is set to Ultrimix-Dante, the AUX C 
port is automatically selected on the Blade I/O Map and any other port is not selectable from this 
map. A small icon displays over the AUX C port when an Ultrimix-Dante license is enabled.
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› A green icon indicates that the license is enabled and the port is populated with a valid SFP 
module.

› A red icon indicates that the license is enabled but an SFP module is not plugged into the port.
› A gray icon indicates that the license is not enabled.

2. Status Table

The left panel includes a read-only table that reports the selected slot that includes the licensed 
Dante channel(s) on AUX C. Refer to Table 61 for more information.

3. Configuration Options

The right panel includes the following tabs:

› Dante Status — reports read-only information from the Dante Controller.
› Network Settings — provides options for configuring the network settings for an AUX C port. 

Refer to Table 63.
› Loopback — options for configuring the audio loopback mode for each AUX C port. This is an 

advanced feature used to troubleshoot your connections.
› Audio Statistics — reports read-only information about the Dante receiver and transmitter 

channels for the AUX C port. This is an advanced feature used to monitor your connections.
› Tone Generator — provides options for troubleshooting the Dante channels.

 The Ultrimix-Dante tabs are disabled (grayed out) when a blade is selected that does not have an 
Ultrimix-Dante license enabled.

4. Configuration Status Toolbar

The toolbar is located in the bottom right corner and includes a status field and two buttons.

› The status field reports the status of changes made in the Ultrimix-Dante tabs and menus. A 
status indicator can vary in severity from green (valid), yellow (caution), to red (alarm). 

› Select  to view details on the current status message.

› Click Apply to save any changes made to the Ultrimix-Dante tabs and menus.

Network Configuration
The Dante channel are transmitted and received via the AUX C port on each supported Ultrix blade. 
This first requires you to specify how the IP address for the port is assigned (Static or DHCP). Both 
methods are described below.

When using UltriStream and Ultrimix-Dante, ensure that your NDI and Dante networks are 
separated. Combining these networks can lead to congestion, performance issues, and degraded 
Dante audio quality.

 Contact your network administrator if difficulties or problems are experienced when assigning IP 
addresses.

To configure the network settings for the AUX C port

1. Display the Ultrimix-Dante interface as outlined in “To display the Ultrimix-Dante interface”.

2. Select the Network Settings sub-tab.
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3. If you are manually configuring the network settings:

a. Use the Mode menu to select Static.

b. Use the IP Address field to specify the new static IP Address for the AUX C port. 

This is the IP Address that is used by the Ultrix router in the Dante network.

c. Use the Subnet Mask field to specify the subnet mask for the AUX C port. 

d. Use the Default Gateway field to specify the gateway for communications outside of the 
local area network (LAN) the Ultrix will use.

4. If you want the network settings for the AUX C port to be automatically obtained, and DHCP 
service is available on your control network, select DHCP from the Mode menu. This is the 
default mode.

 Verify that a DHCP server is running in your network before setting the Mode to DHCP.

5. Verify that the SFP Detected field reports that a supported SFP module is installed in the AUX C 
port and its status is valid.

6. Click Apply to save the new settings.

Configuring a Dante Connection
This section briefly outlines how to establish communication between the Ultrix router and your 
Dante network. It is recommended to consult the Dante Controller user documentation for 
configuration details.

Assigning Dante Channels to the Ultrix Router
This section briefly outlines how to use the Dante Controller software to route the IP audio 
channels, select the Codec protocol, and configure the latency settings for the Ultrix connection.

To configure the Dante controller settings for Ultrimix-Dante

1. Launch the Dante Controller application.

2. Select the Routing tab.

The Dante Controller window displays a matrix of Dante Receivers and Dante Transmitters.

• Dante Receivers — all the destinations on the Dante network that you can route audio to. 
• Dante Transmitters — all the sources on the Dante network that you can route audio from.
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3. On the matrix, select the audio source (Transmitter) that you want to route to the destination 
(Receiver) by clicking on the box where they intersect. 

A check-mark is shown to confirm that the routing has been made.

4. Display the Device View for the Ultrix router.

5. Select the Device Config tab.

6. Assign the Codec and Latency values as required by your routing system.

Audio Routing Overview
Once Ultrimix-Dante is configured, and connections are made via the Dante Controller, you can 
route the audio channels via the Ultrix database. This is done like any other routing on Ultrix as 
follows:

• The Dante audio channels are made available via AUX C. 
• The AUX B audio channels will not be available while Dante channels are in use. 
• This will be reflected by an addition of AUX C channels for SOURCES and DESTS in the Ultrix 

database and issuing take errors for AUX B connections when Ultrimix-Dante is enabled.

For More Information on...
• databases for your routing system, refer to the Ultricore Ultrix Database Guide.

DashBoard Menus Overview
This section briefly summarizes the read-only fields, menus, and editable fields available when an 
Ultrimix-Dante license is applied to a supported router blade, and the Views is set to 
Ultrimix-Dante.

Figure 50  Example of the Ultrimix-Dante > Dante Status Tab in DashBoard

Status Table
Table 61 summarizes the read-only fields displayed in the table located in the left pane of the Port 
Configuration tab.
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Dante Status Tab
Table 62 summarizes the read-only fields displayed in the Port Configuration > Ultrimix-Dante > 
Dante Status tab. 

Network Settings Tab
The Network Settings tab is used to the AUX C port for communication on the Dante network. This is 
required before you can stream Dante audio through Ultrimix-Dante.

Table 63 summarizes the options displayed in the Port Configuration > Ultrimix-Dante > 
Network Settings tab.

Table 61  Ultrimix-Dante — Status Table

Item Parameters Description
Name Reports the identifier assigned to the Dante connection 

AUX Port IP Reports the IP address assigned to this AUX C port

State Green • The Ultrimix-Dante license is enabled
• A valid SFP module is installed in this AUX 

port
• The link for the AUX C port is valid 
• The Dante connection is operating 

correctly without errors

Red The Ultrimix-Dante license is enabled but 
an SFP is not installed in this AUX C port

Gray One of the following is occurring:
• the Dante connection is no longer valid
• the Ultrimix-Dante license is not enabled 

for this slot
• the Dante connection encountered an 

error

Table 62  Ultrimix-Dante — Dante Status Tab

Item Parameters Description
Name <text> Reports the name of the Ultrix router within 

the Dante network

Sample Rate (kHz) # The average number of audio samples sent 
in a second

Codec L16 Specifies the Codec used to encode the 
audio data in your Dante network.
The Dante Controller labels this value as 
“Encoding”.

L24
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Advanced Features
This section briefly outlines troubleshooting and monitoring options for Ultrimix-Dante. 

Configuring the Loopback Mode for Ultrimix-Dante
The Loopback tab allows you to troubleshoot your Dante audio data path by enabling loopback at 
various points in the Ultrix routing system.

To configure the Ultrimix-Dante loopback mode

1. Display the Ultrimix-Dante interface as outlined in “To display the Ultrimix-Dante interface”.

2. Select the Loopback sub-tab.

Table 63  Ultrimix-Dante — Network Settings

Item Parameters Description
Mode Static The user manually supplies the network 

settings for the AUX C port

DHCP Automates the assignment of the network 
settings for the AUX C port. This is the 
default.

IP Address # Specifies the IP address assigned to the AUX 
C port. This address is used to 
communicate with the devices in your 
Dante network.

Subnet Mask # Specifies the subnet mask for the AUX C 
port

Default Gateway # Specifies the gateway for communications 
outside of the local area network (LAN)

SFP Detected 
(read-only)

Valid (Green) The SFP in the AUX C port is supported, 
correctly installed, and operational

Invalid (Red) One of the following is occurring with the 
SFP in the AUX C port:
• the SFP does not support audio streaming
• the SFP is not operational
• the SFP is not installed correctly
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3. Select one of the following:

• No Loopback (Default Audio) — The Dante audio channel is not routed back to its source.
• Ultrimix-Dante Loopback — the incoming Rx data is routed to the transmitter channel at the 

recovered clock rate.
• Dante Network Loopback — the incoming Rx data is routed to the transmitter channel as it 

becomes available.

4. Click Apply to save the new settings.

Monitoring the Audio Status
This Audio Statistics tab allows you to monitor communications and status about the Dante 
network as well as the Dante data path. Enable this tab when monitoring the Dante Controller 
connection for troubleshooting purposes.

Table 64 summarizes the read-only information displayed in the Port Configuration > 
Ultrimix-Dante > Audio Statistics tab. 

Table 64  Ultrimix-Dante — Audio Statistics

Item Description
Show Metrics Determines if the Audio Statistics tab displays the status of the Dante 

Controller connection. The default is Hide Metrics.Hide Metrics

Network

Bandwidth (%) Reports the amount of audio data the Ultrix router is currently 
receiving via the Dante networkBandwidth (Mbps)

Packets

Bytes

Errors Reports the total number of error packets detected on this Dante 
instance

Drops Reports the total number of dropped packets detected on this Dante 
instance

Dante Audio (RX, TX)
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Inserting Test Tones
The Tone Generator tab allows you to insert generated tones onto transmit channels as well as 
verify the status of the generated tone on the receive channel. This is useful for creating an external 
loopback test where an external device or network sends back the data it receives from 
Ultrimix-Dante. If required, you can also inject errors into the transmit path to verify if the 
connections are operating correctly.

Table 65 summarizes the options displayed in the Port Configuration > Ultrimix-Dante > Tone 
Generator tab. 

Frame Count The number of frames detected in a sample of this Dante audio 
instance

FIFO Underflow 
Alarm

No Alarm (Green) Data is being written to the FIFO without 
errors

Alarm (Red) The FIFO cannot provide the requested data 
as it is empty

N/A The Dante audio instance is not configured

FIFO Overflow 
Alarm

No Alarm (Green) Data is being written to the FIFO without 
errors

Alarm (Red) The FIFO is full and new data cannot be 
written to it

N/A The Dante audio instance is not configured

Table 65  Ultrimix-Dante — Tone Generator

Item Parameters Description
Tone Generator Enable

Disabled - Default 
Audio

Selected The Rx and Tx have valid data as configured 
by the user. This is the default

Enabled - Tx Tone 
Audio

Selected All channels coming out AUX C will include 
the internally generated tone

Tone Channel Lock Status

Reports if a valid tone is received on the specified Rx channels, validating that the Tx tone is 
received correctly. Note that only RX channels 0 and 1 are checked.

Channel # Locked (Green) Valid tone on Rx channel

Unlocked (Red) No valid tone on Rx channel

Not Configured (Gray) Tone is not enabled

Cumulative Channel 1/0 Error Counters

Reports the error count on the Rx channels. Can be used alone or with Error Injection.

LSB 4 Bits [0:3] Errors are seen on lower bits. This represents a small scale degradation 
of signal quality.

MSB 20 Bits [4:23] Errors are seen on higher bits. This represents a significant degradation 
of signal quality.

Error Injection

Table 64  Ultrimix-Dante — Audio Statistics

Item Description
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Manually Inject Errors on the specified Tx channel. This can be used in conjunction with Error 
counters above if there exists a remote loopback.

Channel Selection Select the Tx channel to inject the error on

Inject Errors Injects a single error on the specified Tx channel

Table 65  Ultrimix-Dante — Tone Generator

Item Parameters Description
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ULTRIMIX-MXR
The ULTRIMIX-MXR licensed feature is a virtual audio mixer that can be configured up to 128×64. It 
can be partitioned into smaller mixers so you can have multiple instances within the frame. 

The ULTRIMIX-MXR has access to every input in the system, and its outputs can be routed to any 
output in the frame, providing tremendous flexibility for audio work-flows. Each input has a 4-band 
parametric equalizer, noise gate and compressor/limiter. In addition, ULTRIMIX-MXR has 128 direct 
outputs for simple audio processing as part of its standard feature set. It is controllable via a 
DashBoard user interface as well as application-specific panels for both the Ultritouch-2 and 
Ultritouch-4 control panels.

Key Features
• Licensed in 32×16 blocks
• Multiple licenses can be purchased to build a maximum size of 128×64
• 4 Band Parametric EQ per input
• Noise Gate per input
• Compression/Limiter per input
• DashBoard control
• Ultritouch-2 and Ultritouch-4 panel support

Flexible Mapping
Any Ultrix audio input (embedded SDI, MADI, or IP based) may be routed to any mixer input, and 
any mixer output may be routed to any audio output channel. You may route any audio signal 
within Ultrix via any mixer input. Also, the mixer outputs may be routed to any Ultrix audio 
destination, including back into the mixer.

Each ULTRIMIX-MXR license provides an I/O (Input/Output) block of 32 inputs by 16 outputs. A 
maximum of 4 licenses provides an I/O block of 128 inputs by 64 outputs.The ULTRIMIX-MXR may 
be partitioned into smaller blocks to provide multiple small audio mixers. 

Figure 51 is an example of one audio mixer (one license) with 64 stereo inputs (128 channels) and 
32 stereo outputs (64 channels). Figure 52 is an example of partitioning to obtain two smaller 
independent ULTRIMIX-MXR I/O blocks. Each partition is stereo 32x16.

Figure 51  One Audio Mixer — 64x32 Figure 52  Two Audio Mixers — Each 32x16
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Soft Panels
An Audio Mixer soft panel type allows for real-time adjustment of audio levels and audio 
processing, and provides a familiar interface similar to other audio consoles. Each channel strip is a 
stereo pair (i.e. two audio channels). Similarly, each output bus is a stereo pair.

By default, the Home View of an audio mixer soft panel is similar to Ross RAVE. The window is 
divided into channel strips and includes the features you enabled during the soft panel 
configuration. You also have the option to add drawers to the left and/or right margins of the soft 
panel window (like an Ultritouch soft panel). 

When the router is under Ultricore BCS control, the soft panel provides audio mixing capability 
only (and not crosspoint switching as the Sources are automatically set to None). To perform 
crosspoint switching, you must first load the audio mixer soft panel onto the Ultricore BCS panel 
and then select the sources via that Ultricore BCS panel.

For More Information on...
• audio mixer soft panels, refer to the Ultrix and Ultricore Database Guide.

Figure 53  Example of an Audio Mixer (Desktop) Soft Panel

Setup Overview
This chapter summarizes how to:

1. Install a ULTRIMIX-MXR license(s) for each audio mixer partition you require. You can install up 
to 4 licenses in a single router. Refer to “Installing the License Key for an Audio Mixer”.

2. Specify the audio mixer I/O partitions. Refer to “Configure the Audio Mixer I/O Partitions”.

For More Information on...
• creating sources and destinations with audio mixer I/O mappings, refer to the Ultrix and 

Ultricore Database Guide.
• configuring an audio mixer soft panel, refer to the Ultrix and Ultricore Database Guide.
• load the audio mixer soft panel to your desktop or an Ultritouch panel, refer to the Ultrix and 

Ultricore Database Guide.
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Installing the License Key for an Audio Mixer
Install the ULTRIMIX-MXR software license for the Ultrix router as outlined in “Software License 
Keys”.

Configure the Audio Mixer I/O Partitions
Each ULTRIMIX-MXR license provides a block of audio mixer Inputs and Outputs (I/O). The block size 
is determined by how many ULTRIMIX-MXR licenses are enabled. This I/O block may be partitioned 
to create smaller independent mixers.   

For example, an Ultrix with four ULTRIMIX-MXR licenses enabled will yield a single audio mixer with 
an I/O matrix of 64 stereo inputs × 32 stereo outputs. The Device Configuration interface in 
DashBoard enables you to create the following matrices based on how you want to partition the 
inputs and outputs:

• 1 Mixer where the mixer is a 64×32 (stereo)
• 2 Mixers where each mixer is a 32×16 (stereo)
• 4 Mixers where each mixer is a 16×8 (stereo)
• 8 Mixers where each mixer is a 8×4 (stereo)
• 16 Mixers where each mixer is a 4x2 (stereo)

 It is strongly recommended to configure your audio mixer partitions at the same time as 
configuring the other ports for your router. Changes to mixer partition is a major operation due 
to existing mixer I/O maps in sources and destinations are no longer valid, and mixer partition 
assigned to a mixer panel may no longer available.

Master and Monitor Outputs
Each partition has two defined outputs named Master and Monitor. The physical outputs the 
Master and Monitor buses are assigned to is user configurable. By default, Master is assigned to the 
first output bus and Monitor is assigned to the last output bus of the partition.

For example, an Ultrix with one ULTRIMIX-MXR license allows a single block of 32×16 audio mixer 
I/O. This equates to a possible mixer with 16 stereo inputs and 8 stereo outputs, or buses. By 
default, a single partition on this I/O block will set the Master bus to mixer I/O OUT 1 and the 
Monitor bus to OUT 8.

With Master set to bus OUT 1 and Monitor set to bus OUT 8, this leaves the remaining 6 outputs as 
Auxiliary (AUX) buses. 

Figure 54  Master and Monitor Outputs within a Partition
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The Master and Monitor buses operate in conjunction as follows;

• The Monitor bus follows the Master unless a channel strip has SOLO activated.
• When no channel strip SOLO is activated, the Monitor bus has the same audio mix as the Master 

bus.
• When a channel strip SOLO is activated, the Monitor bus mutes other channels except for those 

in SOLO mode. The SOLO button is highlighted (this applies whether the active bus is Master or 
an AUX).

• Any Master channel strip with SOLO activated does NOT affect the Master bus.
• Multiple channel strip SOLOs are allowed, and they all appear in the Monitor simultaneously.
• Selecting the SOLO Clear button will clear all currently active SOLO channel strips.

The SOLO mode on an auxiliary bus operates differently as there is no specific monitoring bus 
output for the Auxiliary buses.

• Any channel strip with SOLO activated will MUTE the other channels on that AUX bus.
• When an AUX strip SOLO is activated, the Monitor bus has the same audio mix as an AUX bus 

with SOLO activated.

Configure the Audio Mixer Partitions
The number of default partitions is determined by the license key you installed.

To configure an audio mixer partition

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Audio Mixer tab.

7. Click Audio Mixer Partitions.

8. Use the Mixer Partition menu to specify the number and types of audio partitions you require.

9. Click Apply.

Audio Mixer Operation
This section provides examples two possible audio mixer setups: a generic system and a.

Generic Setup
This example assumes the following generic setup seen in Table 66. Note that generic physical IO 
names shown for brevity.
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To perform a simple route of audio mixer channels

1. To route a mixer output to a destination:

a. Choose a destination to receive the mix.

b. Choose a source for the destination.

2. To route a source audio to a mixer input:

a. Select the mixer input.

Table 66  Example Mapping for Router Sources and Destinations

Video A1 A2
Source
SRC1 slot1.in[1].sdi slot1.in[1].audio.c

h1
slot1.in[1].audio.c
h2

SRC2 slot1.in[2].sdi slot1.in[2].audio.c
h1

slot1.in[2].audio.c
h2

SRC3 slot1.in[3].sdi slot1.in[3].audio.c
h1

slot1.in[3].audio.c
h2

... ... ... ...

MXR MSTR slot0.mixer-out[1] slot0.mixer-out[2]

MXR AUX1 slot0.mixer-out[3] slot0.mixer-out[4]

... ... ... ...

Destination
Dest1 slot1.out[1].sdi slot1.out[1].audio.

ch1
slot1.out[1].audio.
ch2

Dest2 slot1.out[2].sdi slot1.out[2].audio.
ch1

slot1.out[2].audio.
ch2

Dest3 slot1.out[3].sdi slot1.out[3].audio.
ch1

slot1.out[3].audio.
ch2

... ... ... ...

MXR IN1 slot0.mixer-in[1] slot0.mixer-in[2]

MXR IN2 slot0.mixer-in[3] slot0.mixer-in[4]

... ... ... ...
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b. Select the required source.

With these route operations, we have routed the output of the Mixer Master bus (assuming 
Master is set to Out1 in the mixer partition settings), to our router destination DST 1, and then 
routed audio channels 1 and 2 (as the mixer map is only configured for two channels in this 
example), of our router source SRC 3 to the mixer Channel strip 1.

Or, to look at it another way; audio channels 1 and 2 on router destination DST 1 are connected 
to the mixer Master bus. The Master bus has router source SRC 3 audio channels 1 and 2 via 
Channel strip 1.

3. To add another source to the mix:

a. Select another mixer input.

b. Select the source of the extra channels.

After this route, audio mixer Channel strip 2 receives the audio channels 1 and 2 of SRC 2. The 
MXR MSTR can have a mix of SRC 3 channels 1 and 2, and SRC 2 channels 1 and 2. Channel strip 
faders 1 and 2 control the mix of their respective sources. The Mixer Master fader controls the 
overall level of the mix.

Using Audio Mixer Direct Outputs
ULTRIMIX-MXR provides a direct channels strip output (pre-fader). This allows the use of the 
equalizer, compressor/limiter, and noise gate without requiring the effects to be routed through a 
mix bus.

In this example, we assume the mapping seen in Table 67.

Table 67  Example Mapping for Router Sources and Destinations

Video A1 A2
Source
SRC1 slot1.in[1].sdi slot1.in[1].audio.c

h1
slot1.in[1].audio.c
h2

SRC2 slot1.in[2].sdi slot1.in[2].audio.c
h1

slot1.in[2].audio.c
h2

SRC3 slot1.in[3].sdi slot1.in[3].audio.c
h1

slot1.in[3].audio.c
h2

... ... ... ...

FX1 slot0.mixerda-out[
1]

slot0.mixerd-out[2
]
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With the above mapping, we can feed the output of the filters (noise gate, equalizer, 
compressor/limiter) to any destination.

1. Route a channel strip direct output to a destination:

a. Select the required destination.

b. Select an output of the mixer as the source.

2. Route a source to the channel strip:

a. Select a mixer input as a destination for the source.

b. Select the required source.

With these route operations, we have routed the direct outputs of mixer Channel strip 1 to our 
router destination DST1, and then routed audio channels 1 and 2 of our router source SRC3 to 
the mixer Channel strip 1.

FX2 slot0.mixerd-out[3
]

slot0.mixerd-out[4
]

... ... ... ...

Destination
Dest1 slot1.out[1].sdi slot1.out[1].audio.

ch1
slot1.out[1].audio.
ch2

Dest2 slot1.out[2].sdi slot1.out[2].audio.
ch1

slot1.out[2].audio.
ch2

Dest3 slot1.out[3].sdi slot1.out[3].audio.
ch1

slot1.out[3].audio.
ch2

... ... ... ...

MXR IN1 slot0.mixer-in[1] slot0.mixer-in[2]

MXR IN2 slot0.mixer-in[3] slot0.mixer-in[4]

... ... ... ...

a. The “d” in the mixer physical label represents Direct Out.

Table 67  Example Mapping for Router Sources and Destinations

Video A1 A2
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Or, to look at it another way; audio channels 1 and 2 on router destination DST1 are connected 
to router source SRC3 audio channels 1 and 2 via mixer Channel strip 1 filters (gate, 
compressor/limiter, and equalizer). The settings of the filters will effect the audio channels 1 
and 2 of destination DST1.
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Using Remote Control Panels
When the Ultrix router is configured for Ultricore mode, it responds to switch commands from Ross 
NK Series and Ross series control devices. These commands contain source, destination, and level 
designations. Routers acknowledge the switch request with the selected crosspoint switch status 
after the switch has occurred. The Remote Control Panels (RCP) may operate singularly, or in a 
linked mode where two or more (up to 10) panels may operate as a larger panel with more buttons.

Connection to Ultrix
The method of connection between Ultrix and an RCP will vary depending on the type of panel. 
Ethernet enabled devices such as the RCP-ME and RCP-QE communicate with Ultrix directly. 
Non-ethernet panels such as the RCP-NKQ, RCP-NKM and RCP-NK1 connect through an NK-NET or 
NK-IPS to convert the native T-Bus commands to ethernet.

Native ethernet panels receive their labels automatically from the Ultrix database upon panel 
start-up. Any subsequent changes to the database labels are also automatically pushed out to 
connected ethernet panels. The NK series panels do not automatically get updates from the 
Ultricore control system and must use a manual process via DashBoard. Refer to the user guide for 
your RCP for details.

 For optimal performance when using a Ross RCP with Ultrix, the Comms Retry factor should be 
set to 80ms or greater within the RCP configuration. Refer to the user guide for your RCP for 
details.

RCP-NKM Connection to a Ross NK Router and an Ultrix Router

The RCP connection as shown in Figure 55 requires a connection point between Ultrix and the 
NK-NET. Refer to the section “Connecting to Ross NK Series Devices” for details.

 The NK-NET requires power from the Ross NK Router (over T-Bus).

Figure 55  Example of a Connection from an Ultrix Router to an NK-3G-16 and RCP-NKM

RCP-QE Connection to an Ultrix Router

RCP-QE and RCP-ME remote control panels require a a connection point between Ultrix and the 
panel. Refer to the user guide for your panel for details.
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Figure 56  Example of a Connection from an Ultrix to an RCP-QE

RCP-NKM with a NK-IPS and NK Router to an Ultrix Router

The RCP connection as shown in Figure 57 requires a connection point between Ultrix and the 
NK-IPS. Refer to the section “Connecting to Ross NK Series Devices” for details.

Figure 57  Example of a Connection from an Ultrix Router to an NK-IPS and an RCP-NKM

Remote Control Panel Operation
The control panel functions detailed in this section can be programmed with the Ultricore for full 
functionality. The examples herein are generic functions applicable to all panel types.

For More Information on...
• specific applications, refer to the user documentation that accompanied your device.
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Destination Buttons
Selecting a destination changes the destination the panel controls or switches the next time a 
Source button is pressed. Destinations can be selected by pressing a preset DESTINATION button.

When a preset DESTINATION button is pressed, that button and its source status button (if a preset 
key exists on the current view or menu) will be illuminated.

 Each panel type has slightly differing method of displaying current status depending on the 
display type or lack there-of. Refer to individual RCP manuals for details.

Figure 58 illustrates an RCP-QE36 panel where Outpt1 is the selected destination.

Figure 58  Selecting a Destination Button — Outpt1 Selected

Source Buttons
Source switching is performed by pressing a preset SOURCE button. Selecting a source (when a 
TAKE function button is not assigned), results in the controller requesting the selected source to be 
switched by the router to the panel's current destination. If a TAKE function button is assigned to 
the current view or menu, the TAKE button will be illuminated. This indicates that TAKE is armed 
and the requested switch will be completed upon the user pressing the TAKE button.

Figure 59 illustrates a panel where Outpt1 is the destination, Input 7 is the source, and the TAKE is 
armed.

Figure 59  Selecting a Source Button — Camera 7 Selected

The flow is always destination selection followed by source selection. This switch will be executed 
with the current panel breakaway/level selections.

Level Buttons
Level buttons select individual router levels. These correspond to the levels tab of the current 
Ultricore database. Level buttons are cumulative e.g. you may activate other levels after already 
selecting a level button.

The following sequence of button presses would result in SRC 1 being routed to DEST 1 but only on 
the levels named SDI, SDI A1 and SDI A2. Any other levels defined in the current Ultricore database 
will be ignored and their status will remain as previously selected. If a level is selected in error, press 
that key again to de-select. The switch occurs once the Source selection is made.
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1. Select the Destination button.

2. Select the SDI Level button.

3. Select the Level SDI A1 button.

4. Select the Level SDI A2 button.

5. Select the Source button.

Breakaway Buttons
Breakaway buttons are buttons tied to a breakaway definitions. A breakaway is a pre-set pattern of 
levels defined within the panel configuration. Breakaways can be customized from the control 
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panel’s properties settings via the interface in DashBoard. Figure 60 is an example of configuring a 
breakaway for a control panel.

Figure 60  Example of a Breakaway Setup Interface

 The level numbers correspond to the number in the ID column of the Levels tab within the 
current database.

The following sequence of key presses would result in Src 3 being routed to Dest 2 but only on the 
levels included in the SDI Only breakaway pattern as defined within the RCP set-up (Level 1 in this 
example). The switch occurs once the source selection is made.

1. Select the Destination button.

2. Select the SDI Only breakaway button.

3. Select the Source button to activate the switch selection.

In the following example, the user is switching video from one source (Src 1) and embedded audio 
from another (Src 2).
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1. Select the Destination button.

2. Select the SDI breakaway button containing SDI video only level.

3. Select the Source button to activate the switch selection.

4. Select the breakaway button containing the SDI embedded Ch1 and Ch2 levels.

Once BWAY A1, A2 is pressed, BWAY SDI becomes unlit.

5. Select the Source button for the embedded audio.

Crosspoint Buttons
Crosspoint buttons perform a preset single crosspoint switch in a single button press. A crosspoint 
key contains a source (e.g. Src 1), a destination (e.g. Dest 1), and breakaway (e.g. SDI Only) within its 
definition. 
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Operation with Ross Devices
Ultrix may also connect to Ross NK series devices to expand functionality for signal types the Ultrix 
router itself does not handle. The Ross NK series devices must be connected to the Ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable the Ultrix router to communicate 
with them.

Overview
Introducing an Ultrix router to a Ross NK system will require specific configuration to enable the 
Ultrix routing system to manage them.

Using RCP-NKx Remote Control Panels
When adding the Ultrix router to an existing system with one or more RCP-NKx devices, each 
remote control must:

• have the Virtual routing enabled on their Configuration page
• have the Comms Retry Delay Factor set to 80ms or greater
• ensure that the level numbers correspond to the Ultrix Level ID number

Be aware that the RCP-NKx devices do not:

• support Ultrix salvos
• automatically get source and destination labels from the Ultrix router. They must be entered 

manually or via a global labels file.

Using Ross NK Series Routers
The Ross NK router partitioning not supported. The logical mapping of the Ultricore control system 
is far more capable and should be implemented there if required.

Keep the following in mind:

• The NK-IPS requires version 2.23 or greater to communicate with an Ultrix router.
• The SCP/A is not supported.
• The SCP/K2 is not supported.
• NK-A64 control level is not supported.

Table 68 outlines the nomenclature that Ultrix automatically uses for Ross NK devices. 
Table 68  Default Ultrix Naming for Ross NK Devices

Ross NK Device Matrix Name Port Name
NK-3Gxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Axxx deviceName.An Aud L deviceName.slot1.in/out[socket number].An Aud L.ch1

deviceName.An Aud R deviceName.slot1.in/out[socket number].An Aud R.ch1

NK-Dxxx deviceName.AES deviceName.slot1.in/out[socket number].AES.ch1

NK-Mxx deciceName.Machine 
Control

deviceName.slot1.in/out[socket number].Machine 
Control.ch1

NK-MDxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Vxxx deviceName.An Vid deviceName.slot1.in/out[socket number].An Vid.ch1
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Using Ross Analog Audio Devices (NK-A16, NK-A32, NK-A64)
The Ross NK Analog Audio devices (NK-A16, NK-A32, NK-A64) will present as two matrices: Left and 
Right respectively. Note that the NK-A64 control level is not supported.

Connection Diagrams
Figure 61 provides an example of a routing system with an Ultrix router, an NK-NET, and several 
Ross NK devices. Communication between the NK-NET and the Ross NK devices is over T-Bus.

 The NK-NET requires any Ross NK router to supply phantom power for operation.

Figure 61  Connection Example with an NK-NET

Figure 62 provides an example of a system with an Ultrix router, an NK-IPS, and several NK devices. 

Figure 62  Connection Example with an NK-IPS
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Adding Ross NK Series Devices to the Ultrix Routing System
To add a Ross NK series device to the Ultrix routing system:

1. Define a connection point between the Ultrix router and each Ross NK series device. Refer to 
the chapter “Device Communication Setup” for details.

2. Review the logical matrices for the Ultrix database.

3. Assign outputs to the logical destinations in the database as outlined in “To map a physical 
output to a destination”.

4. Assign inputs to the logical sources in the database as outlined in “To map an input to a 
source”.

Machine-Control (RS-422) Logical Mapping
Connecting an NK-M series router to Ultrix requires some special consideration;

Machine control routing requires two crosspoints for a point to point connection due to the 
bi-directional nature of the signal. Each physical socket contains a transmit/receive pair. This can be 
thought of as a source-destination combination and is known as a port. 

It is necessary to configure the input and output of the machine control port on the same row ID on 
the logical mapping tables.

Figure 63  Destination Mapping

Figure 64  Source Mapping

It does not matter where the machine control is mapped (either row 3 or 300), but the input and 
outputs physical ports must be mapped to the same row ID.

Conditions for Machine Control
Three conditions must be met before machine control can be switched.

1. The NK machine control router is attached and configured within Ultrix (level, destination. and 
source maps).

2. Selected breakaway or level must include the machine control level.

3. Machine control reciprocal must be enabled on the controller.

Using Ultricore-CC as a System Controller
Ultricore-CC may control one or more Ultrix routers. Ultricore has the advantage of supporting 
more external connections so is ideal for systems with many external connections (RCPs, 
DashBoard instances, third-party control).

 Ensure a unique device name is assigned for each Ultrix within a system.
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Figure 65  Example Setup Using an Ultrix and an Ultricore

Configuration
The workflow of enabling an Ultricore as a system controller for multiple Ultrix routers:

1. Setup any Ultrix licensing requirements within each Ultrix router.

2. Enable Remote Controller Mode on each Ultrix as outlined in “Enabling Remote Controller 
Mode on the Client Ultrix Routers”.

3. Create a basic database within each Ultrix to accommodate the inputs/outputs. Ensure to:

a. use generic names 

b. a basic level of routing is functional.

4. Create a connection point (via the Ultricore interface) from the Ultricore-CC to each Ultrix.

5. Edit the Ultricore-CC database to control Ultrix specific resources.

6. Configure all RCP devices to connect to the Ultricore-CC system controller.

Ross MC1 Master Control System
The MC1 Master Control System (MC1-MK or the MC1-UHD) is a dedicated card-based solution that 
provides complete program path protection using input bypass relays, protecting your channel 
output. Communication between the MC1 card and Ultrix is via an ethernet connection. Any router 
source can be mapped to any crosspoint button on the MC1 On Air Control interface. Refer to the 
user documentation for your MC1 card for details on crosspoint button assignment.

Communications between an MC1-MK and the Ultrix Router

 Router control on the MC1-MK requires v5.0 software or higher.
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Keep the following in mind when configuring the options in the Configuration > Router interface 
of the MC1-MK:

• Ensure the Virtual menu is set to Virtual.
• Ensure the Delay value is set to a minimum of 6 frames.

Keep the following in mind when configuring the options in the Remote Control tab of the 
MC1-MK:

• The Ultrix router uses the NK Router protocol in the Ethernet Port area.
• Set the Role to Client.
• Set the Protocol to TCP.
• Use the IP Address field to specify the IP Address of the Ultrix router.
• Set the Port field to 5000.

For More Information on...
• the communications setup for the MC1-MK, refer to the MC1-MK Installation Manual.

Communications between an MC1-UHD and the Ultrix Router

 Router control on the MC1-UHD requires the MC1-MASTERCTRL-LICENSE.

Keep the following in mind when configuring the options in the Remote Control tab of the 
MC1-UHD:

• The MC1-UHD uses the GVG Series 7000 Ethernet protocol to communicate with the Ultrix router.
• Set the Role to Network Client.
• Set the Packet Type to TCP.
• Use the Remote IP field to specify the IP Address of the Ultrix router.
• Set the Port field to 5000.

For More Information on...
• the communications setup for the MC1-MK, refer to the MC1-UHD User Guide.
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ULTRIX-UCCI Redundancy
This chapter outlines the ULTRIX-UCCI Control redundancy feature for the ULTRIX(-NS)-FR5. This 
feature is not available for the ULTRIX(-NS)-FR1 or the ULTRIX(-NS)-FR2.

Before You Begin
The following are required for ULTRIX-UCCI Control redundancy:

• Two ULTRIX-UCCI Control cards physically installed and configured in the ULTRIX(-NS)-FR5.
• When using an ULTRIX-FR5, ensure it is running software 4v10 or higher.
• The ULTRIX(-NS)-FR5 is installed, and fully configured.

 Contact Ross Technical Support for installing the second ULTRIX-UCCI Control card in your 
ULTRIX(-NS)-FR5.

Overview
The ULTRIX-UCCI Control redundancy feature provides built-in redundancy for your routing system. 
In the event that one ULTRIX-UCCI Control card is affected, the router communications and traffic 
automatically routes to the second card. When the primary ULTRIX-UCCI Control card is back 
on-line, communications automatically switch from the secondary to the primary without user 
interaction. A DashBoard option also exists that enables a user to manually switch from one card to 
the other.

Monitoring
Communications can be monitored via the LEDs on the ULTRIX-UCCI Control hardware or via the 
Device Configuration interface in DashBoard.

Using the Physical LEDs
There are two ULTRIX-UCCI Control Card slots in the top-right corner of the ULTRIX-FR5 (Figure 66) 
and ULTRIX-NS-FR5 (Figure 67). Each slot houses an Ultricore-CC Internal board which includes a 
Micro SD Card slot, a USB port, and four status LEDs.

Figure 66  Location of ULTRIX-UCCI Control Slots in an ULTRIX-FR5

Figure 67  Location of ULTRIX-UCCI Control Slots in an ULTRIX-NS-FR5
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Table 69 describes the Ultrix-UCCI status LEDs. 

Using DashBoard
The Device Configuration interface in DashBoard enables you to monitor the ULTRIX(-NS)-FR5 
hardware including each ULTRIX-UCCI Control slot.

To monitor an ULTRIX-UCCI Control card via DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens. 

The Frame View (Home page) automatically displays a rear panel map. This map represents the 
Ultrix rear panel. In the example below, the router has nine slots populated with HD-BNC I/O 
blades, and two ULTRIX-UCCI Control cards.

Table 69  Hardware — Ultrix-UCCI LEDs

LED Status Description
STATUS Green Indicates the ULTRIX-UCCI Control card is powered and the last 

re-boot was successful

Flashing 
Green

Indicates the ULTRIX-UCCI Control card is powered and in the 
progress of a re-boot

Red Indicates the ULTRIX-UCCI Control card is powered but requires 
a re-boot

PRIM/SEC Green Indicates the ULTRIX-UCCI Control card is configured and 
functioning as the Primary

Flashing 
Green

Indicates the ULTRIX-UCCI Control card is in standby 
(Secondary) mode 

ALARM Red Indicates the ULTRIX-UCCI Control card is experiencing an error 
condition; verify the message(s) on the router front panel LCD 
display and DashBoard

Off Indicates the ULTRIX-UCCI Control card is operating correctly 
and is not experiencing any errors

AUX This LED is not implemented.
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5. Refer to Table 70 for the ULTRIX-UCCI Control status LEDs. 

Upgrading an ULTRIX-UCCI Control Card
Contact Ross Technical Support for information on upgrading the software on your ULTRIX-UCCI 
Control card.

Table 70  DashBoard — Ultrix-UCCI LEDs

LED Status Description
STATUS Green Indicates the ULTRIX-UCCI Control card is powered and the last 

re-boot was successful

Red Indicates the ULTRIX-UCCI Control card is powered but is 
currently re-booting

PRIM/SEC Green Indicates the ULTRIX-UCCI Control card is configured and 
functioning as the Primary

Off Indicates the ULTRIX-UCCI Control card is in standby 
(Secondary) mode 

ALARM Red Indicates the ULTRIX-UCCI Control card is experiencing an error 
condition; verify the message(s) on the router front panel LCD 
display and DashBoard

Off Indicates the ULTRIX-UCCI Control card is operating correctly 
and is not experiencing any errors

AUX This LED is not implemented.



238 • ULTRIX-UCCI Redundancy Ultrix User Guide (v28-rev5)



Ultrix User Guide (v28-rev5) Managing your Ultrix Settings • 239

Managing your Ultrix Settings
This chapter outlines how to import/export your device configuration settings as archived files.

For More Information on...
• managing your databases, refer to the Ultrix and Ultricore Database Guide.

Overview
The Product Info > Transfer interface provides options to import and export archived files (*.ufs) 
of your Ultrix frame settings to another Ultrix. The *.ufs file captures the settings of the Device 
Configuration interfaces except for:

• database configuration
• UltriScape layouts
• device name
• network settings
• NTP server settings
• installed license keys

 This feature requires DashBoard v8.2 or higher and Ultrix software v2.0 or higher.

Exporting the Device Configuration Settings
You create an archive of your device configuration settings using the options in the Product Info > 
Transfer tab.

To export your settings to an archived file

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Click Ultrix Frame Settings.

4. Locate the Export area on the tab.

5. Click Browse... to specify the name and location to save the *.ufs file to.

The Save As read-only field updates with the selected path and file name.

6. Click Apply.

The Downloading Archive dialog opens to report the status of the export.

Importing a Frame Settings File
You must re-boot the Ultrix to apply the settings of the imported *.ufs file. 

To import an Ultrix Frame Settings file

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Click Ultrix Frame Settings.
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4. Locate the Import area.

5. Select the *.ufs file you wish to import as follows:

a. Click Browse... 

The Open dialog opens.

b. Use the Open dialog to specify the *.ufs file to import.

c. Click Open to close the dialog and load the file.

6. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.
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Navigating the Monitoring Interfaces
This chapter summarizes the System > Monitoring interfaces for the Ultrix.

Monitoring Tree Overview
The Monitoring tree provides one sub-node: Alarm Configuration. The Alarm Configuration 
interface enables you to manage what types of alarm conditions to monitor for each slot and port 
that is populated in your Ultrix router. The messages are then reported in a separate tab.

Figure 68  Expanded Ultrix Monitoring Nodes in the Tree View

Double-click the Alarm Configuration sub-node to display its interface in the DashBoard window. 
The interface is organized into two tabs: Alarming Config and Alarming Status. The following 
sections outline each tab.

Alarming Config Tab
The options on the Alarming Config tab are organized into two sub-tabs based on the type of signal: 
Video and Audio. By default, the Video Alarms sub-tab is automatically selected.

Video Alarms Sub-tab
The Video Alarms sub-tab is organized into a table where each row represents a specific slot and 
port in the Ultrix router chassis. Each column provides an option for monitoring a specific aspect of 
the video signal associated with that port.

Figure 69  Example of the Alarming Config > Video Alarms Sub-tab



242 • Navigating the Monitoring Interfaces Ultrix User Guide (v28-rev5)

Table 71 summarizes the columns displayed in the Video Alarms sub-tab.

Audio Alarms Sub-tab
The Audio Alarms sub-tab enables you to select what audio signals to monitor for audio error 
conditions.

Figure 70  Example of the Alarming Config > Audio Alarms Sub-tab

Table 71  Alarming Config — Video Alarms Sub-Tab

Item Description
ID (read-only) Specifies the actual sockets (inputs and outputs) of a router (or 

matrix) using the nomenclature of slot.port.video.ch

Video Black Reports an error when the current signal of the port is set to black

Video Black Hysteresis (s) Sets the maximum number of seconds that DashBoard waits before 
reporting that the signal from this port is set to black

Video Freeze Reports an error when the video signal, on this specific port, is frozen 
to the last valid frame of video

Video Freeze Hysteresis (s) Sets the maximum number of seconds that DashBoard waits before 
reporting a frozen video signal on the specified port

Video LOS Reports an error when a loss of signal occurs on the specified port

Video LOS Hysteresis (s) Sets the maximum number of seconds that DashBoard waits before 
an error is reported after a loss of a valid signal on this port

Video Format Reports an error when the video format of the signal is unsupported

Video Format Hysteresis (s) Sets the maximum number of seconds that DashBoard waits before 
an error is reported when an unsupported video format is detected 
on this port

Caption Format Reports an error when the video signal does not include a valid 
Closed Captioning packet

Caption Format Hysteresis 
(s)

Sets the maximum number of seconds that DashBoard waits before 
an error is reported when the closed caption packet is invalid in the 
signal on the specified port
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Table 71 summarizes the columns displayed in the Audio Alarms sub-tab.

Alarming Status Tab
The Alarming Status tab reports error messages as defined by the settings in the Alarming Config 
tabs. The tab is organized into a table where the left column displays the available virtual ports. 
Selecting a port displays the detected error condition(s) for that port.

Figure 71  Example of the Alarming Status Tab

Table 72  Alarming Config — Audio Alarms Sub-Tab

Item Description
Audio Silence Threshold 
(dB)

Audio below the specified threshold value is considered silent

ID (read-only) Specifies the audio channel (inputs and outputs) of a router (or matrix) 
using the nomenclature of slot.port.audio.ch

Audio LOS Reports an error when a loss of the specified audio channel occurs

Audio LOS Hysteresis (s) Sets the maximum number of seconds that DashBoard waits before an 
error is reported when a loss of this audio channel occurs

Audio Silence Reports an error when this audio channel is set to silence in the 
embedded audio signal

Audio Silence Hysteresis 
(s)

Sets the maximum number of seconds that DashBoard waits before an 
error is reported when the specified audio channel is silenced in the 
embedded audio signal
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Monitoring the Hardware
The Device Configuration interface in DashBoard provides status fields for monitoring the 
individual Power Supplies (PSU), the internal chassis fans, the SD Card, Ethernet ports, and the flash 
storage space of your Ultrix router.

Primary and Redundant Power Alarms
The Primary and Redundant Power alarms in the Frame Configuration interface do not consider 
what ports the PSU are connected on the Ultrix rear panel. The alarms trip only if the required 
minimum state for main or redundant power is not met. Refer to Table 73 for the power 
requirements.

Enabling the Alarms for the Router PSU Ports
You can customize the monitoring of the PSU by selecting which units to monitor and display an 
alarm message when the unit is not detected. The Alarms table fields in the Frame Configuration 
interface vary in severity from green (valid), yellow (caution), to red (alarm). DashBoard reports the 
most severe alarm for a single field.

For More Information on...
• the messages displayed in the Fans & Power tab, refer to Table 74.

To monitor the hardware status of an Ultrix router

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Alarms tab.

7. To add a new item to monitor:

 The ULTRIX(-NS)-FR5 has an option of triggering a GPI contact closure for use with external 
equipment. Select the Alarm Relay box to activate for each alarm type required.

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select a PSU to monitor from the drop-down menu. Choose from the following:

Table 73  PSU Requirements based on Frame Size

Frame Size Min. PSU
Min. PSU for 

Redundancy (N+1)
Min. for Fully 

Redundant (2N) Max. Redundancy
ULTRIX(-NS)-FR1 1 2 2 4N

ULTRIX(-NS)-FR2 2 3 4 2N

ULTRIX(-NS)-FR5 1 x Ultripower
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› PSU # — Monitors the specified PSU port on the Ultrix rear panel.
› Primary Power — Monitors the main power connection (non-PSU port specific) to the 

Ultrix rear panel and determines whether a sufficient number of power supplies are 
connected and operating for the router to run reliably (one PSU for an ULTRIX(-NS)-FR1, 
two PSU for a ULTRIX(-NS)-FR2, and one Ultripower for the ULTRIX-FR5). Refer to Table 73 
for details. 

› Redundant Power — Monitors additional power supplies connected to the Ultrix rear 
panel. When the Primary PSU is unavailable and no other PSU ports are in use, an alarm 
message will be raised to indicate that in the event of a power loss on the primary PSU, the 
router will lose power. Refer to Table 73 for details.

8. Refer to Table 74 for a summary of the possible messages displayed in the Alarms status fields. 
Table 74  Alarms — Status Messages

Item Parameters Description
System Error OK (Green) The last re-boot (power cycle) of the router was successful 

and no errors are detected.

Failed (Red) The last re-boot/power cycle of the router failed. You must 
re-boot/power cycle the router. If the issue still persists, 
contact Ross Technical Support.

None Not Configured 
(Yellow)

The row in the table is not currently monitoring any 
component of the Ultrix router.

Fan # OK (Green) Normal operation; no hardware errors are associated 
with the specified fan

x/y Indicates the fan speed in RPM where:
• x represents the current speed
• y represents the maximum speed

Stalled (Red) Indicates the specified fan is not running

Primary 
Power

OK (Green) Normal operation; no hardware errors associated with 
the PSU
• ULTRIX(-NS)-FR5— an Ultripower connection is detected
• ULTRIX(-NS)-FR2 — at least 2 connected PSU are 

detected
• ULTRIX(-NS)-FR1 — at least 1 connected PSU is detected

Failed (Red) Indicates the minimum number of PSUa are not detected

Redundant 
Power

OK (Green) Indicates extra PSU are detected/available; normal 
operation; no hardware errors associated with the PSU
• ULTRIX(-NS)-FR2 — at least 3 connected PSU are 

detected
• ULTRIX(-NS)-FR1 — at least 2 connected PSU are 

detected

Failed (Red) Indicates the minimum number of PSUb are not detected

Temperature OK (Green) Indicates that the chassis core components temperature 
is within the normal range

Warning (Yellow) Indicates that at least one chassis core component 
temperature is between 75°C and 80°C (167°F and 176°F)

Failed (Red) Indicates that at least one chassis core component 
temperature is above 80°C (176°F)
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Setting the Chassis Fan Speed
The Ultrix router enables you to control the cooling fan speed of the interior chassis fans for 
optimum cooling.

To set the fan speed

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Fans & Power Supplies tab.

7. Use the Minimum Fan Speed slider to specify how fast the fans the will run.

Monitoring the Internal Memory
The Device Configuration interface enables you to monitor the flash storage space of your Ultrix 
router. This is useful when managing a large number of databases or during upgrades.

To monitor the flash storage space

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Alarms tab.

Battery OK (Green) The battery installed in the Cooling Fan Module of the 
chassis is operating normally.

Warning (Yellow) The battery power is between 1.5V and 2.7V.

Failed (Red) The battery power is below 1.5V and requires 
replacement. Refer to “Monitoring the Battery”.

a. An ULTRIX(-NS)-FR2 requires a minimum of 2 PSU to be connected at all times. For ULTRIX(-NS)-FR1 
routers, a minimum of 1 PSU is required.

b. An ULTRIX(-NS)-FR2 requires a minimum of 2 PSU to be connected at all times. For ULTRIX(-NS)-FR1 
routers, a minimum of 1 PSU is required.

Table 74  Alarms — Status Messages

Item Parameters Description
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7. To enable the Flash Storage alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select Flash Storage.

8. Refer to Table 75 for a summary of the possible messages displayed in the Flash Storage 
status field.

Monitoring the SD Card
The Device Configuration interface provides two methods for monitoring the SD Card:

• SD Card Free Space — provides an estimate of how much memory is currently allocated on the 
SD Card.

• SD Card Presence — monitors the physical state of the SD Card within the Ultrix chassis.

To monitor the SD Card storage space 

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Alarms tab.

7. To enable the SD Card Free Space alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select SD Card Free Space.

8. Refer to Table 76 for a summary of the possible messages displayed in the SD Card Free Space 
status field.

Table 75  Alarms — Flash Storage

Parameter Description Solution
OK Database and layout storage space is available

WARNING Database and layout storage space is low • Export unused databases and 
layouts as outlined in 
“Exporting a Database”; or

• Delete unused databases as 
outlined in “Deleting a 
Database”

CRITICAL Database and layout storage is nearly 
depleted
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To monitor the physical state of the SD Card

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Alarms tab.

7. To enable the SD Card Presence alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select SD Card Presence.

8. Refer to Table 77 for a summary of the possible messages displayed in the SD Card Presence 
status field.

Monitoring the Ethernet LEDs via the Rear Panel
Each RJ45 connector on the Ultrix rear panel include two LEDs that report the ethernet 
communication activity and speed. Refer to Figure 72 for LED locations on the Ultrix rear panel.

Table 76  Alarms — SD Card Free Space

Parameter Description Solution
OK Storage space is available

WARNING Less than 20% of the storage space is 
available

Contact Ross Technical 
Support

CRITICAL Less than 10% of the storage space is 
available

Table 77  Alarms — SD Card Presence

Parameters Description
OK (Green) There are no SD Card issues detected

FAIL The SD Card is not properly installed in the router 
chassis. Contact Ross Technical Support.
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Figure 72  ENET Ports on Rear Panel — ULTRIX(-NS)-FR1 and ULTRIX(-NS)-FR2 LEDs

Figure 73  ENET Ports on Rear Panel — ULTRIX(-NS)-FR5 LEDs

Table 78 provides basic LED descriptions.

Table 78  ENET Port LEDs

LED Status Description
ENET # - 
Link/Activity

Green When lit green, this LED indicates a valid link is established 
on the specified ENET port.

Flashing When flashing green, this LED indicates communication 
activity is occurring on the specified ENET port.

Off When unlit, this LED indicates an invalid link is detected on 
the specified ENET port. Verify the cable connection on the 
rear module port and your network connections.

ENET # - Port 
Speed

Green When lit green, this LED indicates the ENET Port 
communication speed is at 1Gbps.

Yellow When lit orange, this LED indicates the ENET Port 
communication speed is at 100Mbps.

Off When unlit, this LED indicates the ENET Port 
communication speed is at 10Mbps.

ENET 2

ENET 1

ENET 1 Port Speed LED
ENET 1 Port Link/Activity LED

ENET 2 Port Speed LED
ENET 2 Port Link/Activity LED

ENET 1

ENET 2
ENET 2 Port Speed LED

ENET 2 Port Link/Activity LED

ENET 1 Port Speed LED

ENET 1 Port Link/Activity LED
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Monitoring the Battery
The Ultrix router uses a Panasonic® CR2032 battery to serve as an emergency backup power 
source for the essential memory of the router. This enables the router to power up with the same 
crosspoint selection as when it was powered off. This battery is located on the Cooling Fan Module 
installed inside the Ultrix router chassis.

 A spare battery was included in the Ultrix Shipping Kit (Ross P/N 2101KR-084) when your router 
was shipped from the factory.

Enabling the Battery Status Monitoring Feature in DashBoard
You can monitor the battery status via the Alarms table in the Frame Configuration interface. 

To configure an alarm for battery status monitoring

1. To In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the Alarms tab.

7. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not 
Configured” with a yellow indicator in the State cell.

The Type menu opens.

8. Select Battery from the Type menu.

Replacing a Failed Battery in an ULTRIX(-NS)-FR5
This section describes how to replace a failed battery within the ULTRIX(-NS)-FR5 chassis.

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration 
interface, you will need to replace the battery installed inside the Cooling Fan Module of the chassis. 
This module is accessed via the front of the router chassis and requires that you remove the door 
first. The door is secured to the front of the router chassis with a rare earth magnet on each side. 

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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To remove the door from the ULTRIX(-NS)-FR5

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the middle of the door on the right side.

Figure 74  ULTRIX-NS-FR5 Front Panel — Where to Grasp the Door

 If you have trouble removing the door from the chassis, use your right-hand fingers in the space 
between the door and the chassis for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Figure 75  ULTRIX(-NS)-FR5 — Front Panel — Removing the Door

Caution — The door of the ULTRIX-NS-FR5 is heavy. Ensure that you have a firm grip on the door, or 
that the door is otherwise supported, before removing it from the chassis.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Removing a Battery from the ULTRIX(-NS)-FR5
The battery is located on the Main Board inside the ULTRIX(-NS)-FR5 chassis. You do not need to 
remove the Cooling Fan Module to replace the battery in an ULTRIX(-NS)-FR5. 

To remove the battery from an ULTRIX(-NS)-FR5

1. Locate and note the orientation of the failed battery on the Main Board. Refer to Figure 89 for 
battery location.

Figure 76  ULTRIX(-NS)-FR5 — Battery Location inside the Chassis

2. Gently move the latch to the left and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Main Board.

Installing a New Battery in the ULTRIX(-NS)-FR5
Installing a new battery requires you to orient the battery on the Main Board, and secure the 
battery to the board. 

To install a new battery in the ULTRIX(-NS)-FR5

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you.

2. Pull the latch slightly away to make room for the new battery installation.

3. Slide the battery into the empty slot the failed battery was in.

4. Secure the battery to the Main Board using the latch.

To re-install the door on the ULTRIX(-NS)-FR5

1. Align the door to the front of the router, ensuring that:

• the door is oriented upright
• the corner with the Ultrix logo is in your left hand, and
• the corner with the Ross logo is in your right hand. (Figure 77)

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Battery
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Figure 77  ULTRIX(-NS)-FR5 — Aligning the Door to the Chassis 

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Replacing a Failed Battery in an ULTRIX(-NS)-FR2
This section describes how to replace a failed battery within the ULTRIX-FR2 or ULTRIX-NS-FR2 
chassis. Note that the battery location differs depending on the model. 

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration 
interface, you will need to replace the battery installed inside the Cooling Fan Module of the chassis. 
This module is accessed via the front of the router chassis and requires that you remove the door 
first. The door is secured to the front of the router chassis with a rare earth magnet on each side. 

To remove the door from the ULTRIX(-NS)-FR2

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the top and bottom of the door at the right side.

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###

1
2

3
4
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Figure 78  ULTRIX-NS-FR2 Front Panel — Where to Grasp the Door 

 If you have trouble removing the door from the chassis, you can insert a flathead screwdriver into 
the notch on either side of the door for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Figure 79  ULTRIX-NS-FR2 Front Panel — Removing the Door

Removing the Cooling Fan Module from the ULTRIX(-NS)-FR2
This section only applies if you are replacing a battery in the ULTRIX(-NS)-FR2.

To remove the Cooling Fan Module from the ULTRIX(-NS)-FR2

1. With the door removed, use a #1 Phillips screwdriver to loosen the screw that affixes the 
Cooling Fan Module to the Main Board.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Figure 80  ULTRIX(-NS)-FR2 — Location of Screw for Cooling Fan Module

2. Gently pull the Cooling Fan Module towards you to unseat it from the backplane and to 
disengage the module from the chassis.

Figure 81  ULTRIX(-NS)-FR2 — Removing the Cooling Fan Module from the Chassis

3. Pull the Cooling Fan Module free from the chassis and set it on a static-free surface.

Removing a Battery from the ULTRIX(-NS)-FR2
The battery is installed in a slot on the side of the Cooling Fan Module and secured in place with a 
small latch. 

To remove a failed battery from the ULTRIX(-NS)-FR2 Cooling Fan Module

1. Locate and note the orientation of the failed battery inside the Cooling Fan Module. (Figure 82) 

2. Gently move the latch to the right and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Cooling Fan Module.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Main Board

Screw
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Figure 82  Battery Location inside the Cooling Fan Module — ULTRIX-FR2 and ULTRIX-NS-FR2

Installing a New Battery in the ULTRIX(-NS)-FR2
Installing a new battery requires you to orient the battery on the module, secure the battery to the 
module, and then re-install the front door on the chassis. 

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Battery
Latch

ULTRIX-NS-FR2
Battery
Latch

ULTRIX-FR2
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To install a new battery in the Cooling Fan Module

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you. 
(Figure 90)

Figure 83  New Battery Orientation —ULTRIX-FR2 and ULTRIX-NS-FR2

2. Slide the battery into the empty slot the failed battery was in.

3. Secure the battery to the module using the latch.

Re-installing the Cooling Fan Module
Once you have installed the new battery into the new Cooling Fan Module, you can re-install the 
Cooling Fan Module into the Ultrix chassis and replace the door on the front panel.

To install the Cooling Fan Module into the chassis

1. Align the new Cooling Fan Module in its slot inside the chassis.

2. Gently push the Cooling Fan Module into the slot until the module is fully seated. You will feel 
the back connector of the module engaged with its connector inside the chassis.

ULTRIX-NS-FR2

ULTRIX-FR2
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3. Use the screw from step 1 in the procedure “To remove the Cooling Fan Module from the 
ULTRIX(-NS)-FR2” to affix the Cooling Fan Module to the frame. 

Re-installing the Door on the Chassis  

To re-install the door on the ULTRIX(-NS)-FR2

1. Align the door to the front of the router, ensuring that the door is oriented upright, the corner 
with the Ultrix logo is in your left hand, and the corner with the Ross logo is in your right hand. 
(Figure 91)

Figure 84  ULTRIX(-NS)-FR2 — Aligning the Door to the Chassis

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Replacing a Failed Battery in an ULTRIX(-NS)-FR1
This section describes how to replace a failed battery within the ULTRIX-FR1 or ULTRIX-NS-FR1 
chassis. Note that the battery location differs depending on the model. 

Caution — The Cooling Fan Module includes a connector that must be fully seated. Reinstalling the 
Cooling Fan Module retention screw is required to ensure proper contact.

Caution — Re-installing the door incorrectly or misaligned can damage the door or internal 
components.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration 
interface, you will need to replace the battery installed inside the Cooling Fan Module of the chassis. 
This module is accessed via the front of the router chassis and requires that you remove the door 
first. The door is secured to the front of the router chassis with a rare earth magnet on each side.

To remove the door from the ULTRIX(-NS)-FR1

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the top and bottom of the door at the right side.

Figure 85  ULTRIX-FR1 Front Panel — Where to Grasp the Door 

 If you are having trouble removing the door from the chassis, you can insert a flathead 
screwdriver into the notch on either side of the door for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Figure 86  ULTRIX-NS-FR1 Front Panel — Removing the Door

Removing the Cooling Fan Module from the ULTRIX(-NS)-FR1
This section only applies if you are replacing a battery in the ULTRIX(-NS)-FR1.

To remove the Cooling Fan Module from the ULTRIX(-NS)-FR1

1. With the door removed, use a #1 Phillips screwdriver to loosen the screw that affixes the 
Cooling Fan Module to the Main Board.

Figure 87  ULTRIX(-NS)-FR1 — Location of Screw for Cooling Fan Module

2. Gently pull the Cooling Fan Module towards you to unseat it from the backplane and to 
disengage the module from the chassis.

Figure 88  ULTRIX(-NS)-FR1 — Removing the Cooling Fan Module from the Chassis

3. Pull the Cooling Fan Module free from the chassis and set it on a static-free surface.

IP: ###.###.##.###

1
2

3
4

Main Board

Screw
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Removing a Battery from the ULTRIX(-NS)-FR1
The battery is installed in a slot on the side of the Cooling Fan Module and secured in place with a 
small latch. 

To remove a failed battery from the ULTRIX(-NS)-FR1 Cooling Fan Module 

1. Locate and note the orientation of the failed battery inside the Cooling Fan Module. (Figure 89)

Figure 89  Battery Location inside the Cooling Fan Module — ULTRIX-FR1 and ULTRIX-NS-FR1

2. Gently move the latch to the right and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Cooling Fan Module.

Installing a New Battery in the ULTRIX(-NS)-FR1
Installing a new battery requires you to orient the battery on the module, and secure the battery to 
the module. 

To install a new battery in the Cooling Fan Module

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you. 
(Figure 90)

2. Pull the latch slightly away to make room for the new battery installation.

3. Slide the battery into the empty slot the failed battery was in.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Battery

Latch

ULTRIX-NS-FR1 Battery

Latch

ULTRIX-FR1
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Figure 90  New Battery Orientation —ULTRIX-FR1 and ULTRIX-NS-FR1

4. Secure the battery to the module using the latch.

5. Proceed to the section “Re-installing the Cooling Fan Module”.

Re-installing the Cooling Fan Module
Once you have installed the new battery into the new Cooling Fan Module, you can re-install the 
Cooling Fan Module into the Ultrix chassis and replace the door on the front panel.

To install the Cooling Fan Module into the chassis

1. Align the new Cooling Fan Module in its slot inside the chassis.

2. Gently push the Cooling Fan Module into the slot until the module is fully seated. You will feel 
the back connector of the module engaged with its connector inside the chassis.

3. Use the screw from step 1 in the procedure “To remove the Cooling Fan Module from the 
ULTRIX(-NS)-FR1” to affix the Cooling Fan Module to the frame. 

Caution — The Cooling Fan Module includes a connector that must be fully seated. Reinstalling the 
Cooling Fan Module retention screw is required to ensure proper contact.

ULTRIX-NS-FR1

ULTRIX-FR1
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Re-installing the Door on the Chassis  

To re-install the door on the ULTRIX(-NS)-FR1

1. Align the door to the front of the router, ensuring that the door is oriented upright, the corner 
with the Ultrix logo is in your left hand, and the corner with the Ross logo is in your right hand. 
(Figure 91)

Figure 91  ULTRIX-NS-FR1 — Aligning the Door to the Chassis

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Caution — Re-installing the door incorrectly or misaligned can damage the door or internal 
components.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###

1
2

3
4
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Monitoring the 
Communications
This chapter summarizes how to verify communications on an Ethernet port, an Ultricore 
connection, and the overall communication status of the Ultrix router.

Monitoring the Network Status
The Ethernet ports on the Ultrix rear panel are used to connect to an Ethernet network for 
communications. An ENET port is set to active when Ultrix automatically detects a valid network link 
on the port. When a valid link is detected on both ports, the ENET 1 port is set to active and is the 
primary connection. 

 There are two ENET ports on the Ultrix rear panel. A fail-over feature enables the Ultrix router to 
automatically use the second ENET port when the primary ENET connection is lost or unavailable.

To verify the communication status of an Ethernet Port via DashBoard

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Locate the Status field in the Network Settings area.

This field reports which Ethernet port is currently active.

7. Refer to Table 79 for a summary of the possible messages displayed in the Status field.

Table 79  Frame Configuration — Status Field

Item Parameters Description
Status ENET # is Active 

(Green)
Ethernet communications for the specified 
port are valid. The specified ENET port on 
the Ultrix rear panel is the currently active 
(in use).

Inactive (Red) Ethernet communications for the router are 
invalid. The following conditions may be 
occurring:
• The ethernet cables are disconnected 

from the rear panel.
• A valid network connection may be 

unavailable.
• The IP Address is for the router is no 

longer valid. 
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Monitoring the Ultricore Mode Status
The primary Ultrix router passes all commands to each client Ultrix router in the system. Each client 
Ultrix router responds back to the primary in minute intervals.

Primary Status
If the Ultrix router is configured as a primary, the Frame Configuration > Communications tab 
reports on the status between it and each client router connected to it. Each client is listed in the 
table, with the most recently connected router displayed at the bottom of the list. 

Figure 92  Communications Tab — Example of the Ultricore Mode Field

Client Status
If the Ultrix router is configured as a client, the Communications tab reports on the 
communications between it and the primary.

Troubleshooting
If you have lost communication between the primary Ultrix router and its clients:

1. Verify that each router is installed correctly.

2. Verify that each router is installed with a network connection to your facility.

3. Verify the ethernet settings for each router are valid.

4. Verify that the primary Ultrix router reports a list of valid connections to clients in its Ultricore 
Clients table. 

5. Verify that each client Ultrix router is running software compatible to the primary Ultrix router.

Monitoring the Ultrix System Status
The System Status node displays an indicator that varies in severity from green (valid) to red 
(alarm). This indicator reports the most severe alarm the Ultrix is experiencing. The types of alarms 
the Ultrix reports is configured via the Frame Configuration > Alarms tab.

When you hover your mouse cursor over a red System Status node in the Tree View of DashBoard, 
as seen below, a tool tip displays with a brief error message. The message and indicator continue to 
report an error until the condition is addressed or the alarm is disabled in the Alarms tab.
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Figure 93  Example of a Master Alarm Message

For More Information on...
• the monitoring options, refer to “Navigating the Monitoring Interfaces”.

Using the System Logs in DashBoard
An entry in each log includes a timestamp, a code number, and a description. Messages are written 
to the log when significant changes occur in the operation of the Ultrix router. These could include: 
changes to video, reference, audio or time inputs; power-on or reboot cycles; configuration changes 
that can have an effect on the routing path; alarm conditions.

To access the system logs in DashBoard

1. In the Tree View of DashBoard, double-click the Product Info node under the Ultrix node.

The Product Info interface displays in the DashBoard window.

2. Select the Logs tab.

The Logs tab opens.

3. To view the communication log for Ultrix only, select the System Log option.

4. To view the log for communications between Ultrix and other devices, select Controller 
Communications Log.

5. To view the log for executed tasks in DashBoard for the router, select DashBoard 
Communications Log.

6. Click Refresh to update the entries for the currently selected log.

Enabling SNMP Support
Ultrix routers running software version 3v4 or higher provide optional support for remote 
monitoring of your router using SNMP (Simple Network Management Protocol). This protocol is 
compatible with many third-party monitoring tools. 

 The MIB file provides SNMP traps for the configurable alarms on Ultrix as well as on the power 
supplies and fans.

Enabling SNMP Support
The SNMP Agent on the Ultrix router uses SNMP version 2 to allow queries of the configured system 
alarms, and state changes to configured alarms will be sent out as SNMP traps to the specified Trap 
Destination IP Address(es).

Whenever the options in the SNMP area are edited, the SNMP Agent is restarted on the Ultrix 
router. It can take up to 10 seconds for all monitored states to be updated. This latency only 
applies once on startup.

The SNMP monitoring feature for your Ultrix is a software option that you enable in the System 
Status > Network tab.
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To enable SNMP support on the Ultrix

1. Verify that the Ultricore-SNMP license key is installed for the Ultrix router. Refer to “Installing a 
License Key” for details.

2. In the Tree View of DashBoard, double-click the Product Info node under the Ultrix node.

The Product Info interface displays in the DashBoard window.

3. Select the Network tab.

4. Locate the SNMP area of the tab.

5. Select the Enable SNMP box.

6. Ensure that the Alarms you want to monitor via SNMP are also enabled on the Ultrix router. 
Refer to “Monitoring the Hardware”.

To configure the SNMP Agent using DashBoard

1. In the Tree View of DashBoard, double-click the Product Info node under the Ultrix node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. Locate the SNMP area of the tab.

4. Use the SNMP Community Name field to specify the SNMP password for GET requests. 

 The default SNMP Community Name is ultricore. For stronger security, it is strongly 
recommended that users set their own community string.

5. Use the SNMP Trap Destination IP Address field to specify the target address to which traps 
should be sent.

An example of a valid target is provided in the SNMP area.

 A maximum number of six strings are displayed in the SNMP Trap Destination IP Address field 
at one time. If at the maximum number, you must select a string from the field and delete it 
before adding a new target entry.

6. Press [Enter] to apply the changes.
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Monitoring the Signals
This section outlines how to monitor the reference signal, the inputs and outputs signals via the 
options in the Frame Configuration interface.

Monitoring the Reference Signal
The Sync area of the Frame Configuration interface reports on the signals connected to the REF 
ports on the Ultrix rear panel.

For More Information on...
• setting the default reference, refer to “Specifying a Default Reference Format”.

To monitor the Ultrix reference signal

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the References tab.

7. Refer to Table 80 to troubleshoot the messages displayed in the status fields.

Table 80  Frame Configuration — References Status

Item Parameters Description
Status Active (Green) A valid reference signal is connected to the 

REF port on the Ultrix rear panel

No Sync (Yellow) No signal detected on the REF port on the 
Ultrix rear panel
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Triggers Status
The Triggers area of the Frame Configuration interface reports on the signals connected to the 
reference ports on the Ultrix rear panel.

To monitor the Ultrix reference signal

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Frame Configuration page opens.

6. Select the References tab.

7. Refer to Table 81 to troubleshoot the messages displayed in the Detected and Format status 
fields for each sync trigger.

Monitoring the SDI Outputs
The Port Configuration interface enables you to monitor the signal status of the SDI outputs of the 
Ultrix.

To monitor the status of all the SDI outputs of the Ultrix router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

Format Unknown A reference signal is detected but the 
format is not supported by the router

# Indicates the video format of the reference 
signal

Table 81  Frame Configuration — Triggers Status

Item Parameters Description
Detected Unknown The format of the reference signal is not 

supported by the router

# Indicates the video format of the reference 
signal that is used when the specified 
Trigger ID is used by an output

Format Custom The switching line is specified by the user 
via the Custom menu

# Indicates the video format of the reference 
signal that the specified Trigger will use

Table 80  Frame Configuration — References Status

Item Parameters Description
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The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the top row of buttons, click the button for the slot you want to monitor.

7. Locate the row for the output port you wish to monitor.

8. Refer to Table 82 to troubleshoot the messages displayed in the status fields for each physical 
output port.

Monitoring the SDI Inputs
The Port Configuration interface enables you to monitor the signal status of the SDI inputs of the 
Ultrix router.

To monitor the status of all the inputs of the Ultrix router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the top row of buttons, click the button for the slot you want to monitor.

7. Locate the row for the input port you wish to monitor.

Table 82  Port Configuration — Output Messages

Item Parameters Description
Physical Address slot#.out[#] Indicates the physical socket on the Ultrix 

rear panel

Error Status OK (Green) Indicates a valid output signal is detected 
on the specified socket

No Signal (Red) Indicates that a valid output signal is not 
detected on the specified socket 

Video # Indicates the SDI signal type detected on 
the specified socket

Audio # Indicates the audio signal type detected on 
the specified socket
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8. Refer to Table 83 to troubleshoot the messages displayed in the status fields for each physical 
input socket.

Monitoring a Specific BNC
The Port Configuration tab enables you to monitor the video and/or audio signal status of a specific 
port and/or a group of selected ports on the Ultrix rear panel.

To monitor the status of a specific port for the Ultrix router

1. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultrix node.

The Device Configuration interface opens.

5. Select .

The Port Configuration page opens.

6. From the top row of buttons, click the button for the slot you want to monitor.

7. From the blade map, select the port(s) you wish to monitor.

The label under each selected port is highlighted in blue and the Port Configuration tab 
updates to display information on the selected port(s). In the example below, Port 4 in slot 1 
was selected on an ULTRIX-FR2.

Table 83  Port Configuration — Input Messages

Item Parameters Description
Physical Address slot#.in[#] Indicates the physical socket on the Ultrix 

rear panel

Error Status OK (Green) Indicates a valid input signal is detected on 
the specified socket

No Signal (Red) Indicates that a valid input signal is not 
detected on the specified socket 

Video # Indicates the SDI signal type detected on 
the specified socket

Audio # Indicates the audio signal type detected on 
the specified socket
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8. Click Video to monitor the status of the video signal on the selected port. 

9. Click Audio to monitor the status of the audio channels on the selected port.
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between an Ultrix and a device 
in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a label applied to a router output (or group of outputs).

Device — a physical, virtual, or software application that may include multiple sources, 
destinations, senders, or receivers.

Flow — the continuous raw media content. It can contain more than one essence (e.g. an audio 
flow can contain multiple channels, and an SDI flow may contain audio and video essences). A flow 
is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is one 
type of stream which can carry the flow. Flows cannot generally be passed around natively, and 
need to be encapsulated in a stream. Flows from the same source are considered “editorially 
equivalent”, but may be encoded differently. For example, a video source may be encoded as 4:2:2 
YCbCr uncompressed, 4:4:4 RGB uncompressed, and h.265 encoded. Each of these would be a 
separate flow from a common source.

Hard Panel — a physical hardware panel of buttons that is used to control the routing system.

Head — An OUT port on the Ultrix router that is assigned as an UltriScape (Multiviewer) output.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Macro — a recorded sequence of Remote Control Panel operations (local to the panel).

Map — a table that defines the allocation of names (labels) to router input and output sockets.

Matrix — the part of the routing system that performs the actual signal switching tasks.

Partition — matrices may be partitioned to behave as smaller independent matrices.

Picture in Picture (PIP) — a sub-picture in an UltriScape (Multiviewer) output.

Receiver — an element within a device that receives exactly one stream, which contains one flow 
from a network.

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Resource — a source or destination of a router configuration; an external device providing some 
conversion functionality for use within the routing control system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Sender — an element within a device which presents exactly one flow, packaged as a stream onto a 
network.
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Stream — one flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, 
SMPTE ST 2110-20 Video, or SMPTE ST 2110-30 Audio (AES67).

Soft Panel — a DashBoard interface that represents a panel of buttons that is used to control the 
routing system.

Source — a label applied to a router input (or group of inputs).

T-Bus — the Ross Video proprietary routing communication method via a defined physical 
interface.

UltriClean — clean switch functionality of the Ultrix routers.

Ultricore — refers to the Ultricore-CC and the Ultricore-BCS unless otherwise stated.

UltriMix — SDI embedded audio manipulation sub-system of the Ultrix routers.

UltriScape — licensed Multiviewer option for Ultrix routers.

UltriSpeed — licensed 12Gbps SDI video option.

UltriSync — a per input licensed frame synchronizer.

ULTRIX-FR1 — refers to all versions of the ULTRIX-FR1 router unless otherwise noted.

ULTRIX-FR2 — refers to all versions of the ULTRIX-FR2 router unless otherwise noted.

ULTRIX-NS-FR1 — refers to the next generation of the ULTRIX-FR1 router. This router displays the 
Ultrix logo on the front door with a blue dot in the “i”.

ULTRIX-FR2-NS — refers to the next generation of the ULTRIX-FR2 router. This router displays the 
Ultrix logo on the front door with a blue dot in the “i”. 
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